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Introduction
ImagePrint R.E.D. is a full featured printing environment with an easy to use 
graphical interface that is available for both Windows and Macintosh computers.  

Features include the use of standard ICC/ICM color profiles for screen to print 
and print to print matching utilizing a proprietary Color Management Engine, 
advanced queue management with Spoolface (the Spooler interface), auto-layout 
controls with optional media optimization, decorative text, annotations, crop 
marks, borders/backgrounds, step/repeat and optional photo packaging (tem-
plates).  

Documentation Conventions
This manual is designed to be viewed online, using the Adobe Acrobat reader. 

Hyperlinks are available throughout the document to allow you to easily jump to 
sections of interest.  Hyperlinked text is displayed in blue--click these links to 
immediately move to the part of the manual describing the linked text in greater 
detail.

Cross Platform:  This manual is intended for users of both the Macintosh and 
Windows version of ImagePrint. Throughout this document, screen images may 
be presented from either platform, since in virtually all cases differences between 
the platforms are only cosmetic.  In those rare instances where there are sub-
stantial differences between versions, both screen images will be provided.

This guide assumes that you are familiar with the computer interface of your 
operating system. For detailed information on your computer and its interface, 
refer to your computer’s installation guide. 
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Configuration Requirements
Before installing ImagePrint R.E.D., make sure your system meets the minimum configuration 
requirements indicated below.

Macintosh OSX

-   10.11 (El Capitan), 10.12.x (Sierra), 10.13.x (High Sierra) and 10.14.x (Mojave)

-	 800 MHz Intel processor with 64 bit support

Windows

-	 Windows 7, Windows 8.x and Windows 10.x  (64-bit Operating Systems Only)

-	 800 MHz or above processor

All Platforms

-	 1 Gigabyte of RAM

-	 800 Megabytes of free hard drive space (1 gigabyte free space recommended)

-	 CD-ROM drive

-	 800x600 or above screen resolution

 -   Appropriate connection to the printer

-  Free USB port on computer (or USB hub) for the copy protection dongle

IMPORTANT: The USB copy protection dongle is unique to your installation of ImagePrint. 
It represents the full cost of the software and can not be replaced if lost or stolen. In some 
cases, replacements for damaged dongles may be purchased but require the return of the 
original dongle to ColorByte.

An internet connection to the computer is helpful for installing updates and printer profiles, 
but is not required to operate the software.

Note on minimum requirements: Although any computer meeting the minimum require-
ments listed above should be able to print, speed of printing can be affected by factors 

specific to your particular workflow.  For optimal printing speed, consider increasing the pro-
cessor speed and RAM if multiple-printers are attached or if the computer is also used as a 

workstation to perform other tasks while printing.   
 

Also, some large format printers (such as the Epson 11880) which have the ability to receive 
large amounts of data very quickly can be greatly affected by the computer processing 

speed as well as the speed of the data connection to the printer.  (In cases where the com-
puter is not keeping up with the printer you may see the print head pause at the end of each 

print pass.)
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Contacting Technical Support
Most issues with ImagePrint can be solved by consulting the Troubleshooting guide (located 
in your ImagePrint folder), however, there are times you need a helping hand to get past 
some problems. For that, there’s ColorByte’s technical support department.

ImagePrint R.E.D. comes with 90 days of technical support via email. ColorByte’s email sup-
port is among the best in the business, and responses are typically quick and accurate. 

That said, support is always more efficient if, when contacting us, you include useful infor-
mation on the problem you are experiencing.  Please consult the following guidelines when 
corresponding with our support dept. to receive a solution to your problem more quickly.  
ColorByte’s support can be reached via the email form at: www.colorbytesoftware.com.

Recommended:  “ImagePrint Diagnostic Utility” 
 

The ImagePrint Diagnostic Utility is an application located in your 
ImagePrint folder that contains several useful functions.  One of them, Send a 
diagnostic snapshot to ColorByte, is a convenient and thorough way to pro-
vide the ColorByte Support department with information that can help them to 

trouble-shoot technical issues.   
 

Launching the Diagnostic Utility from your ImagePrint folder and choosing 
the Send Diagnostic Snapshot to ColorByte option will cause the utility to 

gather information about your ImagePrint installation including recent job files, 
log files, configuration files, and computer settings. You’ll be given the option 
to upload the diagnostics to ColorByte’s online server or save a text copy to 
attach to an email. This is the easiest and most thorough method of pro-

viding ColorByte’s Support Dept. with information on your system. 

Things to include in all correspondence with ColorByte Support:

•	 Your name

•	 Your 6 digit dongle number

•	 The printer you are using

•	 The version and build number of ImagePrint (this can be found by choosing “About” 
under the ImagePrint HELP menu)

•	 The platform (Mac or PC) and the OS (e.g., OSX 10.11.2, or Windows 10).

www.colorbytesoftware.com


V ImagePrint R.E.D. User’s Guide Preface V

Contacting Technical Support (continued)

•	 A brief (but detailed) description of the problem you are having.  Make sure to include any 
error messages exactly as they appear.  Some questions you may also wish to include 
answers for are:

- 	 Have you consulted the Troubleshooting guide?

- 	 Is this a brand new installation of ImagePrint on this computer?

- 	 Has anything changed on your system prior to the problem?

- 	 How are you connected to the printer?

- 	 Have you reproduced the problem, or did it just happen once?

- 	 Does the problem only happen with certain images? (If possible, try printing the “sam-
ple portrait.tif” image that is located in the Test Images folder off the ImagePrint folder 
as a test.)

- 	 What have you already done to try to correct the problem?

Support Availability

Colorbyte Technical Support is available during regular business hours: 9:00 am to 5:00 pm, 
Eastern Standard Time.  Most emails are responded to within 2 hours of receipt (often more 
quickly) however volume received and other factors may affect response times.  If you have not 
received a response within 24 hours, please resend the email.  

If you are not using the current version of ImagePrint and are not under a support/maintenance 
agreement with ColorByte, you may receive an automated response detailing your support 

options.
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Other ImagePrint Resources
Online Tutorials: The tutorials located on our web site: www.colorbytesoftware.com 
are a great resource for learning ImagePrint by seeing its features in action. It is 
strongly recommended that new users use these as their first introduction to the fea-
tures and workflow of ImagePrint.

Troubleshooting:  The ImagePrint Troubleshooting guide is a separate document 
that contains solutions for most problems you may encounter with ImagePrint.  This 
guide is the recommended first stop when you have a problem with the software.

The Troubleshooting guide is installed in your ImagePrint folder and can be accessed 
from the HELP menu in ImagePrint, and the latest revision of the guide is also avail-
able on our web site’s (www.colorbytesoftware.com) Help  page.  

User’s Manual: What you’re reading now.  The user’s manual is available from the 
HELP menu when in ImagePrint, and the latest revision is always available on our 
web site’s (www.colorbytesoftware.com).  The manual is large and comprehensive, 
and is often best used as a general reference.  Though not meant to be read cover 
to cover, Chapters 4 (the Basics) may be useful for new users of ImagePrint to read 
in its entirety to achieve a good general knowledge of the ImagePrint workflow, and 
chapter 6 is a useful to learn about ImagePrint’s use of color management and printer 
profiles.

Users Group: The Yahoo ImagePrint Users Group is a great source of informa-
tion about ImagePrint.  Users of the software share their advice, tips, solutions (and 
complaints) in an often lively discussion.  ColorByte Software is not affiliated with this 
group in any way, but many of the participants are long time users of ImagePrint and 
gurus in the ways of printing.  To access the group use the following link:

    http://tech.groups.yahoo.com/group/colorbyte_imageprint/

Workshops, trade shows, seminars: While ColorByte doesn’t currently produce 
workshops or seminars, there are existing ones that utilize and teach with ImagePrint.  
Also, ColorByte personnel sometimes appear at industry trade shows or participate in 
dealer seminars.  For information on upcoming events in your area, contact the sales 
department at: 

 	            sales@colorbytesoftware.com

www.colorbytesoftware.com
www.colorbytesoftware.com
www.colorbytesoftware.com
http://tech.groups.yahoo.com/group/colorbyte_imageprint/
mailto:sales@colorbytesoftware.com
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Installing and Licensing ImagePrint R.E.D.
Follow the instructions in this chapter to activate (license) ImagePrint R.E.D., and to 
download and install it.  You’ll also find instructions for uninstalling the software, add-
ing new ImagePrint R.E.D. drivers, and trouble-shooting the most common installa-
tion problems.

Note: Windows users may be prompted to reboot their computer one to two times 
during the installation.  After rebooting the installation will continue.

1. Activate 

You’ll need the copy protection dongle and a valid license number to print in non-
DEMO mode.

•	 Mac users - insert the USB dongle into any free USB port on your computer 
(or a USB hub). 
 
Windows users--don’t insert the dongle just yet. Wait until prompted to do so 
during the installation of the software.    
 If you don’t have a dongle, you can still install the software in trial mode, 
which will cause a DEMO watermark to appear on all of your output. If you pur-
chase the software later, you can insert the USB dongle into the computer and 
license the software -- no need to reinstall.

•	 To retrieve your license number, go to the ImagePrint R.E.D. Setup web page:
			               http://print-red.info

Click the Get Code button below the Activate heading to access a web page 
where you can enter the 6-digit dongle number listed on the dongle and the 
6-letter login code included in your packaging along with your email address.  
Your license number will be emailed immediately when you click Submit.  
 
Hang on to that number--you’ll need it in just a few steps.

2. Download 

If you haven’t already downloaded the installer, click Download for OSX or Down-
load for Windows on the ImagePrint R.E.D. Setup Web page (http://print-red.info) 
to download it now.

http://print-red.info
http://print-red.info
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3. Install  
Follow the below steps to install ImagePrint R.E.D. It is recommended that you disable any 
anti-virus software prior to installing.
Launch the installer from its download location on your computer:

�� ��On Windows: Double-click ImagePrint_Installer.exe  
 You may be prompted to reboot one or two times during the installation.

�� On Mac: Double-click ImagePrint_Installer.dmg to mount the disk image, then dou-
ble-click the file: ImagePrint Installer.pkg inside it. 
 

 If you receive an “Unknown Developer” warning on the Mac, right click (or control 
click) the installer icon instead of double-clicking it and then choose OPEN from the 
context menu that appears.  

•	 After reading the License Agreement, click the “I Agree” check box and click the 
Install button.  

•	 Macintosh users will be prompted for their computer password.  Enter it and click 
Continue. 

•	 Windows users will be prompted to insert the USB dongle. Insert it into any free 
USB port on the computer or in a USB hub. 

•	 Click Launch IPSetup in the installer window to launch the IPSetup utility.  
•	 In the IPSetup window that appears, click Add Printer. 
•	 Click Continue in the introduction window that appears.
•	 Paste or type in the license number you received in step one and click Continue.   

 

 If you don’t have a license number choose Demo Mode as the install type. Then, 
click Continue and choose ImagePrint R.E.D. (You can license the software later by 
relaunching IPSetup from your ImagePrint folder and clicking the License button.)

•	 �The next window lets you choose a name for your R.E.D. driver (or you can leave it 
at the default.)  

•	 Click Continue to complete the driver setup.
•	 ���Your ImagePrint R.E.D. driver will now be listed in the IPSetup window.  Close 

IPSetup by choosing Quit from the menu at the top of the screen.

Your Installation is now complete! 

Installing ImagePrint - (continued)



Choose to Quit to exit the installer, or to get started with ImagePrint R.E.D. right 
away, choose Launch.

To use Imageprint at a later time, double-click the ImagePrint icon from within 
the ImagePrint folder in Applications (Mac) or choose ImagePrint from the 
ColorByte Software group in your Start menu (Windows). 

Further Documentation

The next few chapters of this manual will take you through the basics of 
ImagePrint and walk you through making your first print.  Or, if you prefer watch-
ing and listening instead of reading, ColorByte maintains a set of video tutorials 
covering both basic and advanced features of the software.  Check them out at: 
www.colorbytesoftware.com.

IMPORTANT: The USB copy protection dongle is unique to your installation of 
ImagePrint. It represents the full cost of the software and can not be replaced if lost 
or stolen. In some cases, replacements for damaged dongles may be purchased but 
require the return of the original dongle to ColorByte

Installing ImagePrint (continued)

www.colorbytesoftware.com
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Problems?

The following trouble-shooting tips will help you to overcome the most common 
issues that you might encounter when installing ImagePrint R.E.D.  Remember, 
there’s MUCH more help available in our Trouble-shooting guide located in your 
ImagePrint folder.

Can’t launch the Installer!

If you have downloaded the installer--make sure the download is complete. The 
installer is more than a hundred megabytes in size and may take a few minutes 
to download, depending on your internet speed. Double-clicking the installer 
before it is fully downloaded will result in an error.

UNKNOWN DEVELOPER message -- If you get an error popup on a Macintosh 
computer that says the Installer can’t be launched because it is from an 
“Unknown Developer”, right-click it (or CONTROL-Click) the installer instead of 
double-clicking it.  A menu will appear with an OPEN option.  Choose this option 
and in the window that appears you’ll have a new button that allows you to 
launch the software. 

No Dongle Detected!

If the dongle number does not show up at the top of IP Setup when configuring 
your printers, you will not be able to license the software (even a valid license 
number will be reported as INVALID if the dongle is not detected).

Try re-inserting the dongle, then quit and relaunch IPSetup to see if it “sees” it.  

To relaunch the IPSetup utility, double-click it from your ImagePrint folder  
which is located within the Applications folder on a Macintosh and in the 
Program Files (x86) folder on a Windows PC.

If reinserting the dongle and re-launching IPSetup fails to correct the problem, 
try a different USB port or a powered USB hub.  (Make sure to quit and relaunch  
IPSetup each time you try a different port).  

If trying different USB ports doesn’t fix the problem, reboot the computer and 
relaunch IPSetup to check once again.  

Installing ImagePrint - (continued)
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If THAT fails as well, you may have a faulty dongle or some issue with your comput-
er’s ability to read the device.  

Check our Trouble-shooting guide for further recommendations and/or contact 
ColorByte’s Support dept. via the support web mail form at www.colorbytesoftware.
com.

 
Make sure to include details on the issue, including your computer platform, what 
steps you have taken to correct the problem and the dongle number (you’ll find 
that on a label on the dongle itself).  Be sure to include any error messages you’ve 
received as well.

Removing or Adding new R.E.D. Drivers
Removing a R.E.D. driver
To remove an ImagePrint R.E.D. driver, first, make sure that ImagePrint and 
Spoolface, are NOT running.  

Then, navigate to the folder where you installed the ImagePrint software,  

The default is \applications\ImagePrint (MAC) or c:\program files (x86)\ImagePrint 
(WINDOWS).

Now, double-click the IPSetup application.  

The IPSetup window will be displayed.

To remove an ImagePrint printer or an ImagePrint R.E.D. driver, choose its name 
from the installed printers listed within the IPSetup window, then click the DELETE 
PRINTER button.

Adding a new R.E.D. driver
If you need to add another printer, just launch IPSetup from your ImagePrint folder 
and click ADD PRINTER.

Installing ImagePrint - (continued)



Completely Uninstalling ImagePrint R.E.D.

To uninstall ImagePrint R.E.D. and remove it from your system, perform the fol-
lowing steps:

Macintosh

•	 Locate the ImagePrint folder that was created during installation, and drag it 
to the Macintosh Trashcan.  The normal location for the ImagePrint folder is 
within the Applications folder of your hard drive.

•	 Remove the ImagePrint,  IPSetup, and Spoolface icons from your desktop 
and/or dock if they exist.

•	 Remove the ImagePrint preferences file: 
 
 “com.colorbytesoftware.ImagePrint11.0.plist” 
 
This file is located in the /Users/”user name”/library/preferences folder.

Windows

•	 To uninstall ImagePrint:  

�� On Vista/Windows 7 choose Start->Run and type “Control Panel”. Hit 
return and select Programs and Features.  

�� On Windows 8 type “Control Panel” when in your Windows Start (Metro 
Tiles) screen, hit return and select Programs and Features.

�� On Windows 10, right click the Windows Start menu and choose Apps 
and Features in the menu that appears. 

•	 Double-click the ImagePrint entry in the Programs list that appears, and 
choose UNINSTALL in the window that appears.   
 
Note you can choose to completely uninstall the software, or leave your old 
jobs, printer configuration and profiles in place (useful if you plan on rein-
stalling the software at a later date).

Installing ImagePrint - (continued)
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Overview
To help you get oriented, here’s a brief orientation to help familiarize you with the various tools 
and components of ImagePrint R.E.D. along with pointers to detailed documentation on each.  

• 		 To get printing very quickly without a lot of extra details, see chapter 3, Printing 
Quickstart.  

• 		 For a more detailed walkthrough of using ImagePrint, see Chapter 4, ImagePrint 
Basics. This is the recommended starting chapter for new users of ImagePrint.

• 		 Chapter 5 is a complete reference that steps through all the menus and features 
including the Dashboard.

• 		 The important subject of color management, including setting profiles for 3rd party 
papers, is discussed in chapter 6, Color Management.

• 		 Preferences and Image settings are described in chapter 7: Preferences.

• 		 Using Automatic Layout Settings to automatically size and position images as you open 
them is discussed in chapter 8: Layout Styles and Auto Layout Settings.

• 		 Output Sharpening and Wide Gamut Toning are discussed in chapter 9: Correction 
Tools - Sharpening and Wide Gamut Toning

• 		 ImagePrint’s powerful layout and design tools are described in chapters 11 The Border 
Browser , chapter 12: Templates, chapter 14: Boundaries, and chapter 13: Adding 
Backgrounds, Frames and Gallery Wrap.

• 		 Typical settings for Canon and Epson system drivers to use with ImagePrint are given 
in chapter 15: System Driver Settings. 

• 	 For details on using the ImagePrint spooler, see chapter 16, The ImagePrint Spooler.
• 		 Finally, helpful informaiton--like supported keyboard shortcuts -- can be found in the 

Appendix.  

• 		 A stand-alone Troubleshooting guide is available as a separate document in your 
ImagePrint folder.

• 		 AutoPrint, a “Hot Folder” utility that allows you to print by dropping images into a speci-
fied folder instead of manually laying them out is also available.  You can find AutoPrint 
in your ImagePrint folder.

		  For Macs, you need to launch the AutoPrint_Installer.app first to install the file AutoPrint.
app to your ImagePrint folder which can then be used to launch AutoPrint.  For 
Windows, no installation is necessary, just double-click the AutoPrint.exe file to launch 
it.  Once launched, a full manual is available under the AutoPrint VIEW menu, and con-
text senstive help is available by hovering your mouse over most items.  There are also 
helpful videos showing AutoPrint in use at www.colorbytesoftware.com.
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Making your first print with ImagePrint R.E.D. 
Launch ImagePrint R.E.D. by double-clicking the ImagePrint icon in your ImagePrint folder in 
Applications (Macintosh) or choosing ImagePrint from the ColorByte Software group in your 
Start menu (Windows).

The right side of the default ImagePrint menu contains the ImagePrint Dashboard. Click the triangle 
button  beside the word PRINTER in the dashboard to expand the printer settings area. 

Choose R.E.D. 
Desktop or 
R.E.D. Large format  
in the printer drop-down  
menu. 

Click the Setup...  
button to launch your system’s 
Printer Setup dialog.

Pick your printer

Select your printer in the Printer 
drop down menu.

After selecting the printer, you’ll need to set 
a few options including the page size and me-
dia type.

The location of these parameters varies from 
printer to printer. Below are general instruc-
tions on setting the necessary options on 
Canon and Epson printers on Macintosh and 
Windows computers.

For more information on recommended settings for most Canon and Epson printers see chapter 
15.
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Set the Page Size, Quality, Roll/Sheet and Media Type - Macintosh
Now you’ll need to specify the Page size, Print Quality (sometimes called the Output Resolu-
tion), Media Type and Roll/Sheet setting for your paper. These settings can be in different 
places depending on the printer you are using.

For most Canon printers these settings are  
found under the Quality & Media menu.

Pick a page size or create a custom one. If 
using Roll, make sure the width is the same as 
that of the roll. 

Pick the Roll/Sheet setting that corresponds 
to how your media is loaded in the printer (if 
applicable).

For the Media Type selection, pick the setting that 
corresponds to the media you are using.  If you 
are using a 3rd party media, pick the Media Type 
recommended by the paper manufacturer.

It is recommended that you set the Print Quality/
Output Resolution to the highest available for your 
printer.

Click  to close the system printer dialog and 
apply your settings.  

► For more information on recommended settings for most Canon and Epson printers see 
chapter 15.

Typical Epson 
Printer

Typical Canon 
Printer

For most Epson printers these settings are 
found under the Printer Settings menu.
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Set the Paper Size, Quality, Roll/Sheet and Media Type - Windows

Epson Printers

Pick the Media Type for the paper you will be using 
from the Media Type menu.

The Print Quality should be set to the highest avail-
able setting.

Make sure the Mode setting is ICM, then click the Ad-
vanced button and make sure “Host ICM” is selected 
as the ICM Mode.

In the Source menu, choose Roll or Sheet.

Pick your paper size.  If the size you wish to use is not 
listed, choose User Defined (or Custom) and create a 
new custom paper size.

Canon Printers

In the Main tab section, pick the Media Type for the 
paper you will be using from the Media Type menu.

The Print Quality should be set to the highest avail-
able setting.

Make sure the Color Mode setting is COLOR, then 
click the Color Settings button. In the Color Settings 
window choose the MATCHING tab and choose ICM 
in the Color Settings section. Ignore any warnings 
that appear and click OK to close the Color Settings 
window.

Now choose the Page Setup tab.

In the Page Setup section, pick your paper size in the Page Size menu.  If the size you wish to 
use is not listed, choose User Defined (or Custom) and create a new custom paper size.

In the Paper Source area, make sure you are set to the proper paper source (Roll or Sheet).  
If using Roll, make sure the Roll Paper Width is correctly listed.

After selecting the above settings, click   to close the system printer dialog.  
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Pick your profile if using a 3rd party paper

If you’re using a 3rd party paper, pick the profile for it in the Us-
ing Profile menu within the ImagePrint Dashboard. 

If you’re using a paper made by your printer manufacturer, you 
don’t need to pick a profile. It was chosen automatically when 
you picked the media type.

Open an Image

The Image Strip is located to the right of the page layout area. It’s the most conve-
nient way to open images. It comes pre-loaded with a few sample images that you 
can use for your first print or you may want to fill it with your own images.

To fill the Image Strip with your own 
images you have to specify what folder 
has the images it should display. In the 
Dashboard, click the triangle button 

 beside the top entry: Image Strip 
Folder Location.

Now use the directory 
tree to navigate to a folder 

containing images you 
want to print.  

The Image Strip window will thumbnails of any Tiff, JPEG, PDF or Photoshop PSD files found 
in the selected Image Strip folder. (If you don’t see the Image Strip to the right of the page 
layout area, you can make it visible via the VIEW menu at the top of the ImagePrint screen.)
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Double-click any image within in the Image Strip to open it on the ImagePrint page.  (Note: 
You can also open images via the File -> Open menu at the top of the ImagePrint screen 
without using the Image Strip.)

Layout Basics 

Here’s some basic tips for arranging, resizing, and removing images in the layout 
window. Information on the complete set of layout tools is available in chapter 4.

•	 �Move an image by dragging and dropping it anywhere on the page. 

•	 �Resize an image by clicking and dragging any edge or by typing the desired 
width/height values into the fields above the page area.

•	 �����������������The FIT icon  in the floating toolbar to the left of the image layout area will 
immediately fit the image to the page.

•	 Rotate an image by using the clockwise or counter-clockwise rotate tools in 
the floating toolbar to the left of the image layout area.

•	 �����������������To delete an image, use the SCISSORS icon  in the  
toolbar to the left of the layout area.

•	 �����������To Remove unwanted pages, or add new ones, drag the PAGES icon 			 
  in the upper right corner of the layout area.

Open an image (continued)
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Print

Click the  button at the top of the Dashboard when 
the layout is ready to print.

A dialog box will appear in order for you to confirm your 
print settings. 

Click OK.

Congratulations, you’ve printed your first ImagePrint with  
ImagePrint R.E.D.!

The next page describes how to control and monitor the status of your print jobs using the 
ImagePrint spooler, Spoolface.
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Checking the job’s progress with Spoolface

Click the printer icon on the top right of the Dash-
board to open the Imageprint print job manager, 
Spoolface.

Using Spoolface

•	 While the job is printing, it will remain in the top (Active) side.  

•	 When it’s done printing, it will move to the bottom (Saved) side.  

•	 Cancel a job by dragging it from the top (Active) side to the bottom (Saved) side.  

•	 Reprint a job by dragging it from the bottom (Saved) side to the top (Active) side.

•	 Job progress and any errors or warnings are shown in the Job Progress area on 
the right.

•	 The current status of the printer will be shown in the bottom left corner along with 
any error codes if the job ran into a problem.

•	 If there’s an error, the spooler will Pause printing. When you’re ready to resume 
printing, unpause the Spooler by unchecking the PAUSE option under the QUEUE 
menu at the top of the screen. (Make sure to move any failed jobs remaining in 
the Top (Active) side down to Bottom (Saved) side before unpausing to avoid them 
being processed again once printing resumes).

Active Jobs

Saved (Finished) 
Jobs

Job Progress 
Information

     Current Status
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The General ImagePrint Workflow

There are typically three basic steps to any ImagePrint session:

1. Opening and laying out your images.

2. Choosing paper and page settings.

3. Sending the job to print.

In this chapter, each of these steps will be touched on, providing a general walkthrough 
of the core ImagePrint workflow.  While comprehensive information for all of ImagePrint’s 
features is available within subsequent chapters, reading through this chapter alone should 
provide the understanding needed to effectively use ImagePrint, with other chapters serv-
ing as a reference when needed.

Of course, each ImagePrint session must first start with launching the program.

The Basics: Starting ImagePrint

To start ImagePrint, double-click the ImagePrint icon.  

On Mac versions*, you can find the ImagePrint icon in the  
                        /Applications/ImagePrint folder

On PC versions, the ImagePrint icon should be on your Desktop, or in the  
                       C:\Program Files (x86)\ImagePrint folder.

The ImagePrint Main application will appear with 
it’s default elements in place. 

*Macintosh users: To launch the program conve-
niently in the future, drag its icon to your Dock.
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The Basics: The Default ImagePrint Windows

When you first open ImagePrint R.E.D., the default windows will appear docked within the 
Main Program window.  All ImagePrint windows are dockable and undockable, meaning you 
can choose to have them all fixed within the Main Window “container” or floating separately.   

The following elements appear when ImagePrint is first launched:

1. The Page Layout Window - This window contains the representations of all the pages with-
in your layout. This is where you will place the images you plan to print.

2. The Dashboard - This window is your “control center” for most ImagePrint functions.

3. The Floating Tool Palette - Icons for commonly used tools, like Zoom or Rotate, can be 
found in this tool bar.

4. The Image Strip - The Image Strip shows thumbnails of images within a selected folder for 
easy layout.

5. The Main Menu, Shuffle and Size and Position Controls - Along the top of the ImagePrint 
window you’ll find the File, Edit, View and Help menus that provide access to some ImagePrint 
functions and advanced tools such asTemplates and the Border Browser. Also, by default, the 
Size and Position Controls palette will appear here, which will let you dynamically adjust the 
size and position of the selected image or interface element.  Finally, the Shuffle buttons allow 
you to quickly alter the positioning of the images on the page to conserve paper or make for 
more efficient cutting.
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 The Basics: Docking and Undocking
With ImagePrint, almost every ele-
ment in the interface has become a 
Dockable window.  This means the 
window can be locked into position 
or moved independently of all other 
elements.

This feature allows for virtually 
unlimited flexibility in setting up 
your work environment, and can be 
especially useful for multiple-mon-
itor setups, allowing you to keep 
some tools, such as the Image Strip 
or Dashboard on one monitor while 
displaying your layout (pages) window full screen on the other.

To specify if a window dockable or undockable, use the 
View Menu at the top of the ImagePrint screen.  First, 
make sure the window is Viewable by selecting that option 
if it’s not already checked.

By choosing Dockable for any visible window, dragging 
that window to the top, bottom, or sides of the ImagePrint 
Main Window will cause it to dock.  You’ll see that it’s 
ready to dock when the Main Window changes color.

When you choose for a window to not be Dockable (no checkbox beside Dockable) then the win-
dow will be able to move freely anywhere on screen.

When you dock a window while other windows are docked in 
the main window, you may see them move to make room for the 

new window.  Sometimes it can be tricky to dock a 
window just where you want--it may “jump” to one 
side or another, or an already docked window may 
move to an undesirable position.  It may take a 
few tries to get your windows just where you want 
them.

If you want to go back to the way things were, just 
choose Reset Window Positions from the View 
menu at the top of the screen 
and the windows will go back 
to their default, docked, posi-
tions.

Docked--the image strip 
is now docked in place.

Ready to dock--other windows 
move out of the way and the 
main window changes color.
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The Basics: Accessing and configuring your system printer driver

ImagePrint R.E.D. uses some settings from your printer manufacturer’s driver (the free driver 
provided by your printer manufacturer). These settings include the paper size, the size of the 
non-printable margins, borderless printing settings and whether roll or sheet paper is being used.  
The Media Type also needs to be set in the printer driver’s settings and will be used to automati-
cally set the correct paper profile if you are using papers from your printer manufacturer (OEM). 

Any settings that need to be set in the printer driver will be labeled with “Set in Driver” in the 
ImagePrint Dashboard.

To access your printer manufacturer’s 
driver: 

Click the triangle button  beside the word 
PRINTER in the dashboard to expand the 
printer settings area.  

Make sure your R.E.D. driver (Desktop or 
Large) is selected as the printer, then click the 
Setup... button to launch your printer’s Printer 
Driver dialog.  

Choose your printer in the driver window drop-
down menu to access the settings for that printer. 

On OSX computers you may 
need to click the “Show/Hide 
Details” button at the bottom 
of the window to view all of the 
available options. 

On Windows computers, you will 
need to click the PROPERTIES 
button to access the printer driv-
er’s settings.

Windows

OSX
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The Basics: Accessing and configuring your system driver (cont)

Although it is impossible to give specific details on where each option is located in 
every printer driver R.E.D. supports, Chapter 15-- Printer Driver Settings gives step-
by-step instructions for that apply to most Canon and Epson printers on both Windows 
and Macintosh computers.

Here’s a general list of the options that should be specified in the system printer driver 
before printing with ImagePrint R.E.D.   

Page Size:  In the driver’s page size menu, pick the page size you plan to use on the 
printer. This page size will automatically be applied to the ImagePrint layout area.

If using roll paper, make sure to choose a page size that matches the actual width 
of the roll.  The height (or length) should be set a size that can accommodate the 
image(s) you plan to print.  

Most printers have a roll paper saving mode (sometimes called “No spaces-top and 
bottom” that will cause the printer to only about the area of the page that has image 
data on it.  Using this option will allow you to use a roll paper length without wasting 

paper if you do not fill the entire page area.

Roll or Sheet: Specify whether you are using roll or cut sheet media.

Borderless (on or off): Full bleed borderless printing is possible on many printers, 
although there are often restrictions on the allowed page sizes, and many printers do 
not support top/bottom borderless on sheet paper.

Quality: The print quality mode should be set to the highest available option.

Color Mode:  Printer color management should not be enabled  You would only need 
to change this setting if you wish to print using the printer drivers black & white printing 
mode (called “Advanced B&W” on Epson printers).

    �On Windows computers, turning off printer management requires specific settings 
be in effect depending on the printer type. Generally, these are:

		  Windows Epson Printers should be set to: Color Mode Custom ICM and in the 
Advanced window: Host ICM

		  Windows Canon Printers should be set to Color Mode: Color  
and in the Advanced Color Settings window, under the Matching tab ICM 
should be selected.

More details on proper system driver settings can be found in Chapter 15 -- Printer 
Driver Settings.
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The Basics: Accessing and configuring your system printer driver (cont) 

Media Type: In the system printer driver, you should also choose the media type that corre-
sponds to the paper you are using. If using a 3rd party paper (one not made you your printer 
manufacturer), select the Media Type recommended by your paper maker for your printer/
paper combination.  

So... just what is a Media Type? 
 

Media Types are presets that the printer uses to adjust its paper feed controls and inking. 
Since they come from the printer, they are based on the manufacturer’s papers. Every print 

job must have a Media Type sent with it so the printer knows how to set itself up for the 
paper being printed.   

 
Media Types are NOT the same as ICC paper profiles, which characterize the coating of the 

paper and have to be sent with each job as well to get proper color and ink density.  
 

That said--since the Media Types are based on the printer manufacturer’s papers, if you use 
a paper from your printer manufacturer (like Epson or Canon)  chances are the Media Type 

that is used will have the same name as the paper you’re using. 
 

This is not true with 3rd party papers. Although your third party paper will use an ICC profile 
made for that paper, it still must use a Media Type from the list of presets for the printer 

maker’s papers. (Your paper manufacturer will normally provide information on what Media 
Type to select for each of their papers). 

 
When you select a media type in the system driver, ImagePrint R.E.D. will automatically set 
the ICC profile it is using to the matching Manufacturer’s profile for that Media Type. This is 

called Automatic Mode profile selection. 
But if you are using a 3rd party paper, don’t forget to switch from Automatic to the proper 
ICC profile for your paper.  You do this in the Dashboard, in ImagePrint R.E.D.’s Profile 
Menu, which shows all the installed profiles on your Macintosh or Windows computer.

Applying your printer driver settings

After configuring the system printer driver, closing the driver dialog will return you to 
ImagePrint.  The page size you selected in the driver will be shown in the layout window. 
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The Basics: Choosing Profiles
Now that you have set your system driver 
settings and have a page size selected, it’s a 
good time to check your profile settings. 

First, some background on Color Profiles 
(feel free to skip to the next page if you are 
already familiar with Color Management con-
cepts.)

Color Profiles define color characteristics for images and devices.  For the purposes of print-
ing, the colors within the image need to be converted to work within the color capabilities of the 
printer on your chosen paper.  The way ImagePrint knows what the color boundaries are for 
both the image, and the printer, is via ICC (also called icm) profiles. Profiles are basically files 
containing color information corresponding to a device or image. 

Color Management consists of 1) determining what Color Profile defines the colors within the 
image (the Source profile),  2) determining the Color Profile that defines the colors the printer 
is capable of printing (the Output profile) and then 3) converting the image colors using the 
profiles  one to the other to maintain the image’s appearance as closely as possible.

Printer (aka Paper) Profile: Of course, the colors the printer is capable of printing varies 
depending on the ink and paper used (among other things).  That’s why there are different 
printer profiles for different papers--each one defines the colors that the printer can print on 
that paper.  Picking the right printer profile for your paper is thus critical in achieving proper 
output.  Luckily, ImagePrint’s huge selection of top of the line printer profiles makes it easy.

Source (Image) Profile: Likewise, since all of the colors within the image have to be convert-
ed into the printer’s color space, it’s vital for the printing software to know what the color range 
(gamut) of the image is to do the conversion correctly.  That’s where the proper source profile 
comes in. It tells us the entire range of possible colors within a particular image.  Nowadays, 
most photographic images carry that profile with them as an embedded profile.  That simply 
means when the image was created, a copy of the source profile was saved with it--and that’s 
great for simplifying color management and avoiding mistakes.  With embedded profiles, half 
the work of profile selection is already done--programs like ImagePrint know right away what 
the proper source profile as soon as it opens the image!
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The Basics: Choosing Profiles (cont.)

For most printers, ImagePrint R.E.D. will pick the proper paper profile automatically when you 
select the Media Type in the system driver if you are using a paper made by your printer man-
ufactures (such as a Canon paper when using a Canon printer, or an Epson brand paper when 
using an Epson printer).  This is called Automatic mode and is the default setting.

If you are not using a paper made by your printer manufacturer, then you will need to choose it 
manually.

Choosing a 3rd party paper profile:

First, acquire the profile from your paper manufacturer.  Usually the profile can be downloaded 
from the paper maker’s web site.  ImagePrint just needs the ICC profile in most cases--we do 
not require a media configuration (AM1X) file for most papers.

Once you have the paper profile, you’ll need to put it in the proper profile folder on your com-
puter. 

   �For Windows computers, paper profiles are located in the following folder:

                        /Windows/System32/Spool/Drivers/Color

 �Tip: If you right click the profile and choose INSTALL PROFILE in the menu that 
appears, Windows will copy it to that folder automatically.

    For OSX (Macintosh) computers, the profiles should go into the following folder:

 	 /Users/”your username”/Library/ColorSync/Profiles

 �Tip: The Library folder may be a hidden folder on some systems. To get to it quickly, 
choose GO from your Mac’s finder menu (at the top of the screen) while holding the  
OPTION key down.  Then choose LIBRARY from the list of folders.

Once the profile is in place, you can select it from the Us-
ing Profile menu within the PRINTER section of the Dash-
board. Just click the menu (which normally says Automat-
ic) to see a list of the installed profiles on your system.

For many papers, once you have selected the paper pro-
file, you’ll see the recommended Media Type listed below 
the entry.  If you don’t see a recommended media type listed, make sure you have 
selected the proper one in the driver according to your paper manufacturer’s recom-
mendation.



4-10 ImagePrint R.E.D. User’s Guide

The Basics: Choosing Profiles (cont.)

Specifying the Source (image) Profile

By default, ImagePrint will look for an embedded profile in each image it opens and use that 
as the source space.  For most workflows, that means nothing else needs to be done--if 
your images have embedded profiles (most do) you can move on to the next section--Creat-
ing a Layout.

For images that don’t have embedded profiles, ImagePrint  will use the default source pro-
files specified in its Preferences window.  For RGB images, the default is Adobe 1998.  For 
single-channel grayscale images, the default is Gray Gamma 2.2.  And, for CMYK images, 
the default is US Web Coated SWOP. These are the most commonly used color spaces for 
those types of images.

If your images don’t have embedded profiles and they don’t use one of the above defaults, 
you should change the defaults to match your workflow.  To change the default profiles, 
choose Preferences (via the View Menu on Windows or the ImagePrint menu if on Mac) 
then click DEFAULT PROFILES and change the entries under Missing Profiles/Untagged 
Images section.

Not sure? 
If you’re not sure of the profile settings of your images, skip to the next section, Creating 
a layout.  ImagePrint’s display is fully color managed--if the image’s look fine on screen, 
chances are your source profile settings are correct.  If the color seems off then you may 

need to check what settings were used when they were created.

The Basics: Creating a layout
The Pages window is the largest section of the default 
ImagePrint interface. 

The white area within the patterned boundary of each page 
shown is the printable area based on the page size you 
selected in the system printer driver a few steps earlier.

The pink cross hatched border area represents the part of 
the page on which the printer can not print (the non-print-
able area). Any portion of an image on the pink area will not 
print.
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The Basics: Creating a layout (Cont.)

 The Basics: Adding and Removing Pages

ImagePrint makes creating and working with multiple page layouts simple--pages can be 
added or removed by simply dragging the pages icon.   

Make sure the Pages Window is visible.  If 
you don’t see it, go to the Views menu and 
make sure Visible is checked beside the 
Pages Window option.

In the top left corner of the Pages Window 
is the Page Creation tool.

Clicking on this icon and dragging will 
cause page icons to be displayed. 

As you drag, more icons will be shown--dragging to the right or left increases or decreases 
the number of horizontal columns of pages, up or down controls the number of vertical rows of 
pages.

When you release the mouse, you’ll 
see the pages created within the Pages 
Window, ready to begin filling with 
images.

Page Numbers

Notice that the upper edge of each 
page displays it’s page number, fol-
lowed by it’s column and row number. 
Don’t worry--these numbers won’t print.  
They are just informational:

•	 	 As images are added, if they don’t fit on a page, they will be added to the next highest 
numbered page that has room. 

•	 	 Pages are printed in their page number order.

To see how page numbers are determined, see More on Creating pages on the next page.
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More on creating pages

Mind the Arrows!

When you drag to create pages, notice that there will be red arrows 
pointing to the left, or the right, and red text will specify “grow verti-
cally” or “grow horizontally”.  Both let you know in what direction new 
pages will be created as others are filled.  

Horizontal arrows means new pages will be added to the right side of 
your layout, while vertically means they will be added to the bottom.  

Note--these arrows do NOT specify where the images will be placed 
as pages are filled.  Image placement is always based on Page Number.  The first area 
large enough to fit the image in the lowest available page number will get the image. 
(Remember--each page shows its number in the upper section).

Page numbering

How pages are numbered is also based on the arrows, but in the opposite direction. This 
can be confusing, but since new pages will be added in the direction of the arrows (verti-
cally or horizontally) when all pages are filled, the page numbering will flow in the opposite 
direction.  That’s because all the existing pages will be filled before new pages can be 
added.

So--if you created pages that will added horizontally (right arrows) as they are filled, the 
page numbering will flow vertically (Page one will be in the upper left, and page two will be 
below it, etc.).

Don’t like your page layout -- Just recreate it!

Creating and removing pages is non-destructive.  
If you want to change the page layout, just click the 
Page Creation icon again and re-drag it.  No images 
will be deleted or moved (though, if you reduce the 
number of pages, some images may end up outside 
of any pages and won’t print until they are moved or 
new pages are created “under” them again.)

The Basics: Adding Pages  (Cont.)

Until these two images are 
within a page they won’t print
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The Basics: Spreads

Normally, when you create pages by dragging the Page 
Creation tool, you can create as many vertical columns of pages 
as you like.  

You can specify a special Layout Mode called “Spread Mode”, 
however, that limits you to two page spreads when creating 
pages.  

Spread mode is useful if you plan to create photo albums or 
other types of books from your images because, in addition 
to the normal page margins, you can specify a non-printable  
“binding gap” between facing pages when in Spread mode.  

You can switch between 
Normal and Spreads by click-
ing the View Menu at the top 
of the ImagePrint screen and 
choosing either option from 
the Page Layout selection.

Specifying the Spreads Mode Binding Gap

The Binding Gap represents the non-printable margin between two 
facing pages that allows for the pages to be bound together without 
obscuring portions of the print.

The Binding Gap is set in ImagePrint’s Preferences window.  

Choose Preferences from the View menu (if on Windows), or the 
ImagePrint menu (if on Mac).  

In the Preferences window, click the 
Pages Tab.  

In the Spreads section of the Pages window, you can enter a 
Binding gap value in the currently used units (inches or cen-
timeters). 

When you close the Preferences window, you’ll see the bind-
ing gap represented on your pages as a patterned area.   
This is a non-printable area. 

If you drag an image across the binding gap, it will split 
across it, allowing you to print one image across two facing 

pages.

When the Layout is set to 
Spreads, you can only create 

facing pages.
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The Basics: Working with Images

Now that you’ve made sure the page size and color management settings are correct, its time 
to open one or more images. Once opened, images can be arranged within the Pages window.

Opening Images

There are three ways to open images in ImagePrint.  

File -> Open

Choose File from the ImagePrint main menu, then choose OPEN to access a standard file 
open dialog allowing you to locate the files(s) you wish to open. The image will open on the first 
available page that has room for it.

Drag and Drop

You can also drag image files from any folder on your system to the ImagePrint layout window. 
If working with multiple pages, this method lets you specify which page to place the image on.

The Image Strip

The Image Strip is a 
graphical way to locate 
your images.  

If it’s not already visible, choose Image Strip from the View menu at the top of the screen. You 
can dock the Image Strip within the ImagePrint main window, or leave it free floating.

Filling the Image Strip with your images

To specify what images on your computer are 
shown in the Image Strip, expand the IMAGE 
STRIP FOLDER section of the Dashboard, 
and use the folder tree to locate your image 
folder.

Click Add to Favorites to save that folder into 
your Favorites list. Then, in the future, just 
choose it from the Favorites Tab.

Remember: ImagePrint works with TIFF, 
JPEG, PDF and Photoshop PSD files only.

To avoid clutter, you can drag the Image Strip over the Dashboard to combine the two into one 
window with a selection button at the bottom.
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The Basics: Working with Images - Image Placement

Once you have the Image Strip populated with your images, just  drag or double-click a thumb-
nail to add it to your layout. 

Dragging to a specific page 

If dragging an image from a folder or from the Image Strip, you can release the image on top 
of any page in your layout to place it on that page.  You’ll see the selected page turn gray, 
meaning it’s the current target page for the image. (If the image can’t fit, it will still automati-
cally move to the next page that can accommodate it.)

Page Origin Point - Where images open

Images will be positioned with their upper left corner at the page origin point. By default, the 
origin point is located at the upper left corner of the page’s printable area, but you can specify 
a different origin point in the Dashboard’s Advanced->Auto Layout Settings.  The Page Origin 
point is shown in blue on each page.

Nesting - Where images fit

Images will automatically “nest” as they are opened.  Starting from the upper left, the image 
will be placed into the first available space that can fit the image. If there’s no room on the cur-
rent page, it will attempt to fit on another one.  If the image is too big for the printable area of 
even an empty page it will simply be placed at the origin point, on top of other images that may 
already exist on the page.

While ImagePrint will automatically find a place to fit each image as it’s opened, it doesn’t opti-
mize the image positioning to save paper.  At any time, however, you can “Shuffle” the layout 
to make better use of the paper or make for more efficient separation of the images when it’s 
time to cut them apart.  

The next page describes using the three Shuffle modes to optimize your layout with the click of 
a button.
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Shuffle - Optimize layouts to save paper or make for easier cutting

The three icons above the layout area are the Shuffle controls.  
Each one, when clicked, will immediatly “shuffle” all the images on 
the page, repositioning them and rotating them if necessary in order 
to conserve paper or make cutting the images apart easier.

The three shuffle modes are:

Tight Shuffle 

This mode typically saves the most paper (but not always).  
Images are rearranged to fit as high on the page as possible, 
with absolutely no concern for easy cutting.  While this mode 
will save paper, if you have lots of images of different sizes it 
may result in a more dificult to cut “jigsaw” arrangement.

Cut Shuffle

Images will be positioned to fit as high on the page as possi-
ble (conserving paper) while guaranteeing that image separa-
tion can be done with single vertical or horizontal “straight-
across” cuts at every step in the process (no right-angle cuts).  

Easy Cut Shuffle

This shuffle mode maintains clear horizontal cut lines 
between rows of images.  It often saves less paper than the 
other modes but is the easiest to cut as it will only require 
horizontal cuts followed by simple vertical cuts to separate 
all the images. 



4-17 ImagePrint R.E.D. User’s Guide

Shuffle Settings

You can tell Shuffle where on the page images shuold be positioned, and how far apart the 
images should be placed from one another, via the Layout Settings section of the dashboard.  

Changing the following parameters in the Layout Settings area and clicking any of the Shuffle 
buttons will re-shuffle your layout with the new parameters in effect.

Gutters: Gutters are the 
distances between adjacent 
images.  You can specify 
Left-Right (horizontal) 
gutter spacing and Top-
Bottom (vertical) spacing 
independently.  By default, 
images are spaced .25 
inches apart, but you can 
change this value to reduce 
or increase their separation.  
A gutter of 0 will butt images 
up against each other.

Page Origin:  This is the position on the page on which images will start.  By default, the 
origin point is set to the upper-left corner of the printable area. Change this value to have 
your layout begin further into the page if you want to produce a wider left/top margin.

Shuffle: A note on speed vs perfection 
 

ImagePrint’s shuffle feature is powerful and fast, but it’s not perfect. In mere seconds it will 
choose a paper-saving arrangement that’s close to the best possible.  But there’s a LOT of 
combinations to consider -- just 10 unique images on the page can result in hundreds of bil-

lions of possibilities when rotations are considered.   So, don’t be surprised if, sometimes, you 
may be able to find a slightly better paper-saving layout than ImagePrint does.



4-18 ImagePrint R.E.D. User’s Guide

The Basics: Working with images (cont.)

Moving and Resizing Images  

Once you’ve opened an image, you’ll probably want to arrange it on 
the page and/or resize it.

Moving an image

	 •	 The simplest way to move a single image is to simply click with-
in the image’s bounding box and drag it to a new location.

	 •	 For exact spacing you can also type in a horizontal (X) and vertical (Y) position values 
for the selected image in the fields within the Size and Position Palette located at the 
top of the main window by default (if not visible, choose Size Position Controls from 
the View menu).

	 •	 Another way to specify exact 
horizontal and vertical positions 
for the selected image is via the 
Image Properties section of the 
Dashboard.

	 •	 To “nudge” an image a small amount at a time, use the Arrow 
keys on your keyboard.  Each press of the arrow key will move the 
image a pixel in the desired direction.  Hold down the arrow key to 
increase the rate of movement.

For more accurate positioning of images, and to align them to other images or page ele-
ments, see Aligning Images and Using Guides later in this chapter.

Click within an image    
and drag to reposition it
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Resizing images   

	 • 	 To proportionally resize an image, click on either side of the image (NOT the corner!)   
and drag. The image will be resized with its original aspect ratio intact.

	 • 	 To non-proportionally resize an image, click on the corner of its bounding box and 
drag.  

 	 •	 For exact proportional sizing you can also type in width and/or height position value 
for the selected image in the fields within the Size and 
Position Palette located at the top of 
the main window by default (if not vis-
ible, choose Size Position Controls 
from the View menu). Note the image will always scale 
proportionally using the value you type in and filling the remaining field with the correct 
value to maintain the original image aspect ratio.

	 •	 Yet another way to specify proportional sizing for the selected image is via the 
Image Properties section of the 
Dashboard. You can also use that 
section to specify the percentage 
scale rather than via size values.

To have the image fill the largest area 
of the page possible without dis-
torting the image, click on the Fit 
Page icon in the floating tool palette.

To scale the image to whatever size is needed to obtain spe-
cific margins (auto-cropping the image if necessary), click 
the Fit to Margins icon in the floating tool palette.

To return the image to its original size after performing any 
sizing operation, click on the Original Size icon in the float-
ing tool palette.

But wait... there’s more!

There are even other ways to size and position images as they are 
opened, such as specifying Auto Layout Settings in the Advanced 
section of the Dashboard, or using ImagePrint Templates.  Those 
advanced topics will be covered later in this manual.

The Fit button is 
the quickest way 
to fit your image 
to the printable 
area of the page
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The Basics: Working with images (cont.)

Deleting Images from the Layout area

The Scissors icons in the Tool Palette are used to remove unwanted 
images from the layout area. If the palette is not visible, choose Tools 
from the View menu at the top of the screen.

 The Black scissors deletes the currently selected image.

  The Red scissors delete every image on the page

Zooming in/out

Sometimes, you may need to 
adjust how much of the layout 
area is visible.

To get a closer look at objects 
within the layout area, click on the 
Zoom In magnifying glass icon 

 found on the ImagePrint Tool 
Palette. 

To view a larger portion of the lay-
out, click on the Zoom Out  mag-
nifying glass icon .  

  

The Tool Palette 
(Vertical Orientation)

Zooming In
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The Basics: Working with images  (cont.)

Other commonly used Layout tools

Rotating an image

To rotate the selected image in 90 degree increments, click on either the Rotate CW  or 
Rotate CCW  icons in the floating tool palette.

Mirroring (flipping) an image

To mirror the selected image right/left or up/down, click on either the Flip Horizontally   or 
Flip Vertically  icons in the floating tool palette.

Centering an image

To center an image on the page, select the image and click the Center Image  icon from 
the floating tool palette.

AutoFlow - Automatically creating new pages

As pages are filled with images, newly opened will “flow” onto 
other pages.  The page with the next highest page number that 
has room for it will get the image. But, if no more pages exist, 
by default new ones will be created to accommodate the new 
images.  

You can turn OFF autoflow by selecting the option in the Advanced->Auto Layout Settings sec-
tion of the Dashboard.  With Autoflow off, new images will simply stack on top of other images if 
there is no room for them on the page.

The Toolbar
(Horizontal Orientation)
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The Basics: Working with images  (cont.)

Splitting images across pages

When you drag an image to the edge of a 
page’s printable area...

...it will automatically split onto the next 
page.  Images will also split if you grow 
them across pages.

You can move either side of the split image, and both sides will move together.  You can 
adjust the split area or remove the split by moving the image within a single page.
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The Basics: Working with images  (cont.)

Aligning images 

ImagePrint has several ways of aligning images:  

Align to other images via the alignment tool - This method lets you pick a “target” image, 
and align other selected images to it.

Align to other images or page elements via smart alignment - When you drag an image, 
“smart” alignment lines will appear when its center or edges are in line with the edges or center 
of other images or the edge or center of the page itself.

Custom guides - You can drag guidelines from the ruler areas of the page menu to create 
your own alignment elements.

Align to other images via the alignment tool

To align multiple images to one target image, first, select the desired 
target by clicking it.

Next, hold the CONTROL key down on your keyboard and click the 
images you wish to align to the target image.

Then, choose the alignment option from the Alignment tool in the 
Tool Palette.

You can choose 
to align the image’s 
edges or center in a 
vertical or horizontal 
direction.

All the CONTROL-Selected images will align to the 
target.

Click the 
target 
image...

...then 
control-
click the 
other 
images 
and 
choose 
your align-
ment 
option.



4-24 ImagePrint R.E.D. User’s Guide

Align to other images via Smart Alignment

ImagePrint’s Smart Alignment guides are a 
dynamic, quick way to line your images up 
with other images or to the page edges or 
center.

When you drag in image on the page, 
dashed red lines appear when the 
edges or center of the image lines up with 
the edges or center of another image on the 
page or of the page itself.

These lines are “snap” lines, meaning if you 
release the image while its center or edge is 
close to one of the pop-up alignment lines, 
the image will snap into alignment.

 

You can decide which, if any, elements of the page or other images act as snap lines 
via the ImagePrint Preferences window (you can get to preferences by choosing it 
from the View menu in Windows, or the ImagePrint menu on Macs).

Once in the Preferences window, choose Pages, then select the snap options you 
wish to use.  Any unchecked options won’t show red-dashed snap lines in the inter-
face. 

IMPORTANT:  ImagePrint’s Grid overlay, also available in the Pages section of 
Preferences, can not be used while Smart Alignment tools are active.  

The Basics: Working with images  (cont.)

Aligning images (cont.) 

Smart Alignment in action

As the central image is 
dragged, the red-lines 

appear to show when its 
close to an alignment option. 

Currently, the center of the 
image is close to both verti-
cal and center alignment to 
the page, and its left edge 
close to alignment to the 

right side of the other image. 
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Align using Custom Guides

Another alignment tool that ImagePrint offers is 
draggable guides.  These vertical or horizontal lines 
allow you to create your own snap-to lines any-
where on the page.

To create a vertical guide, click in the ruler to the left of 
the pages area and drag to the right into the page.

To create a horizontal guide, click in the ruler above the 
pages area and drag down into the page.

The guide will be created where you release the mouse, 
and will extend from one end of your layout to the other, 
spanning multiple pages if applicable.

You can adjust the position of the guide 
by clicking on it and dragging, or for more 
precise positioning, by entering the desired 
value in the Size and Position window (if you 
don’t see the Size and Position window just 
choose it from the View menu).

To remove a guide, select it and drag it back into the ruler area.

That’s the basics of setting up ImagePrint.  

Now it’s time to make a print!

The Basics: Working with images  (continued)

Aligning images (continued) 
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The Basics: Printing 

Making a print

At the top of the Dashboard, 
click the Print button to send 
the current layout to the 
printer. You can also choose 
Print from ImagePrint’s FILE 
menu.

You’ll get a confirmation 
dialog box allowing you to 
confirm a few things--like the 
page size and paper profile.  
Click OK in that box to send 
the job to the ImagePrint 
spooler, Spoolface.  

Spoolface monitors the job’s progress, report any errors and let you cancel or reprint jobs. 
To learn how to use Spoolface, please see the next section.

After clicking print, you’re free to exit ImagePrint. Printing takes place completely in the 
background.  Or, use the scissors (in the floating toolbar) to delete the current layout and 
create a new one.
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The Basics: Spoolface

Where did the print go?

When you clicked Print in the Dashboard, the job to be printed was sent to the ImagePrint 
Spooler for printing.  A spooler is a piece of software that manages print jobs.  A spooler 
allows you to create a “stack” of jobs to be printed, one after the other.  This list of jobs 
currently lined up for printing is called a “queue” (pronounced “Q”).  Spoolers also let you 
cancel jobs, reprint jobs, and keep track of any errors that may occur during printing.

ImagePrint’s Spooler is 
called SpoolFace.  You 
can launch it by choosing 
the printer icon at the top of 
the Dashboard (to the right 
of the Print button and Job 
Name field) for from the 
File menu at the top of the 
ImagePrint main window.

Note: It’s not necessary to launch SpoolFace when printing--jobs will print in the back-
ground without it running, but many users keep it running so they can keep tabs on their 

print queue.

SpoolFace is NOT the print driver

While SpoolFace allows you to monitor, cancel and reprint jobs, remember that with 
Imageprint R.E.D. your system printer driver (the one installed when your printer) is actu-
ally what is communicating with the printer.  If a problem occurs usually you can take care 
of it in Spoolface but you should be familiar with accessing your system printer in case it 
develops a problem outside of SpoolFace’s control   
 
On Macintosh computers system printers are available via the Apple Menu, in 
System Preferences -> Printers and Scanners. 
 
On Windows, the system printers can be accessed from the Windows Start menu 
by going to Settings -> Devices and Printers.
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The Basics: Spoolface (cont)

SpoolFace has three main windows, plus a menu bar along the top (On PC’s, the menu 
bar is part of the SpoolFace window, but on Mac’s it’s up at the top of the screen so don’t 
miss it!)

PC Version Shown

As jobs finish 
printing, they 
move  
to the lower left 
pane.  This is  
the Done Queue.

The upper left sec-
tion of SpoolFace 
is the Active 
Queue.  This is 
where jobs  
will line up to print.  
The top job is  
either printing, or 
the next one in line  
to print.

The large area on the right is 
the Log Window.  A running log 
of any print jobs you’ve done 
appears here.  (The log will get 
truncated automatically, so no 
need to worry about deleting 
any data here).
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The Basics: Spoolface

When you want to 
completely delete a 
job from the Done 
Queue, just drag 
it to the Recycling 
bin.

The bottom left corner 
of the Spoolface win-
dow contains the Status 
Bar.

 
This area give you a 
quick status of the cur-
rent print job. 
It will also tell you if 
the Queue is currently 
Active or Paused. 

If you want to Cancel a job, just drag 
it from the top (Active) pane to the 
bottom (Done) one...

...and if you want 
to Reprint a job, 
just drag it from 
the bottom (Done) 
pane to the top 
(Active) one.
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The Basics: Spoolface

Solving printing problems

If an error occurs when printing (such as an 
ink cartridge becoming empty, a paper mis-
feed, or a connection problem) then the Status 
Bar may display a  numeric error.  Error num-
bers can be checked in the Troubleshooting 
guide--most represent common problems that 
can be quickly fixed.  

If the Status Bar shows the word Paused, that 
means the spooler has stopped sending jobs 
to the printer.  SpoolFace will stay paused until 
you tell it that the problem has been fixed and 
its safe to send new jobs. 

To start jobs going to the printer again, you’ll need to resume the spooler by choosing 
QUEUE from the SpoolFace menu.  The Pause Queue selection will have a check mark 
beside it. Choose Pause Queue to remove the check mark and resume printing.

Be careful!  Re-enabling the Queue will cause it to print all the jobs in the Active (top) sec-
tion of the Spoolface window.  Cancel any unwanted jobs that may have accumulated in 
the active section by highlighting them and dragging them to the bottom (Done) section. 

Hint: Spoolface has other functions such as showing job thumbnails and archiving your 
print jobs.  For more detailed information on Spoolface and printing with ImagePrint see 

the SpoolFace chapter of this manual.
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The Basics: What Next?

If you’ve followed the instructions in this section, you should have a good, basic understand-
ing of the ImagePrint workflow.  You should know how to launch ImagePrint, pick a page size, 
layout images and print them.  You should also have a good understanding of the ImagePrint 
spooler, SpoolFace, and how to control jobs with it.

The rest of this manual is devoted to detailed explanations of the tools and functions you’ve 
learned so far, as well as descriptions of features that were not covered in this basic walk-
through, features like:

• Adding frames and backgrounds

• The Smart Crop Tool

• Boundaries

• Adding Text

• Gallery wrap

• Using Layout Schemes

• Sharpening and Wide Gamut Toning

• Color management and using Color Profiles

• �Templates (Optional module for ImagePrint R.E.D. that allows you to 
design and print customized photo package layouts.)

You may wish to stop reading for now and begin using ImagePrint, coming back to this manual 
as a reference when you want to learn about a particular feature or tool.  Or, you may wish 
to skim through the rest of the manual to familiarize yourself with the full range of tools. And 
remember--ColorByte has numerous videos available online at www.colorbytesoftware.com 
that guide you through many of the above features.

If you need to know more about a tool touched on in this chapter, use the Table of Contents 
to jump to that section.  Remember that clicking any Blue text will jump you to the pertinent 
section of the manual for that topic.
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Tools and Features 
Reference
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ImagePrint Tools and Features Reference
This section is a reference to most of the menus and interface items within ImagePrint.  It is 
not intended as a tutorial on the use of ImagePrint and does not cover some of the basic fea-

tures in detail--for that, see the previous chapter, ImagePrint Basics.  

You can read through this chapter to get to know the features, or jump to one of the areas 
below to learn about a specific one.   (Some of the information from the previous is reprinted 

here in the interest of completeness)

Overview: The ImagePrint Interface

1. The Pages Window - This win-
dow contains the representations of 
all the pages within your layout. This 
is where you will place the images 
you plan to print.

2. The Dashboard - This window 
is your “control center” for most 
ImagePrint functions.

3. The Floating Tool Palette - Icons 
for commonly used tools, like Zoom 
or Rotate, can be found in this tool 
bar.

4. The Image Strip - The Image Strip shows thumbnails of images within a selected folder for 
easy layout.

5. The Main Menu, Size and Position Controls and Shuffle Buttons -  Along the top of the 
ImagePrint window you’ll find the File, Edit, View and Help menus that provide access to some 
ImagePrint functions and advanced tools such as Templates and the Border Browser. Also, 
by default, the Size and Position Controls palette will appear here for easily sizing images. 
Plus you’ll find the three Shuffle buttons which let you instantly rearrange the placement of the 
images on the page to conserve paper or make for easier cutting.

The ImagePrint Main Window (not shown) -  This gray, featureless window is the “mother-
ship” containing all the windows you choose to dock.  All other Windows and Palettes can be 
free floating, or docked within the Main Window.  This allows you to keep some windows in a 
standard docked configuration that can be moved together, while others remain stand-alone 
and undocked.

Note: A context sensitive “mouse menu” containing many of the most frequently used com-
mands, including Shuffle, Rotate, Add Background and Add Text, is also available by right 
clicking (or control clicking) on images or an empty spot in the layout area for convenience.
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Starting ImagePrint

To start ImagePrint, double-click the ImagePrint icon located within the 
ImagePrint folder in the folder in which ImagePrint was installed.  

	 •	 On the PC version, the default location is: c:\program files (x86)\imageprint 
(A shortcut to Imageprint is also created on your PC’s desktop at installation)

	 •	 On the Mac version, the default location is: /Applications/Imageprint 
(Drag the ImagePrint icon to your Dock for convenience)

The Pages Window

The Pages window is the largest win-
dow within the interface, and it is where 
you will create your layouts for printing.  
It consists of pages--anywhere from one 
to hundreds-depending on how many 
you choose to create.

Each individual page represents a 
physical page (or a  defined segment of 
a roll if using roll paper).  

● The white area within the pink bound-
ary is the printable area.

● The gray, patterned border repre-
sents the part of the page on which the 
printer can not print (The non-printable 
area).  Any portion of an image on this 
area of the page will not print.

● If your printer is capable of borderless (full-bleed) printing, and you’ve chosen 
Borderless mode as the Margins Style, you’ll see a red line outside of the page area 
representing the “overprint” area that falls off the paper. By allowing a portion of an 
image to extend into the area bounded by this line, you might avoid “hairlines” along 
the edge of the paper due to misaligned paper when attempting to completely fill the 
page.
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Working with images

File formats

In order to layout and print your images, they must first be opened into the ImagePrint inter-
face.  ImagePrint can open TIFF files, JPEG files, Acrobat PDF and Photoshop PSD files. 

(Note: PSD, PDF and TIFF files will be opened at their saved size, but JPEG files will be 
sized based on pixel dimensions at an assumed resolution of 300 pixels per inch.)

 
While most files of these formats are fine, sometimes layers in PSD or TIFF files may cause 
problems and require flattening of the image.  It is also recommended that you avoid most 
non-alphanumeric characters other than spaces, dashes and underlines.  (For example, 
apostrophes, ampersands, etc. in the name of the file, or in the name of the folder the file 
is in, can cause a file not to be opened).  For best results, make sure files are flattened, 
uncompressed, and have no additional channels to minimize potential problems.

Opening Images

The ImagePrint Image Strip is the most convenient way 
to open files.  Available from the View menu in the Main 
menu, it is described in detail in the previous chapter, 
ImagePrint Basics.	

Image files can also be opened  
via the standard File -> Open  

method from the ImagePrint  
Main menu.

You can also drag files from any folder right into the 
ImagePrint interface.  (And, though not officially supported, 
for most users, dragging from Adobe Bridge works as well!

Hint: Recently opened images will be listed under the File menu for easy opening
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Working with images (cont.) 

Opening PDF Files - The PDF Browser

When you open a PDF file via the Image 
Strip, File->Open command or by dragging 
from a folder, the ImagePrint PDF Browser 
window will appear.  

This window allows you to see all of the 
pages within a PDF file as thumbnails, view 
individual pages in high resolution, and 
select any number of pages for opening 
into ImagePrint.  

Using the PDF Browser

Thumbnails of each page in the PDF document are shown in 
the scrollable area within the Browser. To increase or decrease 
the thumbnail size, use the magnifying glass icons at the top of 
the PDF Browser window.

Click on any thumbnail to select it (a check mark will appear on 
the thumbnail).  To select multiple pages, hold the control key 
(Windows) or the Command key (Mac) while clicking. To select 
a range of thumbnails, click the first in the range, then click the 
last in the range while holding the Shift key down.

Double-click or drag any of the select image(s) to open 
them within the Layout area of Imageprint (New pages will 
be generated as they are filled).

Drag a page thumbnail into the High Resolution section of the PDF Browser to see a high reso-
lution preview of that page.  You can then double-click the high resolution preview to open the 
page in ImagePrint.

If the PDF file has bookmarks, a bookmark palette will appear between the thumbnail pane and 
the high resolution pane.  Click any bookmark to jump to that page’s thumbnail. (You can enlarge 
or close the bookmark pane by clicking the vertical line along its edge and dragging).

You can also jump to a specific thumbnail by typing its page number in the Page field at the top 
of the browser and hitting the Return or Enter key.

Click the vertical line between any component section of the PDF Browser and drag left or right 
to resize that component or collapse it entirely.

Close the browser when done opening pages by clicking the X in the upper right of the window 
(Windows) or the close button in the upper left (Macintosh).

High Resolution 
Page Preview Page Thumbnail 

View

Bookmarks
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Working with images (cont.) 

The Page Origin

The location of the first image on a 
page is determined by the X/Y page 
origin.  The origin is shown as a 
blue colored pair of small lines.  The 
upper left corner of the first opened 
image will align with this marker.   
You can adjust the origin point by 
changing it numerically in the Layout 
Settings section of the Dashboard.

Filling the page

Subsequent images will be added 
to available clear space within the 
printable area, going from the high-
est to lowest, left to right.  If Auto 
Flow is in effect, an image that can’t 
fit on the page will be added to a 
new page, as shown in the page 
layout area. If Auto-Flow is not in effect, when an image can’t fit on the page, it will be placed at 
the origin point on top of previous images. (Use the scissors icons to delete unwanted images 
from the page).

Shuffle

Click any of the three Shuffle buttons to re-arrange the images in the layout to conserve 
paper and/or make them easier to cut apart.  Shuffle is described in detail in previous chapter, 
ImagePrint Basics.

Image Information

Move your mouse over an image to see its size and location on the page listed in the bottom 
left corner of the ImagePrint Main window. 
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The Dashboard

The Dashboard is where you’ll find many 
of the features essential to making a print 
brought together in one place, organized 
into an easily accessible and logical menu 
structure.  The menu choices are laid out in 
a top to bottom format that takes you natu-
rally through all the steps needed to make a 
print, and the currently selected options are 
always visible at a glance. 

While you can view and set many image 
and layout related features in the dash-
board, with ImagePrint R.E.D. there are 
some paper and printer related settings that 
must be set in the system printer driver (the 
free software driver that comes with each printer).   

To access a menu in the Dashboard, click the 
small triangle item beside its name to expand 
that section.

The current setting for each 
Dashboard item is shown in blue 
to the right of the menu label.  This 
allows you to easily check your set-
tings prior to sending a job to print.

 

Settings labeled with “Set in driver”--such 
as Margins Style-- can not be set within 
ImagePrint but must be set in the system 
printer driver.

The following few pages will describe the menus available within the Dashboard.
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The Dashboard (cont)

The Print Button

The top of the Dashboard is where you’ll find the Print button.  Click this button 
to immediately send your job to the ImagePrint spooler, Spoolface, for printing.  
Printing is described in chapter 8, Printing.

The Job Name Field

Next to the Print button is the Job Name field.  This field contains the name that the 
layout will be given when it appears in Spoolface.  By default, the job name will be 
the name of the first image added to the layout. Edit the field by clicking and typing 
a new name.

 The Spoolface Button

The small icon beside the Job Name field is the Spoolface launch button.  Click this 
button to launch Spoolface, the ImagePrint spooler.  This is where you can view the 
status of print jobs as well as cancel, delete or reprint them.  Spoolface is described 
in detail in chapter 8, Printing.

The Image Strip Folder Selector

This section of the Dashboard 
allows you to choose the folder 
you wish the Image Strip to 
use.  Choose a folder using the 
displayed folder tree structure 
to populate the Image Strip with 
the JPEG, PDF, TIFF or PSD 
(Photoshop) files within it.  The 
Image Strip is described more 
fully later in this chapter.
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The Dashboard - Printer Section

Printer Selector Section  

The Printer Selector sec-
tion is where you select 
between your installed 
ImagePrint R.E.D. and 
ImagePrint Black drivers (if 
installed). For ImagePrint 
R.E.D. it is also where the 
Color Management mode is selected, as well as the Profile selection mode. 

Selecting a system printer driver

When an ImagePrint R.E.D. Large or Desktop driver is selected in the Printer Selector 
drop-down menu, the menu to the right will show the system printer driver it is currently 
using.  If that menu appears empty, it just means you haven’t yet selected a printer driver 
to use.

To select a printer driver--or to configure the one you are currently using--click the  
button beside the printer driver menu.

The system printer dialog box will 
appear, letting you choose from your 
system printers which one you want to 
use with ImagePrint R.E.D.

It is extremely important that you 
choose the right parameters-
-such as page size and media 
type--in your system printer driver 
prior to printing or laying out 
images in ImagePrint R.E.D.

Setting up your system printer driver for ImagePrint R.E.D. is detailed in pages 5 through 
8 of the previous chapter, ImagePrint R.E.D. Basics.  

Windows

OSX

Pixma Pro 1
HP Laserjet
TX 1700
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The Dashboard - The Printer section (continued)

Color Management Mode

Also within the PRINT section of the dashboard are controls for setting the ImagePrint 
R.E.D. Color Management Mode and the Printer Profile Selection Method.

The Color Management Mode determines if ImagePrint or the system printer driver 
will handle color management.  In most cases it should be set to ImagePrint Manages 
Colors.

The Profile Selection 
Mode determines how the 
Printer (paper) profile will 
be selected.  Automatic 
mode is the default and 
should be used when a 
paper created by your 
printer manufacturer is in 
use.  With Automatic, the 
right profile will be automatically chosen when you pick the Media Type in the system 
printer driver.

If using a 3rd party paper, instead of 
Automatic choose the proper paper 
profile by clicking the drop-down menu 
and choosing from the list of installed 
profiles.

Color Management options are 
described in detail in Chapter 6, 
Profiles and Color Management.
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The Dashboard - The Printer section (continued)

Paper Size 

The Paper Size field within the ImagePrint R.E.D. Dashboard shows the page size 
that is currently in effect.  Although the page size is shown, this setting is not alterable 
within the Dashboard.  It must be set in the system printer driver.

For information on choosing the page size and other system printer parameters, see 
the previous chapter: ImagePrint Basics.

ImagePrint R.E.D. Large supports any printer size. 
 

ImagePrint R.E.D. Desktop supports any printer that can print to a paper width of 
17-inches or less.  Choosing a printer with a larger paper width capacity will cause your 

prints will be watermarked with the word DEMO.

Printer Profile 

The Printer Profile field simply shows the 
ICC/ICM profile currently in use.  This is 
the profile selected in the Printer section 
of the Dashboard according to the proce-
dures outlined in the previous pages.

Media Feed

Options that relate to Media Feed--such 
as choosing Roll vs Sheet paper, roll auto-
cut manual vs automatic feed, are set in 
the system printer driver.  Please see the 
previous chapter, ImagePrint Basics, for more information.  

Margins Style 

Margin settings--such as Borderless (full bleed) --are also set in the system printer 
driver. Please see the previous chapter, ImagePrint Basics, for more information.  
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Image Properties 

The next section of the ImagePrint Dashboard is the 
Image Properties section.  

Here you will find controls relating to the currently 
selected image in one convenient place.  You can 
resize and position the image or step/repeat it, apply 
custom color management settings as well as adjust 
the transparency and shadow point.

The tools and controls in this section are fully 
described in Chapter 10 - Image Properties.

The Dashboard (cont) 
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ADVANCED DASHBOARD  
SETTINGS 

The Advanced section of 
the Dashboard contains set-
tings and tools that change 
infrequently, aren’t needed 
for basic everyday print-
ing or are used for specific 
workflows such as those 
requiring crop marks or 
automatic image sizing. 
Following are descriptions 
of the settings found within 
the Advanced section of the 
ImagePrint Dashboard.

Print Setup (not used)

Since most print related parameters are set within the system printer driver, the Print 
Setup section of the dashboard is deprecated with ImagePrint R.E.D.  There are no user 
configurable features within this part of the dashboard.

Layout Style and Auto Layout Settings

Layout Styles and Auto Layout Settings control the various methods ImagePrint has of 
automatically sizing and positioning images as they are opened.  For detailed information 
please consult Chapter 8, Layout Styles and Automatic Layout Settings.

The Dashboard - Advanced Settings 
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The Dashboard: Advanced (cont) 

Crop Marks

The Crop Marks section of the 
Advanced Dashboard gives access 
to the Crop Marks controls.

Here, you can specify settings 
for crop and cut marks which will 
appear on your prints.  

Crop marks will be printed as vertical lines, with Cut marks appearing as hori-
zontal lines at each corner of every image on the page when crop marks is 
on.    

Important note on Crop marks with Templates and Step/Repeated 
images 

 
Crop Marks will appear at the edges of an entire template or group of step/repeated images as 

a whole--not around each individual image.  
 

If you want crop marks to appear for each image in a template you can ungroup the template 
by right (or control) clicking it and choosing “Ungroup” in the menu that appears.  

 
For step and repeated images there is no way to have crop marks appear for each image. If 
you need crop marks for each image, you can copy/paste the image to duplicate it, or open it 

multiple times, instead.

Cut Line
Crop Line
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The Dashboard: Advanced  (continued)

Print Crop Marks  Click 
this checkbox to turn on 
Crop/Cut Mark printing.
 
You can specify crop set-
tings on the left side of the 
window, or just use the 
pre-defined styles avail-
able on the right.  Here’s 
descriptions of the crop 
mark cuts available in the 
Crop Marks preferences 
window:

Thickness  Represents the thickness of the crop and cut lines in the specified measurement 
units.

Length  Specifies the length of the crop and cut marks in the specified units.

Cut  Designates the distance the two lines will be moved in relation to each other.  The verti-
cal crop mark will be moved in a vertical direction, the horizontal cut mark will be moved in 
a horizontal direction.  (Positive values will move the marks inward in relation to the image, 
negative values will move the marks out from the image). 

A 0 value for cut will butt the origin points of the lines.  

A cut value that is equal to half the Length value will result in a cross shape.  

A cut value equal to the Length value will result in the tops of the lines butting (not 
shown).

Distance  Designates the distance the crop marks will be from the corner of the image.  
Click the Symmetrical button to have the crop marks appear an equal distance from each 
corner of the image.  Without Symmetrical selected, you can specify different values for the 
top and bottom and left/right distances.
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Dashboard: Advanced  (cont.)

Predefined Crop 
Styles  

You can now 
choose between 
the 3 most common 
crop mark styles by 
clicking one of the 
predefined buttons 
on the right side of 
the crop mark window.

Below are the available predefined crops:

“L” Style			          “Inverted L” Style	         Cross shaped
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Dashboard: Advanced (cont.)

Defining your own crop style

If you need custom crop styles not available in the pre-defined styles, you can make your own 
using the controls in the crop window.  Here’s some examples (assuming symmetrical distanc-
es):

Note: Since the distance and cut values affect the position of both the Crop and 
Cut lines equally, some crop types (like a capital T shape) are impossible to 

achieve.

Distance 0.0
Length .25
Cut 0    

Distance 0.0
Length .25
Cut .123   (Half the Length)
The lines moved vertically and 
horizontally inward .123	

Distance 0.0
Length .25
Cut .25    (Equal to Length) 
The lines moved vertically 
and horizontally inward .25

Distance 0.0
Length .25
Cut .3

Distance .3
Length .25

Cut .123
Distance value pushes line 

intersection away from image.

Distance .3
Length .25

Cut .25

Distance 0.0
Length .25

Cut  - .1
Negative cut means lines moved ver-

tically and horizontally outward .1.
For non-intersecting lines, distance 

refers to where lines would meet
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Dashboard: Advanced (cont)

Annotations (also known as Captions)

The Annotation section of the Advanced Dashboard area provides controls for adding text 
annotations (captions) to your images.  The filename (with or without extension), date and 
time can be automatically printed beneath each image.  

Print Annotation  The Print Annotation checkbox turns annotation printing on or off.  Select 
this checkbox to enable the printing of annotations according to the other settings within the 
Annotation settings area.  

You can also toggle annotations via the icon in the Page Control area in the bottom right 
portion of the ImagePrint Main Window.

File Name 	 This setting will cause the File Name to be printed below each image 
when annotations are enabled.  If the filenames have 3 letter extensions 
(for example .tif, .jpg, .pdf), then choosing the “and Extension” checkbox 
will cause it to be included in the annotation, otherwise the extension will 
be left off.

Date 	 This setting will cause the current date to be part of the annotation.  If the 
“and Time” checkbox is selected, the current time will be added as well.

Font Size 	 The Font Size drop down menu allows you to choose the size of the 
annotation.  You can choose between Large, Medium and Small.

Note: Normally, annotations will appear beneath each image on the page.  
To have annotations appear beneath a group of images, create an Image 

Boundary around them or place them in a template.  For information on using 
Image Boundaries, see the Boundaries chapter later in this manual.
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Dashboard: Advanced (cont)

The Context Sensitive Mouse Menu 

Many operations can be performed on an 
image or the entire layout quickly via the 
ImagePrint Mouse menu.  

Activating the Mouse Menu depends on your 
Operating System.

    •     Macintosh: To access the Mouse menu 
on a Mac if you don’t have a right mouse 
button, hold the Control Key down while 
clicking on the image.

	

	 • 	 PC: To access the Mouse menu on a PC, 
right-click the image.

Note that the contents of the Mouse Menu depends on what you are clicking--

•	 Right click an image to show functions that apply to images such as Rotate or 
Add Background.  

•	 Right (Control) - Click on a blank area of the layout window and image specific 
functions won’t be available, but some non-image specific features like Add 
Text will.  

•	 Right-click on a group of images, or a template, and template specific options--
like Ungroup, will be shown.

Below are descriptions of the various Mouse Menu options.

For convenience, most of the tools available in the Mouse Menu can also be found in the 
Main Menu and/or Tool bar. 

Copy/Paste

Copy will copy the clicked on image to the clipboard for later past-
ing.  If you click on an empty area of the layout window instead 
of an image, and have already copied an image to the clipboard, 
Paste will be available in the Mouse Menu for pasting the previ-
ously copied image.
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Rotate

Choosing Rotate will let you choose to rotate the image clockwise, or 
counterclockwise, 90 degrees.

Add Background to the image 

Choose this option to open the Backgrounds and Frames window.  
This window allows you to apply colored backgrounds, image back-
grounds, frames and mattes, and gallery wraps to your image. If you 
have already applied a background or frame to the image, this menu 
item will show “Edit Background”.  For more information on these 
functions, see the Backgrounds, Frames and Gallery Wrap chapter 
later in this manual.

Add Boundary

Choosing Add Boundary will allow you to create an Image Boundary 
around an image or group of images.  Think of boundaries as sub-
pages that can contain images and text.  Each of these sub-pages can 
have its own crop marks and annotations, making for easy genera-
tion of album pages or any output that requires multiple items treated 
as one page.  Boundaries are also a convenient way of grouping 
images for moving them together, and they can even be used as a 
colored background for a set of images.  For more information on this powerful function, see the 
Boundaries chapter later in this document.

Fill Non-proportionally  

The Fill selection will cause the  selected image to expand to fill the cur-
rent page.  Note that this option will not preserve the aspect ratio of the 
selected image, and image distortion will usually occur.

Fit Proportionally

The Fit selection will cause the  selected image to expand to fit as 
large as possible within the current page without distorting the image.  
The aspect ratio of the image is preserved as the image is resized.

The Mouse Menu (cont)  



5-21 ImagePrint R.E.D. User’s Guide

The Mouse Menu (cont)  

Mirror

Choosing Mirror will let you flip (mirror) the selected image 
horizontally or vertically.

Center	

This option will center the currently selected image within the print-
able area of the page.

Correct 

Choosing Correct will give access to the various 
Correction tools ImagePrint offers.  Please see the chap-
ter in this manual on Correction tools.
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The Mouse Menu (cont)  

Add Text / Edit Text

By right clicking (PC) or control-clicking (Mac) anywhere on the layout area and choosing Add 
Text, you will be presented with the Add Text window. (Once you have Added text, right clicking 
or Control Clicking the text will give you the option to Edit the text.)

You can also select the  text icon from the Floating Tool Palette to change your cursor to a 
text icon. then click anywhere in the layout area to place text. Click the text icon again to return 
the cursor to normal.

Once created, text is treated like an image--you can move it around on the page, group it with 
other images, delete it with the scissors tools.  You can also edit the text by right clicking/control 
clicking it, and choosing Edit Text from the Mouse Menu.

The Add Text Window

With the Add Text window, you can add text using any 
font available on your system.  The font can be colored 
and styled, and you can even add drop shadows.  

Adding the text

Add text by typing it into the text entry section at the top of the Add Text window.  You’ll see the 
text added to the layout window at the location you last clicked with your mouse.

Choosing the Font

Choose the desired font by clicking Font... at the top of the Add Text window.  The Select 
Font window will appear.  There you can choose the font, the style and the size of your text.  
When you click OK in the Select Font window, you’ll see the changes applied to the text within 
the window as well as the text in the Layout window.

Type text here

Cross Platform (Mac/Windows) Font issues

If you are printing from a Mac client computer to a Windows host, or from a Windows host 
to a Mac client, the fonts chosen on the Client computer may not match those printed by 

the host.  To limit font compatibility issues when printing cross platform, use TTF (True Type 
Fonts) whenever possible.
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The Mouse Menu (cont)  
Add Text / Edit Text    (cont)

Advanced Text Options

Click the Advanced button at the top 
of the Add Text window to access 
controls for changing the text color, 
transparency, background color, and 
alignment.  You can also add a drop 
shadow and specify its color and dis-
tance.  

Click the color menu in the Text area 
to access a color chooser for the text.

The Transparency slider allows you 
to adjust the opacity of the text--move 
this slider to the right to make objects 
under the text appear through it. 

The Alignment controls allows you to 
specify how the text should be justi-
fied: Left, Center, Both, or Right.

Click the color menu in the 
Background area to access a color 
chooser for the text background (the 
text background is a rectangular 
area behind the text filled with color).  
Choose Transparent in this menu if 
you want no background to appear.

Click the Drop Shadow checkbox 
to enable a drop shadow on your 
text.  You can pick the color via the 
color menu below the Drop Shadow 
checkbox.  You can also specify the 
angle of the drop shadow, and the 
distance it will appear in that direction 
from your text.

Type text here

Hint:  Copyright © and other symbols

Some symbols not on the keyboard must be 
created with a combination of keys. For exam-

ple, © is Option-G on Mac, and Alt-0169 on 
Windows.  Use system utilities like “Charmap” 

(Windows) or “Keyboard Viewer” (Macintosh) to 
locate the key combinations needed.
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The Mouse Menu (cont)  
Applying your text

Once you are satisfied with the text you have created, click the green check mark in the upper 
right corner of the Text window to apply the text.  To close the Add Text window without making 
changes, click the X button.

Once the text has been added, it can be repositioned by clicking and dragging, just like any 
image on the page.

Editing your text

To edit the contents of the text, or change its size, color or other parameters, right-click or con-
trol-click the text, then choose Edit Text in the Mouse Menu that appears.  The Edit Text win-
dow will appear, allowing you to make changes using the same controls you used when adding 
the text.

Forever

Hint:  Cropped final letter

For some decorative fonts, such as 
cursive script, you may need to add 

a space to the end of the last letter to 
ensure that character is not truncated
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Working with Images - Advanced 

Stepping/Repeating an image

ImagePrint offers a unique and powerful method of interac-
tively adjusting the step (horizontal copies) and repeat (ver-
tical copies) on images within your layout by just dragging 
the image with your mouse. (You can also repeat images 
by using the Step and Repeat fields located in Image 
Properties in the Dashboard.)

Increase/Decrease the number of images:  To change the number of images being 
stepped and repeated, press and hold the SHIFT key on your keyboard, then, with the 
mouse, click the sides or corner of the image.  

• Drag the cursor horizontally to increase/decrease images in the horizontal direction.  

• Drag the cursor vertically to increase/decrease images in the vertical direction.  

• Drag the cursor diagonally to increase/decrease the images in both directions.  

Increase/Decrease the distance between images:  To change the distance 
between the images in a step and repeat pattern, press and hold the SHIFT key on your 
keyboard, then use the mouse to click within the image.

• Click and drag the side along the Y axis to increase /decrease space horizontally

• Click and drag the side along the X axis to increase/decrease space vertically 

• Click and drag a corner to increase/decrease space in both directions 

Don’t forget, you can also step and repeat images numerically for more precise 
control with the Step and Repeat fields.  See Chapter 10, Image Properties, 

for details.

Hold SHIFT while drag-
ging the corner or edge of an 

image to duplicate it
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Working with Images - Advanced (cont)  

Cropping images with Smart Crop

ImagePrint’s Smart Crop feature 
allows much more precise crop-
ping of images than in previous 
versions.  

To activate Smart Crop, double-
click an image that you have 
added to the ImagePrint layout.  

A separate window will appear, 
containing a preview of the 
image.  It is within this window 
that you will adjust the crop-
-any changes made here will 
immediately be reflected in the 
image within the layout window.

The Crop Palette will also 
appear beside the Crop window.  
This palette will let you choose 
from preset crop sizes, or create 
your own.

Cropping with preset sizes

The easiest way to crop an image is to choose a preset photo 
size.

Click the Photo Sizes menu within the Crop Palette to choose 
from a list of common photo sizes.  

Pick a photo size to immediately have the selection marquee 
within the crop menu change to the new dimensions.  The image 
in the layout area will also change to the exact size specified.

Mac Version Shown
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Working with Images - Advanced (cont)  
Cropping images with Smart Crop (cont.) 	

Cropping with custom sizes

You can also type in custom Width and Height values for the 
crop in the Crop Palette.  Hit the return key after typing in each 
value to see your image immediately cropped to your new 
size. To remove the crop settings and return the image to it’s 
uncropped state, click Remove Crop.

Changing the crop aspect ratio

To change the shape of a crop, type the desired values in 
the width height field.

Resize or move the crop by clicking and dragging

You can also click and drag control points of the crop mar-
quee to change the crop size interactively.  Control points 
are the small circles on the corners or mid-line points of the 
dashed line marquee.

Drag a control point to adjust the crop while maintain-
ing the image’s aspect ratio as shown in the width/height 
fields. 

By shrinking the cropped area, you effectively are zoom-
ing in on your image.

Moving the Crop Location

You can adjust the crop location by clicking in the middle 
of the Smart Crop window and dragging the cropped 
area.  

Finishing up

When done cropping the image, close the Crop Palette 
by clicking the X in the upper corner. (Images that have 
been cropped will show a small cropping tool icon in their 
upper right corner).

To adjust an already cropped image, just double-click it 
again to re-access the Crop Palette.
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The Tool Palette

The ImagePrint Floating Tool Palette is a vertical or horizontal, dockable bar of buttons 
that gives easy access to many of the more frequently used commands within the soft-
ware.  Following are descriptions of each of the tools available within the ImagePrint Tool 
Bar:

 
Zoom In  Click the Zoom In icon to zoom in on  the layout 
area. 
 
 

 
Zoom Out  Click the Zoom In icon to zoom out, expanding 
your current view of the layout area.

Rotate CCW  This button will cause the currently selected 
image to rotate ninety-degrees counter-clockwise.  You can also 
rotate the image by right-clicking it and choosing CCW from the 
pop-up menu that appears. 

Rotate CCW  This button will cause the currently selected 
image to rotate ninety-degrees counter-clockwise.  You can also 
rotate the image by right-clicking it and choosing CCW from the 
pop-up menu that appears.

Mirror Vertically  This button will cause the currently selected 
image to be mirrored vertically across the horizontal axis.  

Mirror Horizontally  This button will cause the currently 
selected image to be mirrored horizontally across the vertical 
axis.  
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Fit to Margins The Fit to Margins 
button is a brand new method of siz-
ing images according to the desired 
page margins in the final print. Click 
this button, and a pop-up window will 
appear that allows you to specify the 
horizontal and vertical margins you want to have. Click OK, and 
ImagePrint does the rest--sizing (and cropping if necessary) the 
image to perfectly fit the page without distortion while maintaining 
the specified margins. 

Fit to Page (Also available from Mouse Menu) The Fit Image 
button will cause the  selected image to expand to fit as large as 
possible within the current page without distorting the image.  The 
aspect ratio of the image is preserved as the image is resized.

Center Image Clicking the Center button will center the currently 
selected image within the page.  

Original Size Clicking the Original size button will return the cur-
rently selected image to its original size, discarding any resizing 
operations previously performed.

Delete Selected Image The Delete Selected Image button will 
remove the currently selected image from the ImagePrint layout.

Delete All Images on All Pages  The Delete All Images on All 
Pages button will delete every image on every page in your layout.

Text Click this icon, then click anywhere in the layout area, to add 
decorative text (See Adding Text in the Mouse Menu section ear-
lier in this chapter)

Alignment This special button lets you align any number of imag-
es to one “master” image.  More information on how to use this 
tool is in the previous chapter, ImagePrint Basics.

The Floating Tool Palette (cont.)
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The Main Menu

The ImagePrint Main Menu offers access to most features of the program.  

The following pages will step through the available within the ImagePrint Main 
Menu.  

The File Menu 

The File Drop-Down Menu contains the commands 
necessary to open image files, send your layout to 
print , and to quit the current session of ImagePrint.  
The four most recently opened images will also be 
listed under this menu for convenience.

Following is a description of each command found in 
the File drop-down menu.

Open  

The Open command allows you to open 
TIFF, PDF, JPEG and PhotoShop PSD 
files.  Clicking on the Open Button brings 
up the standard file selection dialog, from 
which your files can be chosen.  

Remember, you can also open images by dragging them directly 
into the layout window, or by using the Image Strip.
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The Main Menu (cont.)

Rebuild  

The Rebuild command allows you to  rebuild a 
previous layout from the ImagePrint Spooler.  

Choosing Rebuild will cause the Rebuild Window 
to appear.

Rebuilding Jobs

The Rebuild window shows 
all the jobs on right side of the 
SpoolFace window for your 
chosen printer.  

Highlight any job by clicking 
on it, and the layout that job 
contained will be “rebuilt” 
into the ImagePrint layout 
window. Each image in the 
original job will be opened, 
with all its sizing, color man-
agement and other settings 
intact.

Note that rebuild a layout 
can take a significant amount 
of time, depending on how 
many images were in the lay-
out and their size.  

Important:  All files that were in the layout being rebuilt MUST be in the 
same location on your computer that they were in when the layout was 

originally made, or they will not appear in the rebuilt layout!
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The Main Menu (cont.)

Save Layout Scheme  

This menu item will cause the Layout Scheme 
Save Dialog window to appear, for saving Layout 
Schemes created in the Automatic Layout Settings 
section of the Dashboard->Advanced.  For more 
on using and saving Layout Schemes, see chapter 
8 of this manual.  

Save / Load Correction Data  

The Save and Load Correction Data selections 
allow you to both save and recall settings from 
the Correction Tools.  For information on using the 
Correction tools, see chapter 9, Correction Tools.

Print  

The Print command is used to the send the cur-
rent layout to the ImagePrint Spooler for printing 
via your System Driver.  
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The Main Menu (cont.)

Exit  

Windows version only

The Exit command will exit the ImagePrint appli-
cation on the Windows version. 

Quit  Mac version only

In keeping with the standard Macintosh 
 Interface Guidelines, the Mac version uses 

a Quit command, located under the 
ImagePrint menu.

Mac Version

PC Version
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The Main Menu (cont.)

The Edit Menu 

The Edit Drop-Down Menu gives access to 
the Copy/Paste commands, as well as the 
Combined Corrections controls, Template 
creation controls and the Background, Frame 
and Gallery Wrap controls.   Note that many of 
the commands available in this menu are also 
available in the context sensitive Mouse Menu, 
accessible by right- or control- clicking within 
the layout area or image.

Copy  / Paste  

These standard commands allow you to copy the currently selected image to computer 
memory and then Paste the image onto a page.  Copying and Pasting images is the 
quickest way to create stand-alone duplicates of an image.

Corrections  

Choosing Corrections will give access to the various Correction tools ImagePrint R.E.D. 
offers.  Please see the chapter in this manual on Correction Tools.

Templates  

This command will cause the Templates design window to appear.   
Using the tools within this window will allow you to create templates 
(or packages) for your images.  For more information on creating and 
using templates, please see chapter 11, Templates. (This feature 
may not be available with ImagePrint R.E.D. or it might require addi-
tional purchase as an add-on. Please contact ColorByte for more information).
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The Main Menu (cont.)
Edit (cont.)

Add Background and Boundary 

The Add menu entry has two options: 

Add Background, which gives access to 
the Background, Frame, Image and Gallery 
Wrap commands which allow you to put 
decorative borders and mattes around 
your images, or extend them with a gal-
lery wrap for frameless mounting.  If you 

have already applied a background or frame to the image, this menu item will show 
“Edit Background”.  For more information on these functions, see the Backgrounds, 
Frames and Gallery Wrap chapter later in this manual.

Add Boundary, which gives access to the power Add Boundary command. 
Boundaries can be used to designate separate sections of the page--think of 
boundaries as sub-pages that can contain images and text.  Each of these sub-
pages can have its own crop marks and annotations, making for easy generation 
of album pages or any output that requires multiple items treated as one page.  
Boundaries are also a convenient way of grouping images for moving them togeth-
er, and they can even be used as a colored background for a set of images.  For 
more information on this powerful function, see the  Boundaries  chapter later in 
this document. 
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The Main Menu (cont.)

The View Menu 

The View Drop-Down Menu allows you to switch 
between normal page layout and spreads, and to deter-
mine which windows are visible within the interface, 
and if they are dockable.  You can also reset the win-
dow positions from the View menu, and, on Windows 
computers, this is where the Preferences window is 
accessed (On Macs, Preferences is found under the 
ImagePrint menu.)

Zoom  

The Zoom selection allows you to choose to zoom in, or 
out, of the layout area just as if you selected the magni-
fying glass icons from the tool palette.

Page Layout  

Choosing Page Layout will let you switch between the default page layout mode, and spread 
mode (also known as Book Mode).  More information on Page Layout Modes can be found in 
Page Layout: Spreads in the ImagePrint Basics Chapter of the Manual.

Tools, Size Position Controls, Pages, Image Strip, Borders Browser, Dashboard  

Each of these windows can be displayed or hidden by choosing the appropriate option here. 
You can also choose to make any of the listed windows dockable (meaning they will snap into 
the Main ImagePrint window when dragged near one of its internal edges.

Reset Window Positions

This useful command will reset all windows to their original, default positions.  Tools, Size 
Position Controls, Pages, the Image Strip and the Dashboard will all dock into the main window.

Preferences  

The Preferences option appears in different locations within the ImagePrint Menu structure for 
Macintosh and Windows users.  The View menu is the location on the Windows version, while on 
the Macintosh version Preferences appears in the ImagePrint menu.

The Preferences Window has controls for various options including default Profiles and Snap-to 
alignment settings. For more on Preferences, see chapter 7: Preferences. 
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The Main Menu (cont.)

The Help Menu

The last menu to mention in the 
ImagePrint Main Menu is the 
Help menu.

Check for updates...

Choosing this option will cause 
ImagePrint to check online to 
see if new updates to the software are available. If a new release is found, choose 
“Download and Run Installer” in the Checking for Updates window to download 
the new version and have it automatically installed.  After the update downloads, 
ImagePrint will quit, then the update will automatically install (you may be asked for 
your computer password as part of the process).  

The process will take a few minutes to complete, but afterwards you’ll be running 
the very latest revision of ImagePrint.

Tip: Sometimes updating the software--even if you’re already on the 
current version--can be a quick fix for common problems, especially 

those that arise from an operating system update.

Troubleshooting

The comprehensive Troubleshooting guide can be accessed from the Help menu 
as well--most common problems can be solved by consulting this guide.

Manual

Here you’ll get access to the ImagePrint Users Manual you are reading now.



Profiles and Color 
Management

6
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Profiles and Color Management

ImagePrint R.E.D. is a Color Managed application.  This means that it utilizes ICC (or ICM) 
color profiles throughout its workflow.  These profiles are used to characterize the color 
space of the images being printed, the monitor displaying those images, and the output 
device printing them. 

This section gives detailed descriptions on ImagePrint R.E.D.’s use of profiles as well as 
delving into the topic of Color Management itself.  Although choosing the correct settings is 
usually a simple process becoming familiar with these concepts and procedures is the best 
way to avoid unexpected color problems.  

The first part of this chapter, Choosing Profiles, jumps right to the specifics of specifying the 
Color Management settings within ImagePrint R.E.D..  If you just want to choose the right 
profile for your printer and images, this first section is all you’ll need to read.

The rest of this chapter is devoted to explaining other Color Management related concepts 
such as Rendering Intents, soft proofing and printing without color management to create 
your own profiles. 

Acquiring Printer Profiles for your papers

Choosing Profiles and Color Management settings

Types of Profiles

Rendering Intents

Soft Proofing

The Shadow Point Slider

Turning off ImagePrint’s Color Management
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Choosing Profiles and Color Management 
Settings

Acquiring Printer (paper) profiles

Printer profiles characterize the paper you print on, the inks you print with, and the 
printer itself. 

Since ImagePrint R.E.D. uses the system printer driver (the software provided by your 
printer manufacturer), any ICC paper profile made for your printer driver can be used 
by ImagePrint R.E.D.

OEM Profiles

When the system printer driver is installed, paper profiles for the printer maker’s papers 
(sometimes called OEM profiles) are installed as part of the process meaning you will 
have access to most of their profiles immediately.

3rd Party Profiles

Profiles for 3rd party paper makers must be acquired from the paper maker.  Typically 
these profiles can be downloaded from an online profile repository but contact your 
paper manufacturer for specific information on acquiring the right profiles to work with 
your printer model.  

Once acquired, the 3rd party paper profile must be installed in your computer operating 
system for ImagePrint R.E.D. and other applications to use them.

For Windows computers to install an ICC paper profile, just right click the profile and 
choose “Install”.  It will be copied to the proper color profile on  your system.

For Macintosh computers, the easiest way to copy the profile is the following proce-
dure:
	 -	 Hold down your OPTION key while clicking on the GO menu at the top of the 

Finder screen.

	 -	 In the list of folders, click LIBRARY

	 -	 That will open your user’s Library folder.

	 -	 In the window that appears, double-click Colorsync, then double-click Profiles.  

	 -	 Drag your ICC profiles into the folder to install them.
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Choosing the Color Management Mode

Once you’ve acquired the printer profiles for 
your papers, you’ll need to tell ImagePrint 
R.E.D. how to use them.  

ImagePrint R.E.D.’s Color Management mode 
and profile selection settings are found in 
the ImagePrint Dashboard within the Printer 
Selection area.  

Expand the Printer Selection area by clicking 
the arrow icon to its left.

Color Management Mode

Within the PRINT sec-
tion of the dashboard are 
controls for setting the 
ImagePrint R.E.D. Color 
Management Mode.  Two 
modes are available:

    -	 ImagePrint manages colors - With ImagePrint R.E.D. managing colors,  ImagePrint 
will handle the conversion from your image colorspace to the printer color space of 
the printer profile.  This is the default mode and should only be changed when printing 
black & white images using a grayscale only mode within your system printer driver 
such as the Epson Advanced Black & White or Canon’s Black and White printing selec-
tion. 

    -	 Printer manages colors - Selecting this mode causes the system printer driver to 
handle color management instead of ImagePrint R.E.D. This method  takes the image 
profile to paper profile conversion out of ImagePrint R.E.D.’s control and should only 
be used if using one of the special black & white modes supported by your system 
driver.  

Choosing Profiles and Color Management Settings (cont.)



6-5 ImagePrint R.E.D. User’s Guide

The Profile Selection Method

Just below the Color Management Mode menu is the Profile Selection menu.  This menu allows 
you to determine which profile will be used.  There are three methods: Automatic, Manual and No 
Color Management.

Automatic Profile Selection 

Automatic profile selection is 
the default.  Use this selec-
tion method if you are using 
a paper made by your printer 
manufacturer (such as Canon 
or Epson). 

Choosing the proper Media Type in the system printer driver will cause the correct ICC profile 
to be chosen for the paper automatically.  

For information on setting the Media Type, as well as other paper options in your system printer 
driver, please see pages 5 through 8 of the earlier chapter, ImagePrint R.E.D. Basics.

Manual Profile Selection 

If you are using a 3rd party paper (one 
NOT made by your printer manufacturer) 
you’ll need to choose the proper profile 
for your paper. This profile will need to 
have been acquired from your paper 
maker and installed on your system 
according to the normal methods. For more infor-
mation on installing paper profiles see the previous 
section in this chapter.

The Profile Selection menu provides a list of all the printer profiles installed on your system. 
Just click the menu to see it. 

No Color Management 

The final profile selection method is one that does not use a paper profile at all: No Color 
Management. Only select this method if you are printing a color calibration target that requires 
no color management.  Printing with no color management is described in detail later in this 
chapter.

Choosing Profiles and Color Management Settings (cont.)
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A word about Media Types

Remember: In addition to selecting the correct printer profile for your media, you’ll also 
need to select the proper Media Type for it in the system printer driver. Media Types tell 
the printer how to set its paper feed controls and inking limits for different types of media.   
Each media type is based on a paper made by the printer manufacturer.

 
You can set the Media Type before, or after, selecting the profile. Detailed information on 
selecting the Media Type in the system printer driver is described in the earlier chapter, 
ImagePrint Basics. 
 
Which Media Type to use? 
 
For OEM papers (those made by your printer manufacturer, like Epson or Canon) you’ll 
usually pick the Media Type that corresponds to the name of the paper.  

For 3rd party papers, you should pick the one 
recommend by your printer manufacturer.  

To help in knowing which one to choose, 
ImagePrint R.E.D. will display the recommended 
Media Type right below the profile selection for 
many popular 3rd party papers.  However, we 
aren’t able to do that for all papers and printers.  

If a recommendation is not available for your 
media, check with your paper manufacturer for 
the right one to use.

Choosing Profiles and Color Management Settings (cont)
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Specifying the Source (Image) Profile
Source profiles define the range and quantity of colors available within an image.

Unlike the Printer profile, source profile settings seldom need to be changed.  This is 
because most users use embedded (sometimes called “tagged”) profiles in their imag-
es--embedding your source profile in your image ensures software programs know, right 
from the start, the correct source profile for your image. Most software programs allow 
embedding the profile within their Save File dialog.  

ImagePrint will automatically apply the embedded profile if found in an image. For most 
workflows, that means nothing else needs to be done--if you know that all of your images 
have embedded profiles (most do) you can move on to the next section--you are done 
selecting profiles!

For images that don’t have embedded profiles, ImagePrint  will use the default source pro-
files specified in its Preferences window.  

For RGB images, the default is Adobe 1998.  
For single-channel grayscale images, the default is Gray Gamma 2.2.  
For CMYK images, the default is US Web Coated Swop.
 

These are the most commonly used color spaces for those types of images.  Only if your 
images don’t have embedded profiles and aren’t using one of the above defaults will you 
need to change the ImagePrint defaults to match your workflow.  You can also change 
the profile settings on a per image basis via the Dashboard’s Image Properties section 
described in chapter 10, Image Properties.

To change the default profiles ImagePrint uses, choose Preferences (via the View Menu 
on Windows or the ImagePrint menu if on Mac) then click Default Profiles and change 
the defaults accordingly for each color space within the Missing Profiles/Untagged Images 
area.

Although seldom needed, you can also change ImagePrint’s default method for handling 
Embedded profiles. Setting the Embedded Profile Action to Prompt instead of Apply 
will cause it ask before applying the detected embedded profile.  Setting it to Ignore will 
cause any embedded profiles to be ignored (which will cause the default settings (if any) 
within the Missing Profile/Untagged Image section to be used.  You can also change the 
Embedded Profile Action on a per image basis via the Dashboard’s Image Properties sec-
tion described in chapter 10, Image Properties.

Choosing Profiles and Color Management Settings (cont)
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Simulation Setup (Press Match)

What is it?

Simulation profiles are used to 
cause the output of your printer 
to match another output device.  
You might use this feature if you 
want to see how a set of images 
would look when printed on a 
Web Offset Press before actually 
sending them off to the press. 

Most users should leave the 
Simulation Setup profile at 
None.

You can select the Simulation Setup Profile (also known as a Proofer or Press Match Profile) 
within the ImagePrint Preferences window (Preferences is found under the View menu on 
Windows and the ImagePrint menu on Macs) 

In the Preferences window, click the Default Profiles tab and select a printer simulation profile 
in the Profile field of the Simulation setup section.  Never pick the same printer profile you are 
using for your inkjet printer!  

REMEMBER: The Simulation Setup feature is used to cause your printer to match 
another printer or press--in other words, it will cause your printer to act as a proofer to 
the other printing system.  You will need to have a profile created for the output source you 
are attempting to match.  The desired rendering intent for the conversion to the Press Match 
profile can also be set in this area.  The intent is only used if a Press Match profile is select-
ed--otherwise the intent is ignored regardless of its setting.
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The Shadow Point Compensation Slider  

What is it?

The Shadow Point 
Compensation slider allows 
you to adjust the black 
point of the source profiles. 
With this control, you can 
adjust the richness of the 
blacks in your RGB images 
and control how much detail 
appears in the shadows.  
The default value is 50. 
Lower values will result in 
more dark shadow areas, 
but at a possible loss of 
tonal separation and shad-
ow detail.  Higher values 
reduce the density of the 
shadow areas.

Very Important Note 
 

The effect of the Shadow Point Compensation Slider is often much stronger 
if the Rendering Intent used for the image is Relative Colorimetric rather 

than Perceptual.  

To adjust the Shadow Point slider, open an image in ImagePrint and choose 
IMAGE PROPERTIES from the ImagePrint Dashboard, then expand the 
SHADOW POINT section.  Adjust the slider to alter the selected image’s 
shadow point--remember, higher values will expand (lighten) the shadow, 
lower values darken it--and the effect will be much stronger if RELATIVE 
COLORIMETRIC is the selected Rendering Intent for the image type (RGB, 
Grayscale or CMYK) currently selected. As you change the slider, the current 
shadow point value will be shown in the field to its right.

Rendering Intents and their usage in ImagePrint are described in the following 
pages.
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Rendering Intents 

ImagePrint allows you to specify the rendering intent for each of the four supported 
color spaces (RGB, Grayscale, CMYK and LAB) as both a default setting and on a 
per image basis.

Specifying the DEFAULT Rendering Intents

Open the ImagePrint Preferences win-
dow (Preferences is found under the View 
menu for Windows systems and under the 
ImagePrint menu for Macs), then choose 
Default Rendering Intents along the top.

The rendering intents listed here will 
be used for images of the specified 
colorspace. Set them to the intent you use 
most commonly for each type of image. 

Specifying the Rendering Intents on 
a Per Image Basis  

If you want to change the ren-
dering intent used by a partic-
ular image without changing 
your default setting, use the 
Image Properties section of 
the Dashboard. 

Not sure which Rendering Intent to use?  ...or what one is? 
 

Rendering intents are methods used by the color management to handle out of gamut 
colors and other issues that crop up when converting from the source space to the printer 

space.  For photographic images, Perceptual or Relative Colorimetric will give best 
results. Read on for a little more information on just what rendering intents are and how 

they can affect your output.
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About rendering intents

What are they?
It’s an inescapable fact that when an image is printed, any color within it that can’t be repro-
duced on the printer/paper must be changed to one that can actually print. You can do this 
yourself--using soft proofing tools like those found in Photoshop--or allow it to take place auto-
matically. 

But... if allowing the change to happen automatically, how should those changes from one color 
to another be made?  Should the closest printable hue be used when an exact match to an 
image’s color isn’t available on the printer?  Or should the hue stay the same but the saturation 
be adjusted to get to a printable color?  And what about the other colors in the image--the one’s 
the printer can print?  Should they be left alone?  Or should they change along with the non-
printable one’s to keep a consistent look to the image as a whole?

Such questions are where Rendering Intents come in.  Think of them as strategies used to com-
pensate for the differences in color gamuts and white points of different output devices when 
converting from one to the other. 

The ICC profile specification allows for four standard intents--they are created when the printer 
profile is created and are embedded within it.  ImagePrint allows you to pick which rendering 
intent to use based on the color type of the image--so you can have different rendering intents 
for RGB, CMYK, Grayscale and LAB images. 

The following is a general guide as to the effect of the different rendering intents and when they 
might be best used.  Although four are available, in practice, for Photographic printing  only two-
-Perceptual and Relative Colorimetric--are typically used. 

Perceptual

Along with Relative Colorimetric the most often used for Fine Art and Photography
Used often for continuous tone images such as those from scans, digital cameras 
or bitmapped (non-vector) computer images.

Perceptual rendering compresses the gamut of the source color space into the printer 
space.  Think of wrapping your arms around the entire source space and squeezing it 
until it fits the smaller printer space.  The relationship between the colors is maintained 
in this intent, but everything--even the colors the printer can print--get changed (usually 
just a little bit though). Photographic images with lots of out-of-printer-gamut colors often 
yield best results with this setting, although if it’s vital in-gamut colors print exactly as they 
appear the image Relative Colorimetric may be a better fit.  

Color Management - Rendering Intents (Cont.)



6-12 ImagePrint R.E.D. User’s Guide

Relative Colorimetric

Along with Perceptual, this is the intent most often for Fine Art and Photography. Use this 
option is you plan to use the ImagePrint Shadow Compensation slider to expand or com-
press shadow detail.  

With Relative Colorimetric, out-of-print-gamut colors are clipped to the nearest reproduc-
ible hue.  Instead of squeezing all of the image’s colors to fit the printer’s gamut (like 
Perceptual Rendering does), with Relative Colorimetric only the out of gamut colors are 
altered. This means that all the colors that the printer can print won’t be changed at all- 
but those it can’t print will be “clipped” into the closest printable color. If you have a lot of 
out-of-print-gamut colors this can make the image lose detail or appear flat in places as 
some color separation can be lost. Therefore, this intent is often a good choice for imag-
es that don’t have many important out-of-printer-gamut colors or when it’s critical that in-
gamut colors are reproduced exactly.

Absolute Colorimetric 

Only recommended for PRESS applications---not for printing photography or fine art
Absolute Colorimetric is most often used for simulating (proofing) another printer 
while reproducing its paper color.

This rendering intent reproduces in-gamut colors exactly, and clips out-of-gamut colors 
to the nearest reproducible hue--just like Relative Colorimetric. The difference is that this 
rendering intent uses the paper color (as recorded in the printer/paper profile) as its white 
instead of treating white as “no ink”.  Everywhere there is white in your image will be out-
put with the paper tint.  This makes this the best rendering intent to use when simulating 
another printer and paper (proofing) but not so much for general printing. 

Saturation 

Not recommended for any color critical work.  Used most often for bright, non-color criti-
cal graphics such as those in business charts.

Saturation rendering is most concerned with maintaining saturation of colors.  Colors 
are mapped with an emphasis on their saturation rather than hue or lightness.  Primary 
colors of the source color space are mapped to the saturated primary colors in the target 
space.  The end result is images which maintain their overall vivid nature without neces-
sarily producing a precise reproduction of the originals hues.  Bright business graphics 
and signs often work best with Saturation style rendering.

Color Management - Rendering Intents (continued)
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Turning Off ImagePrint’s Color Management

Now that we’ve described ImagePrint’s Color Management, there’s one last thing to cover:  
How to turn it off.

There are times when you may not wish to use ICC/ICM color profiles.  The most frequent case 
is when outputting a target for the generation of custom profiles for your printer.  

Turning off color management in ImagePrint R.E.D. is done by first setting the Color 
Management Mode to No Color Management within the Printer Section of the Dashboard.  That 
will ensure that the data sent to the printer driver is not color managed.

It is also important that Color Management is not enabled within the System Printer Driver.  

► On Macintosh computers, this is automatically done for you, so no further steps are need-
ed to turn off Color Management.

► On Windows computers, ImagePrint R.E.D. can not automatically disable the System 
Printer Driver’s color management so you should confirm that it is not enabled.  (Accessing 
and configuring the system printer driver is described in chapter 4 of this manual.)

The exact procedure for doing this varies from driver to driver, but typically the driver must 
either be 1.) Set to an ICM mode within the driver’s color settings area, or 2.) Set to disable 
color management explicitly in its color settings area (if your driver has such an option.)  

Either option will work to disable color management in the system printer driver.

The good news is that in normal printing from ImagePrint R.E.D. the driver has already 
been set to a non-color managing ICM mode (such as HOST ICM) if you followed the setup 
instructions in Chapter 4 of this manual for setting up the system printer driver.  

This means that in most cases you will not need to make any change at all within the sys-
tem printer driver to turn off color management, though you should double-check it.  Only in 
cases where the driver is not already on an ICM mode will a change to the Windows system 
printer driver be necessary to disable its color management.
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Softproofing
A major goal of most workflows is to have what comes out of the printer match what you see 
on the screen.  Using the computer monitor to simulate the printed output is called softproofing, 
and can be one of the most challenging tasks in color management.

Note: More information on soft proofing and proper color management can be found in the 
ImagePrint Troubleshooting guide within the Profiles and Color Management section

Softproofing in ImagePrint

ImagePrint always shows a softproofed display by passing the displayed image through the 
chosen printer profile.  This means that if you have picked the proper printer profile for the 
paper you are using the image on the screen should accurately reflect the print--as long as:

1. Your monitor is properly calibrated for print conditions including brightness
Calibration software typically calibrates the monitor to achieve optimal viewing 
brightness--not to match the relatively darker look of a physical print which has 
no pure whites or blacks.  Therefore--even if the colors look correct-- it is often 
necessary to use the monitor’s controls to darken the display to achieve a match 
in the tonality of your prints, or create a monitor calibration for a lower luminance 
than the default setting of your profiling software. 

2. Your printer is functioning properly
Always do a nozzle check on the printer at the first sign of trouble to ensure that 
there are no clogs--a single slightly clogged nozzle can have dramatic effect on 
color cast.

3. Your color management workflow is correct
•	 Make sure you know the proper source space (i.e., SRGB or Adobe 1998) of your 

images at every step in your workflow--improperly “dumping” an image from one 
space to another without proper conversion is a major source of color issues.  

•	 Familiarize yourself with the ImagePrint color management settings by read-
ing through this chapter. If you have color problems, check out the entries in the 
Profiles and Color Management section of the ImagePrint Troubleshooting guide.  

	 Some common causes of color issues within ImagePrint are:
  -	 Choosing the wrong Paper/Printer profile for the media being used.

  -	 Selecting a Simulation profile in Preferences when you are not trying to match 
another printer.

  -	 Printing images that don’t contain embedded profiles while not having the correct 
default profiles set for non-color managed images.	  
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Softproofing (continued)

Soft Proofing with color profiles in Photoshop

Since by far most color correction work is done via Adobe Photoshop, achieving a workable 
match between Photoshop’s display and the printer’s output is often critical, especially for matte 
papers which can have dramatically smaller gamuts and max densities than glossy media.

By default, Photoshop does nothing to adjust its display to reflect what the printed results will 
be. Thus the image on screen will appear the same no matter if you plan to print it on high 
gloss film, canvas, or rag paper.  Because different papers can have vastly different color repro-
duction capabilities, it is therefore critical that you see the image as it will be printed so you’re 
not “flying blind” when making adjustments.  

To alter its display to reflect the intended printing conditions, Photoshop has a feature called 
Proof Setup.  With Proof Setup, you can choose a printer profile for Photoshop to use when 
displaying images, there by allowing you to make adjustments in an informed environment. 

The Printer profile you are using can be selected for soft proofing within Photoshop by choosing 
View->Proof Setup from the Photoshop main menu.  When the Proof Setup window  appears, 
click the CUSTOM button and choose the printer profile from the list of profiles that appears.  
Once it is chosen, you’ll see Photoshop’s display change to reflect the output the profile will 
produce. 

There are other options within the Proof Setup window that may or may not have an effect 
on matching your output (such as simulate paper color).  The best way to determine which 
features to turn on is to print a sample image from ImagePrint, then compare it to the screen 
display of Photoshop with Proof Setup in effect.  Try the different options in the Proof Setup 
window and use the ones that cause the display to most closely match the print. For more infor-
mation on the Photoshop Proof Setup feature, consult your Photoshop documentation.
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Color Management Concepts - Types of Profiles

Simply speaking, color management boils down to how colors are converted from one color 
space to another. Since most image creation methods (such as cameras) can produce a 
wider range of colors (referred to as their color space) than most output methods (such as 
printers) can utilize, some mechanism needs to exist to convert the colors from one device’s 
space to the other while preserving the appearance of the image as closely as possible. 
Using ICC (also called ICM) profiles to accomplish this is the heart of color management.

Note: ICC (International Color Consortium) and ICM (Image Color Management) profiles 
share common formats and are essentially the same.  ICM profiles are typically gener-

ated on Windows computers, while ICC profiles usually come from Macintosh computers.  
ImagePrint handles both formats identically, and with no change of filename required. 

In a color managed workflow, each image and each device outputting that image has asso-
ciated profiles that describe how many and what colors can exist for it.  

In a printing workflow, there are typically 3 of these profile types that come into play:  
Monitor Profiles, Source Profiles, and Printer Profiles

Monitor Profiles 

While it’s not necessary to have a calibrated monitor to print with ImagePrint, if you edit 
your images on screen a properly calibrated monitor is vital in order to ensure that what you 
see on the screen accurately reflects what’s in your images.  

When you calibrate your monitor, a Monitor Profile is created by your profiling software and 
is typically installed into your operating system as part of the process.  Like most programs, 
ImagePrint uses this monitor profile automatically so there is no need to specify it within the 
software.  

Remember--the monitor profile does not actually change the output to your printer or modify 
the colors within your image.  Instead, it simply provides information about your particular 
monitor’s display so your operating system and programs like Photoshop and ImagePrint 
know how to properly show colors on it.  
 
Of course, if you adjust your images using the on screen preview as a guide, a faulty moni-
tor calibration can cause you to make incorrect edits which certainly will reveal themselves 
in the print.
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Source Profiles

Source profiles characterize the color space of images.  (Photoshop calls these image 
color spaces working spaces). These profiles define the full range of colors that can 
be represented within the digital picture. Though it might seem that a bigger space is 
always better (more colors!), that’s not necessarily true--while a color space that is too 
small may limit the available colors you have in the image,  a color space that is too 
broad might lead you to create images with colors that are not reproducible on your out-
put device or monitor (which can lead to unwelcome surprises at print time). 

Since no color space is a perfect match to all potential output methods, picking the right 
color space depends on your intended workflow. Bigger spaces like Pro Photo RGB will 
force you to be more vigilant (by using Photoshop’s soft proof and gamut warning tools) 
to ensure that colors are converted correctly to the printer’s more limited range of colors.  
Smaller gamuts like SRGB reduce the likelihood of “surprises” at print time since the 
printer can often handle all the colors in that space (depending on the paper used) but 
there’s a risk of limiting the potential range of colors you could be printing. Adobe 1998 
is often the best balance between what your printer can print, your monitor can display 
and your camera can shoot.  

Huge color spaces: There are some 16 bit source spaces (like Pro Photo RGB) that 
are much bigger than the color space of the printer and monitor. These huge spaces 
require care when editing and are generally best for archiving copies of your work and 
purposes other than printing.  Converting  a “print” copy of the image to a smaller space 
(like SRGB or Adobe 1998) will help prevent big color shifts at print time.  If you do plan 
to print images that are in a very large color space, using Photoshop’s Proof Setup fea-
ture and gamut checker is always a good idea to ensure that the colors in the image 
are within the gamut of the printer/paper. Manually bringing colors into the printer/paper 
gamut before printing eliminates surprises that can come about if you just let the conver-
sion to the smaller space happen automatically.

Maintaining consistency: Most images use well known color spaces such as Adobe 
1998, SRGB, or ColorMatch RGB, and its beyond the scope of this guide to list the 
pros and cons of each. But, whatever the color space you use, one of the most critical 
aspects of proper color management is consistency--if an image is in one color space 
(such as SRGB) it is important that throughout your workflow the color space is either 
maintained or is properly converted to another one. (Photoshop can do profile to pro-
file conversions via its Image -> Mode menu). Because it is not apparent just by look-
ing what color space an image was created in, embedding the source profile within the 
image is the best way to ensure that, throughout your workflow, the correct color space 
is used.

Color Management - Types of Profiles (cont.)
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Embedded Profiles:  When a color managed application like Image Print or Photoshop 
opens an image, it needs to know its color space in order to properly map the colors. To 
make this easier, many applications and devices allow you to “embed” the profile within 
the image.  Embedding the profile can take the guesswork out of color management-
-with the profile embedded, applications know what the correct color space is automati-
cally at the time of opening it.  If the profile is not embedded, it is critical that you specify 
the correct profile--otherwise, the colors will be mapped into an incorrect gamut for the 
actual color data.  In Photoshop, the Save dialog contains a checkbox to specify that the 
profile be embedded in the image.

Using a Monitor profile as a source profile: Converting your images into the color 
space of your monitor may seem like a good idea--after all, that will ensure that the 
image contains only colors that are displayable on your screen.  However, locking 
your image into the color space of your particular monitor is almost always a bad idea.  
Your monitor space only applies to your display at a particular point in time--it would 
not match the display of others who may need to work with your image, or even other 
systems that you may have.  Also, the monitor profile is rebuilt each time you recali-
brate--you may quickly end up with a library of images all with different source spaces 
which can be a consistency nightmare.  And besides, locking your image into the par-
ticular strengths and weaknesses of one monitor may unnecessarily limit the gamut of 
your images.  Instead you should use one of the standardized spaces (Adobe 1998, 
Colormatch RGB and SRGB are examples of industry standard color spaces) to ensure 
a consistent workflow.

Know the color space of your untagged images! 
 

By default, when an image without an embedded profile is opened for the 
first time in Photoshop, you will be prompted to choose how to handle 

color managing the image.  (Since Photoshop can’t detect an embedded 
profile it needs to be told what to use).   

 
If you tell Photoshop to “Use the current working space profile”  you are 

telling it to assume the default working space currently chosen in the 
Photoshop Color Settings window is the space the image was created 

in.  If this happens to be different than the image’s true color space, the 
image will be incorrectly color managed and will likely not print correctly.  
Check your camera settings, scanner software, or the person supplying 
your images to ensure you are using the correct source space for these 

“un-colormanaged” images.

Color Management - Types of Profiles (cont.)
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Output (PRINTER) Profiles

The final profile type are Output profiles.  These profiles characterize the color space of 
output devices.  In the case of profiles for printers, remember that all aspects of the output 
are taken into account when a calibration print is made--the paper, the inks, the print quality 
settings, and the software used to drive the printer make a difference in what colors can be 
produced.  Therefore a profile made for one printer driver or RIP would not be correct 
for another driver since each software driver prints differently--don’t use ImagePrint 
profiles with the manufacturer’s printer driver (or vice-a-versa) or bad color will result.  

The media and ink you are using can have dramatic effects on the range of colors reproduc-
ible by the printer.  Matte papers tend to have significantly less overall gamut then photo/
glossy papers, and pigment inks tend to have less gamut than dye inks (although pigment 
inks have much better resistance to fading over time).

Important: Each time you change the paper you are using in your printer, you 
will need to choose a profile made for that paper to compensate for its unique 
printing characteristics. Choosing profiles was covered earlier in this chapter. 

Printer Profile Creation Printer profiles are created by printing a color chart contain-
ing hundreds or thousands of color swatches.  This chart is then read by a colorimeter or 
spectrophotometer to build a “thumbprint” of all the colors the printer is capable of producing 
on that paper and how it prints them.

In the past, different printers of the same model would often not match “out of the box” when 
printing on the same media.  To bring them together, it was often necessary to profile each 
printer individually, or create linearization tables to force each printer to behave in a standard 
way. Today’s professional inkjet printers maintain excellent consistency from device to device 
so it is usually no longer necessary to create custom profiles for individual printers to com-
pensate for device differences.

Never try to use a profile made for one printer driver with another.  Printer pro-
files are specific to the software printer driver they were made for.

Color Management - Types of Profiles (cont.)
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Color Management Concepts - Bringing it all together

We’ve now covered the most basic components of a color managed workflow.  A proper 
monitor profile to correctly view your images, a proper source profile embedded in the 
image, and a proper output profile for reproducing the image within the color capabilities 
of the printer for a given paper. 

In a standard color managed workflow (using embedded profiles within your images):

•	 	 When an image is opened in ImagePrint, the software checks to see if the image 
has an embedded Source Profile--if it does, then it will use that profile to deter-
mine the proper color values within the image.  If if doesn’t, it will assume the 
default profile (as set in Preferences) is the correct profile and use it.

•	 	 Next, the currently selected Printer Profile and ImagePrint uses its internal color 
management engine to convert from the source color space to the printer color 
space.

•	 	 The results of that conversion are then passed through the current Monitor 
Profile to produce an accurate representation on screen of how the image will 
look when printed.  

•	 	 When you click print, the results of the source space to printer space conversion 
are sent to the printer via ImagePrint’s printer driver.

There’s a lot more to color management, but understanding the above profile types and 
general concepts is vital to taking hold of your color managed workflow.  The next por-
tions of this chapter describe other color management topics, such as softproofing and 
rendering intents and how they are used by ImagePrint.
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Preferences 

ImagePrint’s Preferences 
window allows you to specify 
parameters for many of the 
software’s global features.  The 
Preferences window contains 
Grid settings, Smart Alignment 
guide settings,default color 
profile and rendering intent set-
tings and default parameters 
for certain functions such as 
Sharpening and the Shadow 
Point control as well as 
General settings that affect the 
ImagePrint interface including 
default display resolution.

The Preferences window can be accessed via the View menu on the Windows version 
of ImagePrint, and via the ImagePrint menu on the Macintosh.

The remainder of this chapter will describe in detail each of the available settings acces-
sible from the Preferences window.  
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Preferences 

The Preferences window can be accessed via the View menu on the Windows version of 
ImagePrint, and via the ImagePrint menu on the Macintosh.

General

The General Preferences contains miscellaneous settings 
that affect the operation of the software.

Units

The Units drop down menu allows you to choose which 
measurement units are used throughout the interface.  
You can choose between Centimeters and Inches.

Preview Size  

This menu allows you to adjust the resolution with which ImagePrint will display images.  Lower 
values may speed up opening images but will cause them to be rendered in less detail.  This 
value has no effect on the printed output--just the display.  You’ll need to reopen any images 
already in the layout window after changing this setting in order to see the results of the new 
resolution.

Language  

Choose the language ImagePrint’s menus and tools should be presented in.

Use thumbnails from Images Pane

The ImagePrint Image Strip creates small thumbnail images when building its display.  These 
can be used to add images much more quickly to the layout area.  Choosing “Use File Browser 
Thumbnails” will cause ImagePrint to use these low res thumbnails, causing images to be placed 
more quickly but with a lower quality, pixelated appearance. The printed output will not be affect-
ed by this setting. 
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Use alpha-channel in PSD files  

Some Photoshop files (PSD) contain alpha channels.  Normally, an image file includes 
a channel for each primary color used (for instance, an RGB file will have a channel for 
Red, Green and Blue.)  Certain effects, however, (such as masking and transparency) may 
cause additional channels to be used in an image which can confuse software expecting 
each channel to represent a color.  To check your image, you can choose Windows -> 
Channels in Photoshop.

Global Printer Compensation  

These two fields allow you to specify a horizontal (X) and vertical (Y) distance to shift each 
layout as it is printed.  Positive X values will shift images to the right (relative to the  screen 
display) while negative values will shift to the left.  For the Y field, positive values will shift 
down (relative to the screen display) and negative values will shift up.  Unlike the X/Y origin 
point setting (in the Layout Controls window), this shift will NOT be visible on screen and is 
not reflected in any on screen measurements.  The shift will only occur at print time.

The Global Printer Compensation is used to compensate for printer feed or alignment prob-
lems.  For example, if you find that on borderless printing you are getting a “hairline” visible 
on the edge of the page, putting in small negative value here can shift your entire layout over 
to compensate, allowing you to essentially ‘calibrate’ your printer’s page feed characteristics 
so you can be sure the coordinates you see on screen will translate properly to the printed 
page.

Set Profile Valet Offline  (ImagePrint Black only) 

The Profile Valet checks for new profiles each time you launch ImagePrint Black.  If you 
don’t have an internet connection for your ImagePrint computer or don’t want the valet to 
access it you can set this option.  Remember--with this option in effect, the Profile Valet will 
not keep the available profile list up to date and will not automatically download profiles.

Preferences - General (cont) 
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Preferences - Pages

The Pages Tab of the 
ImagePrint Preferences win-
dow is where you can specify 
the settings for both the Grid 
Settings and the Smart 
Alignment snap guides. 

Note that only one of these lay-
out methods can be active at a 
time. 

The Binding Spread (the mar-
gin between two facing pages 
when Spreads is the chosen 
layout mode) is also located in 
the Pages section.

Smart Alignment Settings   

Important: Smart Alignment settings can not be used when ImagePrint’s Grid 
Overlay is active. Toggling the “Use Smart Alignment Settings” checkbox will auto-
matically turn off the Grid.

ImagePrint’s Smart Alignment feature will cause vertical and horizontal “snap to” 
lines to appear as image’s are dragged across various alignment points on your 
layout--such as the center or edges of the page, or the edge or center point of 
other images.  This can aid tremendously in arranging your images in relation to 
one another or the page.

For detailed information on Smart Alignment guides, please see chapter 4, 
ImagePrint Basics.  That chapter also describes Spread mode and the Binding 
Gap.

Preferences (cont) 
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Preferences   - Pages and Grid (cont)

Grid Settings   

Important: Grid settings can not be used when ImagePrint’s Smart Alignment tools are active. 
Toggling the “Use Grid” checkbox will automatically turn off Smart Alignment features.

The Grid Settings section of the Preferences->Page window allow you to display and modify 
a placement grid within the image layout area. Image’s can be “snapped” to grid intersections, 
allowing you to easily drag and drop images into aligned positions. 

Use Grid This check box toggles the display of the grid.

Grid X/Y Spacing  
The Grid Spacing 
fields allow you to 
specify the amount 
of spacing between 
the lines of the layout 
grid.  The X field will 
control the amount 
of spacing along the horizontal axis, the Y field controls the 
spacing along the vertical axis.  After typing in new numbers, 
click the Apply button (or hit the return key) to have them take 
effect in the currently displayed grid.

Snap images to Grid  When Snap to Grid is toggled On via the 
Snap to Grid icon in the Floating Tool Palette, the Upper Left or 
Upper Right corner of the image will automatically jump to the grid 
intersection you specify in the Snap To section (see below) as you 
drag it.

Upper Left / Upper Right   Use these buttons to select which cor-
ner of the image will snap to the grid.  Choosing Upper Left will cause the upper left corner 
of images to “jump” to the closest upper left intersection of grid lines as you move them, while 
Upper Right will cause the upper right corner of the image to jump to the intersection.
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Preferences (cont.)

Default Profiles

The Default Profiles section 
of the ImagePrint Preferences 
window contains advanced 
and default Color Management 
features. Note that these are 
Default settings--newly opened 
images will use these settings, 
but they can be overridden via 
the Input Profiles controls of the 
Image Properties section of the 
Dashboard.

The settings available in this part of the Preferences window are described in Chapter 6, Color 
Management. 

Default Intents

The Default Intents section of the 
ImagePrint Preferences window 
contains the default rendering 
intents to be used for images of 
each color type (RGB, CMYK, 
GRAYSCALE and LAB).   The 
default intent can be overridden 
via the Input Profiles controls of 
the Image Properties section of 
the Dashboard.

The settings available in this part of the Preferences window are described in Chapter 6, Color 
Management. 
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Preferences (cont.)

Default Parameters

The Default Parameters 
section of the ImagePrint 
Preferences window allows you 
to set default settings for sev-
eral ImagePrint tools.  When 
ImagePrint is launched, the val-
ues you select in this window 
will be applied to each image 
you open automatically.

Use Sharpening

The Sharpening feature is described in chapter 9, Correction Tools Specify the Radius and 
Magnitude sharpening values  you wish to apply to each image upon opening.

Use Shadow Point

The Shadow Point slider is described in chapter 6, Color Management. Normally the Shadow 
Point slider defaults to 50, but here you can specify a different value to apply to your images 
when they are opened.

Use Wide Gamut Tint

The Wide Gamut Tint tool is described in chapter 9, Correction Tools.  This area of the Default 
Parameters  window lets you choose from your saved Wide Gamut Tint settings files. Once cho-
sen, the Wide Gamut settings will be applied to all color images that you open.

Use Narrow Gamut Tint (ImagePrint Black Only)

The Narrow (black & white) Gamut Tint tool is described in chapter 9, Correction Tools.  This area 
of the Default Parameters window lets you choose from your saved Narrow Gamut Tint settings 
files. Once chosen, the Narrow Gamut settings will be applied to all grayscale images opened. 
ImagePrint BLACK only, not available for ImagePrint R.E.D.
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Layout Settings

Normally, when you open an image into the ImagePrint layout area, it comes in at its saved 
width and height, and is positioned as far up and to the left on the page that it can fit.  You can, 
however, define rules that cause images to be automatically sized  and positioned as they are 
opened. These rules are defined in the Layout Settings area of the Dashboard.  You can then 
save these settings to create custom layout “schemes” that can be used to automate different 
workflows.

To access ImagePrint’s Layout Settings, click the triangle icon beside the word Layout in the 
ImagePrint Dashboard.

Layout Styles and Layout Schemes

At the top of the Layout Section are two drop-down menus. The Layout Style menu and the 
Saved Layout Scheme menu.

Layout Styles

The first step in defining Automatic Layout parameters is choosing 
the Layout Style you want to use. Layout styles define the gen-
eral rules of how images will be sized and oriented when brought 
into ImagePrint.  For instance, you may want images to always 
be opened in their original orientation.  Or, you may want images 
to rotate if that lets them fill the page or your custom size param-
eters more efficiently.  You may also want images to fill preset 
ImagePrint Templates to create Photo Packages. 

There are five available layout styles:

As is  
Images will be placed in their original orientation. If a custom width or height is in effect, 
the image will be cropped to fit but will not rotate to “best fit” the custom size.

Rotate to Fit 
Images will rotate to best fit on the page or within any specified width/height settings as 
specified in the Layout Controls area or via a selected Layout Scheme. If a custom width 
or height is in effect, the image will be cropped to fit.  For most users, this should be 
the default setting.

Fit to Size 
Images will scale to fit the current width/height settings specified in the Layout Controls 
area (below)--no automatic cropping will occur, but images will be centered within the 
width/height bounding box.  This mode is good for Index Sheets as images will be 
spaced uniformly on the page.
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Template and Linked Template

The last two Layout styles are special modes for use with ImagePrint Templates. 
When one of the Template based modes is selected as your Layout Style, newly 
opened images will be added to the currently selected template (As shown to the 
right of the Layout Style menu in Saved Layout Scheme menu.) Templates won’t be 
covered much in this chapter, but for information on creating and using templates, 
see chapter 11, Templates

The Layout Scheme Menu

To the right of the Layout Styles menu is the 
Layout Scheme menu.  Here you can pick 
from any saved Layout Schemes you have 
created.  By default, you’ll see “no name” in 
this menu, meaning you currently don’t have a 
saved Layout Scheme selected.  (Don’t worry, 
you don’t need to use a saved Layout Scheme 
in order to take advantage of layout settings-
-it’s just a convenient way to save your layout parameters in order to reuse them later.

More information on saving Layout Schemes will be covered later in this chapter.  

Hint:  Layout Styles are best understood by seeing them in action. Check out the 
Layout Types tutorial from the ColorByte web site’s tutorial page.

Layout Settings (cont)
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Layout Controls 

Below the Layout Style and Layout Schemes menus you’ll find the various Layout Controls for 
customizing how images will be sized, cropped and positioned on the page.

Photo Sizes / Max Width and Height

When images are opened into ImagePrint they 
can be automatically sized to fit within a cus-
tom width/height bounding box that you 
specify.  You can do this through pre-set 
Photo Sizes, or by manually entering a 
Maximum Width and/or Height.

Photo Sizes

The drop down menu at the top of the Layout 
Settings window allows you to choose from 
preset sizes for your images.  Most common 
sizes can be found in this list. Choose a size 
to have all newly opened images sized to the 
selected dimensions.

Max Width / Max Height

You can also specify your own custom width and height by typing in the values within the Max 
Width/Max Height fields. The checkboxes next to each field may need to be clicked to activate 
the field for modifying.  

Any newly opened images will be constrained to the width/height values. If Crop and Zoom 
(below) is enabled the image will be cropped to best fit the dimensions.  If Crop and Zoom is 
NOT enabled, the image will be “best fit” within the specified dimensions while maintaining its 
original aspect ratio. 

Note that you can specify one dimension while leaving the other empty.  This is useful for 
specifying one dimension but not the other. For example, typing 6 inches in the Width field, but 
leaving the Height field empty will cause all images to open at 6 inches wide, with the height 
varying according to the aspect ratio of the original image.

Layout Settings (continued)
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Center Automatically

Clicking the Center Automatically checkbox speci-
fies that each image will be centered on the page 
as it is opened.  Only use this option if planning 
only one image per page as it does not apply 
centering to multiple images on a page.  With 
Auto-flow on, this option allows you to quickly create 
single-image, multi-page layouts.

Crop and Zoom  

This option cause newly added images to grow (or shrink) to fit the specified width and 
height values, with an automatic crop applied to make them fit perfectly.  

Understanding Crop and Zoom  If the aspect ratio of the image is not the same as the 
specified Width / Height dimensions, an automatic crop of the non-fitting dimension will 
occur (you can always adjust this auto-crop by double-clicking the image and using the 
Smart Crop feature).  Without Crop and Zoom in effect, the image will be sized to fit with-
in the width and height specifications, but will be smaller in one dimension if the aspect 
ratio does not match.

An example: The Width and Height values are 4 by 5 (represented by the red rectangle, 
below).  A 2 by 3 image is added to the layout. Since the 2x3 is not the same aspect ratio 
as 4x5, the image will not perfectly fit the specified dimensions.  

With crop and zoom on, the image is grown to completely fill the 4x5 size, with the 
excess in one dimension being trimmed.  Without crop and zoom, the image will be sized 
to fit within the 4x5 boundaries with no cropping (and therefore not a perfect fit--one 
dimension will be smaller.

Layout Settings (cont)

Crop and Zoom ON Crop and Zoom OFF
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Auto Flow   

Auto Flow determines what happens when a page is 
filled.  ImagePrint will either lay new images on 
top of old ones, or automatically generate a new 
page and place newly added images there. Auto 
Flow can be a powerful way of generating multiple 
pages full of images.

Auto-Flow On  Indicates that Auto-Flow is in effect. 
If an image can’t fit on the current page, a new page 
will be generated for it.

Auto-Flow Off  Indicates that Auto-Flow is not in effect. If an image can’t fit on the 
current page, it will be stacked on top of other images on the current page.

Place Holders   

The Placer Holders option will cause rectangular placeholders to appear in the layout area, 
representing where images will be placed based on the current settings within the Layout 
Settings window.  These rectangles are for display purposes only in order to help you see the 
effects of your layout settings.  They will not be printed.  

Note that Place Holders are only available when Crop & Zoom is in effect as that setting 
ensures images will be cropped to perfectly fill your specified width/height values -- with-
out Crop & Zoom, images of different aspect ratios will be “best fit” within the bounding box 
which makes predicting Place Holder sizes and positions impossible.

Fit oversized images   

With Fit oversized images enabled, images that are too big for the printable area of the cur-
rent page (or a subset of the page as defined by the page origin point) will be automatically 
scaled to “best fit” within that area while maintaining the image’s original aspect ratio and 
without cropping.  If there are already images on the current page, a new page will be gen-
erated for the image.

Layout Settings (cont)
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Gutter

The Gutter Layout Settings control how far apart imag-
es should be spaced as they are automatically added to 
the Layout area.  

L-R:  Enter a “Left to right” gutter to specify the amount 
of horizontal space between your images.  

T-B: The “Top to Bottom” field designates the vertical 
spacing between images.

Values can be typed in, or adjusted with the “spinner” controls to the right of each field.

Remember:  Gutters have no effect on how far images will be placed from the edge of the 
paper.  Just how far apart they will be placed from one another. 

Layout Settings (cont)

Gutters
L/R: .25 inch

T/B:  .25
(Default)

Gutters
L/R: .5 inch
T/B: 1.0 inchGutters

L/R: 0 inch
T/B:  0 inch
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Page origin   

The Page Origin allows you to specify where the imag-
es begin on the layout area.  By placing a value in the 
X and Y fields, you can offset your images to the right 
and down on the page, effectively adding margin area 
to your print. 

Understanding Page Origin    
 
The origin point values are relative to the edge of the physical paper itself--not just the 
printable area.   
 
So, a 0,0 value means the upper left corner of the first image will fall flush with the edge of 
the paper.  If not printing full bleed (borderless), this means that some of the image will fall 
off the printable area and not print in this case. Which typically is not desirable.  
 
This is why the default origin point may not show 0,0.  Instead, the default values will 
correspond to the non-printable margins in effect.  The exception is when printing in 
borderless mode.  Since you can print to the edge of the paper when printing borderlessly, 
the default values for the origin point will be 0,0 in that mode meaning the images will start 
at the physical edge.  

Layout Settings (cont)
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Crop to page   

The Crop to page layout feature will cause any image 
that’s too big to fit within the printable area of the current 
page (or a subset of the page as defined by the 
page origin point) to be automatically cropped so 
that it completely fits without scaling the image. 
You can choose to crop only the left or right sides 
of the image, or equally crop both sides.  This set-
ting can be useful for some workflows--such as printing oversized blueprints--where it’s impor-
tant that image is not cropped or resized at all while retaining as much of the image on the 
page as possible.

Layout Setting Examples 

Here’s some examples of various layout settings and how they will effect image placement.

No layout settings in effect. Images open “as is” at their 
saved size, nesting on the page starting as far up and 
to the left as they will fit and placed at a default of .25 
inches apart from one another.

Layout Style “As Is”, max width 5-inches and max 
height 6-inches. Crop & Zoom enabled. Images 

are cropped to entirely fill the 5x6 bounding box.

Layout Style “As Is”, 5x6 max width/height, with 
Crop & Zoom NOT enabled.  Images are scaled 
(not cropped) to fit within the 5x6 boundary 
meaning some images of differing aspect ratios 
may have smaller widths or heights than others.

Layout Style “Fit to Size” with a max. width of 
5-inches and height of 6-inches. Images are 

scaled to fit without rotating within the 5x6 
boundary and centered without cropping.

Layout Style “Rotate to Fit”. 5-inch max width, 6-inch 
max height. Images are rotated if necessary to best 
fit the 5x6 (portrait shaped) boundary without cropping.

Layout Settings (cont)
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Saving your layout parameters with Layout Schemes

Saving and reusing your automatic layout settings  

All the settings in the Layout Settings window can be saved and reused.  That makes it 
easy to create a list of Layout Schemes to be used for different output needs. For example, 
you may want to create a scheme called “My proofsheet” that scales all your images to fit 
within a 2x2 inch area, spaced 1 inch apart.  Another scheme called “My Portraits” could be 
created for sizing all your images to fill an 8x10 size, centered on the page.

Saving a Layout Scheme  

To save the current Layout Settings, choose “Save Layout Scheme” from the ImagePrint 
File menu.  In the standard File Save dialog box that appears, give your new Layout 
Scheme a descriptive name and click OK.  Layout Schemes will be saved to the Layout 
folder within your ImagePrint folder.

Choosing a Layout Scheme  

To choose a Layout scheme, first make sure the layout type chosen in the Layout Style 
menu of the Dashboard is set to As is, Rotate to Fit, or Fit to Size (Do not choose 
Template--in that mode only saved Templates, not layout schemes, will appear in the 
Schemes menu.)

Layout Schemes will be listed in the Layout Scheme menu to the right of the Layout 
Styles menu in the Dashboard.  Choosing “No Name” will cause no layout scheme to be in 
effect.

Choosing a layout scheme will cause the values saved with that scheme to appear in the 
Auto Layout Settings section of the Dashboard and those settings will be used for any new 
images you open until you pick another scheme. 

Note: The current Layout Style (As is, Rotate to Fit, or Fit to Size) is included in the 
Layout Scheme. The Layout Style that was saved with the selected Layout Scheme will 

be loaded when that scheme is selected.

Layout Settings (cont)
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Correction Tools

ImagePrint R.E.D.’s Correction tools 
consist of 16-bit true output sharpening 
and Wide Gamut toning controls.  

To Access the Correction controls, choose it from the Edit drop-down 
menu within ImagePrint’s Main menu, or right click (or Control-Click) 
an image within ImagePrint’s layout area and choose Correction via 
the menu that appears.
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Combined Corrections Tools and 
Features

ImagePrint’s Combined Corrections window 
brings together several new tools and features 
common to all the correction modes.  Before 
we cover the details of using each correction 
tool, let’s go over the common features within 
the Combined Correction window that all of 
them will use.

Before and After views

Each correction window provides a before and after side-by-side view of the image you are 
correcting.  The left display is the before representation.  This section shows the image before 
any corrections you make via the Correction tools are applied.  But that’s not all--it can also 
show the image before the Paper Profile is applied as well!

By default, the before view will show the image as it will appear when printed.  This is a “soft 
proof” view, and historically has been ImagePrint’s normal viewing mode.  It shows the image 
after it has been processed through the currently chosen ICC/ICM Paper profile.  Typically, 
this means the image may appear less vibrant and dense as the paper and ink will invariably 
reduce both color range and density to some degree or another.  Note that this effect is typi-
cally much more evident when printing to a Matte Paper.  Photo/Glossy papers often show very 
little reduction in color and contrast--in fact, it can be hard to see a difference with and without 
the profile applied.  But Matte papers, with their reduced range and density, will often look sig-
nificantly lighter and more washed out compared to the original or a photo paper print.

By un-clicking the “Include Paper Profile” checkbox below the before section, you can toggle 
the view to show the image without the paper profile applied.  This is a handy way of seeing 
your image in its original state, and gives you a chance to attempt to correct or at least reduce 
any loss of color or density that the paper and inks cause.  

Again--with a photo paper profile in place, you may not see much difference with this control, 
but a matte paper profile will often show a significant change when the paper profile is applied, 
which is expected.  (As nice as many art and watercolor papers may be when it comes to tex-
ture and overall look, its a sad fact of printing that the blacks and color vibrancy will not to the 
level of most photo papers when viewed side by side.)

Correction Tools (cont.)
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Positioning and Zooming

Another feature common to all the 
Correction tools is the ability to zoom in 
or out of the previewed image and move 
the image within the preview pane.

When you move your cursor within either 
the before or after view, the cursor will 
change to a hand icon, and allow you to 
move the image within the preview area.  
Note that regardless of which side you 
make adjustments to, both before and 
after views will move together.

You can zoom in or out of the image as 
well.  

Just choose the Zoom In or Zoom Out 
magnifying glass in the upper right of the 
Combined Corrections window.  Note 
again, both the before, and after, pre-
views will zoom together.

Probe

The bottom right side of the Correction window 
contains the Probe Area.  The Probe gives you 
valuable information about the color values of a 
selected area of the image.

Correction Tools (cont.)
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There are three columns in the probe area.  Choosing the Eye Dropper tool, and clicking 
in either the before or after image will cause those values to show the color values for:

1. Raw - Before the Paper Profile and Correction

This shows the values, in appropriate absolute 
pixel values (0 - 255) for  image’s color space 
(RGB, CMYK or Grayscale) of the clicked on 
area before the paper profile is applied and 
before any corrections are applied--in other 
words, the original values in the image as it 
was saved.

2. Before - Profile applied but no correc-
tion

This column shows the pixel values for the 
same clicked on area AFTER the paper 
profile is applied but before Corrections.  

3. After - Profile and corrections applied

The final column in the Probe section shows 
the percent values of the selected area both 
after the paper profile has been applied, and 
after any corrections you have made with the 
Correction controls.

Correction Tools (cont.)



9-6 ImagePrint R.E.D. User’s Guide

Using Wide Gamut (color) toning

In the ImagePrint Dashboard, expand the 
Profile section and either using the Profile 
Valet or the “Choose by Profile” method, 
pick a color profile for the paper you plan 
to use.  For information on selecting pro-
files, see chapter 6 of this manual:  Color 
Management.

When a Color Printer profile is in place 
Wide Gamut will be available as an 
option under the menu at the top of the 
Combined Corrections window.  Choose it 
to access the Wide Gamut Toning controls.

To enable Wide Gamut toning, click the Global tint checkbox.  You can then choose whether to 
split the tone (toning highlight and shadow areas differently) or tone all the tonal areas equally.

Quick Grayscale Conversion
Need a quick way to convert your color 
image to grayscale before printing without 
having to save a separate copy? 
Just enable the Wide Gamut controls and 
leave them at their default setting (with 
the color control at the bottom of the color 
palette).  Any color in your image will be 
rendered as tones of gray.

Splitting the Tone

You can tone the entire image as a 
whole, or “split tone” the image and 
assign a different tone to two distinct 
tonal areas of the image (highlight and shad-
ow).  To enable Split toning, click the Split 
tones checkbox.  With the Split Tones checkbox selected, there will 
be two colored “Tint Picker” areas available.  Without Split Tones in effect, only one Tint Picker 
will be shown.

Correction Tools (cont.)

No Split in effect

Split tones enabled
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Applying a tone

To tone the selected image simply click a 
color within the colored Tint Picker area.  
The image will immediately show the new 
tone.

If Split Tones are in effect, clicking within 
the Left tint picker will affect the highlight 
areas of the image.  The Right tint picker 
will affect the Shadows.

The fields below the 
tint picker show the 
current values of the 
selected color.  You 
can also manually 
enter the H,S,V (hue, 
saturation, value) or 
Red, Green, Blue val-
ues in those fields to 
select a tone.

The density slider 
along the left of the 
tint picker(s) lets you 
pick a more or less 
saturated color.

Determining the Split 

If Split Tones is in effect, the slider along the side of the Wide Gamut Tone controls allows you to 
specify where along the image’s tonal gradation the split between highlight and shadow should 
be considered to occur.  Using this slider, you can fine tune where the toning for each Tint Picker 
occurs.

Correction Tools (cont.)
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Sharpening

ImagePrint’s 16-bit output sharpening allows 
you to compensate for print processing and 
viewing conditions that affect the perceived 
detail of your prints.  Resizing of the image 
on the page, the paper you print on, and the 
anticipated viewing distance are examples of 
factors that might cause the need for sharp-
ening beyond that which is done as part of 
your normal workflow.

To enable output sharpening, click the Apply 
Sharpening checkbox.  Then, use the slider con-
trols to adjust both the Magnitude and Radius while 
observing your changes in the right pane of the cor-
rection window.

Radius  
The Radius slider determines the width of the contrast applied to 			 
“edges” in the image (areas of sharp transition from one hue or tone to another) 
The radius setting has less of an apparent effect than Magnitude (below).  Generally, the 
more fine detail in an image, the smaller the radius should be to avoid “haloing”.  For most 
images, a setting of 3 to 5 works best.

Magnitude  
The Magnitude slider controls the degree of contrast that is applied to the edge areas.
With too high of a magnitude setting you may see harsh, blown-out edges or artifacts 
appear in your image.  For most output it isn’t recommended to go above about .5, but 
make sure to zoom in to various parts of your image within the correction window to deter-
mine what works best.

Setting a default Sharpening  
To set a default sharpening value to be applied to all images as they are opened, access the 
ImagePrint Preferences window and enable Default Sharpening in the Default Parameters 
section.

Correction Tools (cont.)
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Image Properties

For settings that apply to 
individual images, the Image 
Properties window is used.  

Currently, Scale and Position 
controls, Input (source) 
Profiles settings, Step and 
Repeat,Transparency and 
Shadow Point settings are 
found here. 

Image Properties is available 
in the ImagePrint Dashboard.  
If the Dashboard is not visible, 
choose it from the View menu.

Important:  Image Properties settings apply to the currently selected image.  
If no image is selected, the controls will not be functional.
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Size and Position Settings 

ImagePrint provides scaling and 
positioning of your images via click-
ing and dragging with your mouse, 
or, for more precise scaling, via the 
Position,  Scale and Width/Height 
fields in Image Properties. 

All measurements are in the Units currently in effect in the General Section of the 
Preferences window.  

Below are descriptions of the available options.  Make sure to hit the Return key after 
entering new values (not TAB) to ensure they are accepted.

X POS / Y POS  These fields show the X and Y coordinates of the upper-left hand corner 
of your image.  Type in a new number to have your image shift to the specified position.

Width / Height  The Width and Height fields show the current size of the image.  Typing 
in new values and hitting the Enter key will cause the image to immediately grow or shrink 
along the specified X or Y axis.

H Scale/V Scale  The H Scale and V Scale fields are used to specify a scaling percent-
age for the current image in the horizontal (H) and vertical (V) directions.  If Constrain 
Proportions is checked (see below) typing a number in one field will cause the same num-
ber to appear in the other.

Constrain Proportions  Selecting the Constrain Proportions checkbox will force the 
aspect ratio of the current image to remain constant (non-distorted) as you change the 
scale preferences.

Image Properties (continued) 
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Input Profiles

The Input Profiles area of the Image 
Properties section allows you to 
specify image specific color manage-
ment settings for the selected image.  
These settings will override the 
default color management settings 
set in the Preferences window.

The use of these controls are Color Management functions described in Chapter 6 of this 
manual.

Image Properties (continued) 
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Step and Repeat

The Step  and Repeat window 
allows you to specify step (horizon-
tal) and repeat (vertical) preferences 
for the currently selected image.  
(Remember, images can also be 
stepped and repeated with the mouse 
via clicking and dragging with the 
shift-key depressed.)  

Access the Step and Repeat window by choosing Image Properties from the ImagePrint 
Dashboard.

The following controls describe the Step and Repeat settings fields. Make sure to hit the 
Return key after entering new values (not TAB) to ensure they are accepted.

Note: When you step and repeat an image, the entire collection of repeated images 
becomes one region, and all controls used affect the region as a whole. For example, if 

you used the Scale controls to affect the magnification, the entire region is magnified, not 
just the initial image.  Also, crop marks will appear on the corners of the entire group, not 

individual images.

Step  The Step field displays the number of times the image is 
repeated along the X axis (horizontal) of the Layout Area. 

Space  This field, to the right of the Step field, shows the hori-
zontal distance between stepped images.  A value of zero will 
cause the images to have no horizontal offset.

Repeat  The Repeat field displays the number of times the image is 
repeated along the Y axis (vertical) of the Layout Area.  

Space  This field, to the right of the Repeat field, shows the vertical dis-
tance between repeated images.  A value of zero will cause the images to 
have no vertical offset.

Image Properties (continued)



10-6 ImagePrint User’s Guide

Settings - Step and Repeat (continued)

Tile, Half-drop and Slide 

The three Mode Functions allow you to change the way in which the images are shift-
ed as they are duplicated via Step and Repeat.

Tile - This mode will cause the images to be stepped 
along the horizontal axis and repeated along the vertical 
axis with no shifting.

Half Drop - This mode will cause images to be shifted 
vertically one half of their height when being stepped

Slide - This mode will cause images to be shifted hori-
zontally one half of their width when being repeated

Image Properties (continued)
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Transparency 

The Transparency section of the 
Image Properties window allows 
you to set the transparency of an 
image.

Access the Transparency window by choosing Image Properties from the 
Dashboard.

By default, images are fully opaque, meaning they have no transparency.  Slide 
the Transparency slider to the left to increase transparency, allowing elements 
beneath the selected image to become visible. 

To put images above/below each other, right- or control- click the 
image and choose Bring to Top or Push to Bottom. 

Shadow Point 

The Shadow Point Slider con-
trol within the Image Properties 
section of the dashboard gives 
access to a slider which lets you 
adjust the Shadow Point setting 
for the currently selected image.  

The Shadow Point is a Color 
Management function described in Chapter 6 of this manual.

Image Properties (continued)
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What are Borders?
With ImagePrint’s Borders feature, you 
can add any type of border to your 
images.   

Any Photoshop format (psd) file with 
a transparency layer can be used as 
a border—simply place the border 
image in the Borders folder to install it. 
On Macs, the Borders folder is found 
within the ImagePrint folder in your 
Applications folder. On Windows, it’s in 
the ImagePrint Data folder -- you can get there by choosing “ImagePrint Data folder” from 
the ColorByte Software group in your Windows Start menu.

You can create your own borders, or purchase them.  Its easy to find vendors who specialize 
in borders such as artistic edges, greeting cards and sports cards. As long as the border is a 
flattened Photoshop file with a transparency layer, it can be used.

Borders are chosen via the Border Browser.

The Border Browser

Choose Border Browser from the View menu to launch the 
ImagePrint Border Browser.  



11-3 ImagePrint User’s Guide

Borders (Cont.)

Applying Borders

Simply drag any of the displayed bor-
ders in the Border Browser on top of 
any image in the layout area to apply it 
to an image.  

Border Sizes

When you apply a border to an 
image, the image will be resized 
to fit the size of the border.  For 
example, dragging a 4x5 border 
to a 8x10 image will resize the 
bordered image to 4x5 in the lay-
out window. 

Once a border is applied to an image, you can alter the size of the bordered image via 
the Scale settings, or dragging its edge, just like any other image.  (Using the side of the 
border, not the image, is necessary to prevent distortion of the border when applied to an 
image with a different aspect ratio than the border’s.)
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Cropping and Zooming borders

ImagePrint’s Smart Crop feature will let you zoom and crop the 
image for a best fit.  The normal Smart Crop tools apply, with the 
addition of a Zoom mode that lets you grow or shrink the image 
into the border.  

As always, double-click the image 
to activate Smart Crop. The Smart 
Crop window will appear.

Drag the image in the Smart Crop 
window to adjust its position.

To grow the image within the 
border, hold the COMMAND key 

(Macintosh) or the CONTROL Key 
(PC) down while dragging it.

By moving and zooming the image within the border, 
it’s easy to perfectly size and position the image.
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Borders and Templates

When you drag a border to a template, 
it will be applied to all images with the 
frames group that match the aspect 
ratio of the border.  

Important: Borders can only be 
applied to frames that match the 
border’s aspect ratio. This is neces-
sary because template frames have 
fixed aspect ratios--it would be 
impossible to force a border into a 
different aspect ratio without distort-
ing it.
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What are Templates?

Templates is an optional add-on with ImagePrint R.E.D. 

Please contact ColorByte if you wish to purchase the 
Templates feature.

ImagePrint’s templates are packages of images, sized 
and arranged according to your specifications.  Using 
Templates, you can create professional packages that 
mix wallet sized images, 4x5s, 8x10s, or any custom 
size you specify.  

When an image is assigned to a template, it is 
automatically sized to fit each frame within, and 
rotated to best fit each frame’s aspect ratio.  You 
can create templates that fill the page, or print 
multiple templates on one page.

Images within templates can be easily cropped, 
and borders can be applied via the Border 
Browser.

► Linked Templates:   

Linked Templates are groups of standard 
ImagePrint templates that can be added to your 
pages at once, allowing you to mix and match 
your templates into packages to be printed across 
one or more pages. 

For instance, you might have a template composed of a single 8x10, another tem-
plate composed of 20 wallet-sized images, and another with only 4x5s.  With Linked 
Templates, you can create a template group called  “8x10 and wallets” that includes 
both the 8x10 and wallet templates, and another called “8x10, wallets and 4x5s” that 
contain all three.  Based on customer orders, choose the linked template and drop imag-
es on it to fill all the templates within the group for easy mixed package creation.     

Hint: Templates may be one of those features that is easiest to understand when seen 
in action.  You may therefore want to view the online training movie that demonstrates 

Templates in use before reading through this chapter.  
 

ImagePrint training movies are available on the ImagePrint web site: 
  www.colorbytesoftware.com.

www.colorbytesoftware.com
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Templates are created with the controls in the Template Editor window and then 
applied to images by choosing Templates from the Layout Styles menu, and picking 
the template you want to use.

We’ll start by describing the controls available in the Template Editor window for 
viewing, creating and editing templates. Then we’ll describe choosing the active 
template, and applying your images to it.

To access the Template Control window, choose Edit from the ImagePrint main 
menu, then choose Templates...  

The Templates Editor window will appear.

Here, you can choose among pre-saved templates in the Templates menu along the 
top of the window, or create your own custom template.

A template is composed of frames of various colors within a single rectangle which 
represents the template’s bounding box.  In the Template editor window, the tem-
plate is shown as a gray patterned area.
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Viewing Templates

ImagePrint comes with a list of 
predefined templates to get you 
started.  These templates can 
be seen on the left side of the 
Template window.  

Any templates listed in this area 
will be available to use with your 
images.  

Below this list of saved 
Templates, you’ll see a section 
with two clickable tabs--one for 
Templates, and one for Frames.  
Click the Templates tab. You’ll 
see that the currently chosen template’s name will appear in the Template Name field 
here, and its width and height will be shown in the Width and Height fields.  Notice 
that as you choose each template, the frames and blue template bounding box that 
compose the selected template are displayed in the template design area on the left 
side of the window.

Creating New Templates

The template window also gives you the ability to create custom template designs.  
These templates can be saved into the template list, allowing you to create a set of 
unique packages.

To create a new template design, click the New Template but-
ton under the Template Tab.  The template design area  within 
the ImagePrint layout window will change to reveal only an 

empty template at the default size (the default template size is always the printable 
area of the current page.
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The first thing to do when creating a new template is to give 
it a name.  By default, new templates start out with the name 
“User Defined”, which can be seen in the Template Name 
field at the top of the Template window.  To give your new 
template a name, just type it into this field in place of the 
default name.

The next step is to specify 
the bounding box size of 
the new template.  At first, 
this size will be that of the 
current page, as shown by 
the gray area within the Template design area to the 
left.  Specify a new size by entering the numbers in 
the Template Width and Template Height fields of the 
Template window.

Adding a template background or artistic 
frame

You can also choose to add a background 
image, solid background, or frame with 
matte, to a template. The image will fill the 
template boundary area, with your image 
frames displayed within. 

Click the Add Background button and 
you will be presented with the normal Add 
Background window as described in the 
Backgrounds, Frames and Gallery Wrap 
chapter of this manual.  To remove a back-
ground from a template, click the Remove 
Background button.
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Frames

Adding a Frame
Now that we’ve named and defined the size of 
the template, it’s time to add frames.  To access 
the Frames controls, click the Frames tab.  

Remember, frames are the rectangles that rep-
resent where individual images will reside on the 
template. To add a frame, you must first specify 
its width and height. Specifying a frame’s width 
and height can be done in two ways.  

•	 Common frame sizes can be chosen 
by clicking on the Size drop down 
menu and choosing one of the listed 
sizes.  

•	 You can also create custom frame 
sizes by typing in values within the 
Width and Height fields below the 
Frame Size drop down menu. 

Once you have specified the width and height of the frame, click the Add button to 
have the frame immediately added within the Template design area of the ImagePrint 
layout window.

Each time you click add, a new frame will be added, using the current width and 
height settings.  Each new frame will be automatically positioned into the first avail-
able free spot within the template.  The distance the frame will be from the previous 
frame is determined the Gutter settings. We’ll talk a little more about gutters below.
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Adding Frames (cont.)

Adding a frame background or artistic border

Just like with the template as a whole, individual frames within the 
template can have their own backgrounds or artistic frames (how-
ever, in the case of frames, Image backgrounds are not allowed).  
Just click the Add Background... button to access the normal Add 

Background window.  For more information on the Add Background window, 
see the Backgrounds, Frames and Gallery Wrap chapter later in this manual.  
Choose Remove Background... to remove a frame’s background or artistic 
frame.

Gutters  The X and Y Gutters specify how much 
space to put between frames when automatically 
adding.  For instance, an X gutter of 2 inches will 
cause frames to be positioned 2 inches apart hori-
zontally.

Positioning Frames

You can manually adjust the frame positioning after 
adding it by clicking the frame within the Template 
design area and moving it.  You can also use the X / Y 
position fields to specify numeric position values rela-
tive to the edge of the template.  

  

Deleting Frames 

To delete a frame, click on it and choose the Remove Frame button.
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Grouping Frames

A powerful feature of templates is the ability 
to group frames. By default, every frame in a 
template will contain one image, but you can 
set up groups to cause the same image to be 
copied to several frames at once. 

Grouped frames will automatically be filled 
with the same image when you drag the 
image to any frame in the group.  Also, any 
cropping, or borders applied, will be applied to 
all frames within the group.  

The Group section of the Template Control 
window has the controls necessary to specify 
how your frames will be grouped.

Creating and Assigning Frame Groups

Frame groups are assigned via the Group menu within the Group section of the 
Template Control window. 

Use this drop-down menu to choose what group 
the next added frame will be a part of.  At first, 
there will be only two default groups, Group 0 and 
Group 1.  You can click the Add Group button to 
add to this list of groups as needed. Click Add 
Group once to create a Group 2, click it again to 
create a Group 3, etc. 

You can pick any created groups in the Group drop down above the Add Group but-
ton.  Once you select a group, all frames you add will be a part of that group until you 
specify a different group.

If you want to later assign a frame to a different group, just click the frame in 
Template Design area and pick a group from the drop down menu.
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Assigning Frame Groups (Cont.)

As you assign groups, each one will have a unique color assigned to it.  This 
group color is shown to the right of the Group drop down menu.  As new frames 
are created, they will be displayed with this color in the Template Design area. 
You can override the default color for the current group by clicking the Group 
color button.

Global Group Settings

The Group menu has two other choices besides its 
list of groups.  These two choices override the stan-
dard group assignments, and are used when you 
don’t want to manually choose your frame group-
ings:

Same image for all Frames  This option will cause every frame to be part 
of the same group within the template.  Any image applied to this template 
will be applied to all the frames within it.

Unique images for all frames  This option will cause every frame added 
to be in a unique group of its own.  Images applied to this template will only 
use a single frame.

Saving Templates

Once you have added and positioned the frames 
for you template just the way you want, you need to 
save it.  Choose the Template Tab at the top of the 
Templates window, then click the Save button.  

Your new template will be saved, and its name 
added to the template list on the left side of the 
Template window.  
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Deleting Templates

To delete a template, choose the Delete button on 
the right side of the template Window.

Editing a Template

Sometimes you may wish to edit an existing template rather than create a new 
one.  To do this, simply choose the template from the template list on the left side 
of the Template Editor window, then add new frames, and/or move, resize and 
delete existing frames as needed, using the tools within the Template Control win-
dow.  

Once done, click Save to save over the old template, or type in a new name for 
the template within the Template Name field and click Save to have it saved as a 
new template.
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Linked Templates

The Linked Template feature provides the ability to 
organize your already created templates into groups 
that can utilize the same images.  This allows you to 
create custom sets of packages that can span mul-
tiple pages.

To create a Linked Template, make sure you’ve 
already created two or more templates using the 
methods previously outline, then click the Links tab 
in the Edit Templates window.

Choose a template from the list of templates shown 
at the top of the window and drag it to the gray 
area to include them in your linked template.  You 
can drag any number of templates, and re-drag the 
same template to include them multiple times in 
your linked set.  To remove a template, simply drag 
it out of the window.  

Once done specifying which templates to include 
(and their order) type in a name for the linked set of 
templates, and click SAVE.  You’ll see your linked 
set added to the list at the bottom of the window. 

Once created, you can use your linked template 
much like you do individual templates, via the 
Layout Mode menu described in the next few pages. 
Choosing a linked template will cause all the tem-
plates within the set to appear on your layout, with 
ImagePrint automatically creating new pages to fit them if needed.  Dragging images into 
any of the frames within any of the linked templates will fill frames with the same group 
across all templates.
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Assigning Templates to images

Now that you are familiar with the mechanics of creating templates, it’s time to apply imag-
es to them.

To use templates, the current 
Layout Style must be set to 
Template.  You change the Layout 
Style in the Advanced section of 
the ImagePrint Dashboard. 

If the dashboard isn’t visible, 
choose it from the View menu.

Close the Template Editor window 
if you are done creating your tem-
plates, and choose Template as 
the Layout style in the Dashboard.

With Template as the 
Layout Type, the Layout 
Schemes menu (to the 
right of the Layout Type 
menu) will display all of 
your saved Templates.

Now choose one of the templates to see it displayed 
in the Pages window.

If you pick a linked template, all the templates that are 
part of that group will be displayed.

As is

Rotate to Fit

Fit to Size

Template

Package1

Wallets and 
4x5x

8x10 Set

Kids pack

Wedding1

Wedding2

Wedding3
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Assigning Templates to images (cont.)

Once you have chosen a template, you’re 
ready to assign images to it.

Open an image (or group of images) in the 
normal way via the Image Strip, the File-
Open command, or by dragging the image 
from a folder into the ImagePrint interface. 
The image will fill frames within the tem-
plate.  If your template is grouped, then all 
the frames of a group will be filled with the 
image.

If you drag your image from the 
Image Strip (instead of using  
File->Open, or double-clicking it 
in the image strip) you can spec-
ify which frame the image will be 
assigned to. 

Notice how, as you drag the image 
over a frame, the frame (and any 
other frames in its group) change 
color to indicate they will receive the 
image.

If you’ve picked a Linked Template, 
then dragging an image to any 
frame will cause that image to fill the 
frames in all the templates within 
that linked set that correspond to 
the same frame group.
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Assigning Templates to images 
(continued)

Once a template is filled with 
images, a new template will be 
added to the page if there is 
room.

Note: If AutoFlow is in effect, 
and there’s no room on the 
page for a new template to be 
created, a new page will be 
added with a blank template 
on it, ready for more images. 
This can be a powerful method 
of creating multiple template pages by dragging multiple images into the layout window-
-page after page of templates will be automatically created.

Scaling and Positioning Templates

When the Layout Type setting is Template, you will not be 
able to adjust the position of your template on the page or 
resize it.  However, if you switch the Layout Style in the 
Dashboard->Advanced to one of the non-Template modes 
(As is, Best Fit, or Fit to Size) then the templates will be 
treated like any other image.  You can scale, move and 
rotate the template as if it were one single image.

As is

Rotate to Fit

Fit to Size

Template
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Cropping Templates

Frames within a Template can be 
cropped like any other image.  Simply 
double-click the image to have it appear 
in the Smart Crop menu.

Any crop you apply to the image will 
be applied to any other frames within 
that template that are part of the current 
frame’s group and which have the same 
aspect ratio as the current frame. 

When cropping template frames, you can zoom the image 
in or out, allowing you to adjust the size of the image that 
appears in the frame.

To zoom in or out:

On the Mac, hold down the Command key while dragging 
the mouse within the Smart Crop window.

On the PC, hold down the Control key while dragging the 
mouse within the Smart crop window. 

Note that when cropping a template frame, your crop area will always be constrained 
to the aspect ratio of the frame.  You can zoom the crop, or position it, but you can’t 

change its shape.
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Borders and Templates

When you drag a border from the border browser to a template, it will be applied to all 
images with the frame’s group that match the aspect ratio of the border.  

Important: Borders can only be applied to frames that match the border’s aspect ratio. 
This is necessary because template frames have fixed aspect ratios--it would be impos-
sible to force a border into a different aspect ratio without distorting it.

Once applied to a frame, the 
border can be adjusted via 
Smart Crop by double-
clicking the frame, and 
adjusting the crop.

Don’t forget, you can 
Zoom the image in or out 
of the border within the 
Smart Crop window: 

On the PC, hold down 
the Control key while 
dragging the image in 
the smart crop window 
to Zoom it.

On the Mac, hold down 
the Command key 
and drag to zoom the 
image.

For more information on using Borders, see chapter 10, Borders.
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Backgrounds, Frames and Gallery Wrap

With ImagePrint, it’s easy to customize your layouts with colored background or 
frames.  And the new gallery wrap feature lets you automatically mirror and flip 
the edges of images for easy frameless mounting of canvas prints.

The Add Background window

All the controls to create backgrounds, frames and gallery wraps are in the Add 
Background window.  This window is accessed via the Mouse Menu or the Edit 
Menu at the top of the ImagePrint main window.  

On PCs, you can right click an image or group of images to see the Mouse 
Menu. (Left click with control pressed to select multiple images).

On Macs, if you don’t have a right mouse button, access the Mouse menu 
by holding the Control key and clicking on an image or group of images (to 
select multiple images, hold the Command key down and click each image 
to be added to the group). 

In either the Mouse menu, or the Edit menu, choose “Add Background” to see 
the available options (Frame, Solid, Image and Gallery Wrap).  Choosing any of 
these will open the Add Background window, with the chosen option selected.

The Add Background window 

Here, you can choose to add a Frame and 
Matte, a Solid Background, a Background 
Image, or a Gallery Wrap to the selected 
image.  

Each of these options has its own set of con-
trols that will be available when that option 
is chosen. (Remember--the Background and 
Frames window is also available when creat-
ing or editing a template, allowing you custom-
ize your templates with background graphics 
and frames.)  
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Adding a frame to an image

A frame is a rectangular border of a speci-
fied thickness and color which can be set at a 
specified distance from the edge of the area 
being framed.  The area between the frame, 
and the image, is the matte.  The matte can 
be colored as well, for “double-frame” effects. 

To create a frame for your image, click 
the Frame button at the top of the Add 
Background window.  The following controls 
will be available:

Distance from Image Edge

This is the distance the frame will extend from 
the edge of the image(s) being framed.  It can 
be symmetrical; meaning equal distance from 
each edge of the framed area, or you can 
choose different distances for the top, bottom, 
right and left edges. 

Color

Here you can choose the color of the frame by clicking the color button and choosing via the 
Color Chooser that will appear.  An eyedropper has also been provided--select this icon, then 
click anywhere on the screen to choose a color.  The eyedropper is a great way to pick a 
frame color using a color from within the image itself.

Frame Thickness 

The frame thickness is specified via the Thickness field. Note that this value does not include 
the thickness of the matte (see matte, below).  The difference between the Frame Thickness 
and the Distance from Image Edge will be filled by the Matte color.

Matte Color 

To alter the Matte color, click the Matte Color button in the Frame area, or use the eye drop-
per beside it to choose a color from any image in your layout.  (Hint: Try choosing Transparent 
as the Matte color--this allows for very interesting effects when you place the image on top of 
another one.)
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Transparency 

The transparency slider allows you to change the transparency of the frame, allowing you to 
see the current matte color through the frame.  In most instances this is not desirable, but...
if the Matte color is set to transparent, then instead of the matte color being revealed, you 
will see underlying objects through the frame, which can lead to some great effects.

Creating an artistic frame:  An example 

For the below image, Frame was selected in the Add 
Background window, then a .600 Distance from Image 

Edge value was chosen.  

Next, for the Frame itself black 
was chosen, but for the Matte 
color, the Matte Color eyedrop-
per was used to select a bit of 
color from the image.  Finally, 
a Frame thickness of .3 was 
chosen--this means that the 
Matte color will fill the .3 differ-
ence between the .6 Distance 
from the image edge, and the 
.3 thickness of the black frame.

Frame

Matte
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Adding a Solid Background

A solid background is an area of single solid color sur-
rounding an image or group of images.  It is similar to 
a frame, but has no control for specifying thickness or 
matte, since it always fills the area between its edge 
and the image(s).

To specify a solid background for your image(s), click 
the Solid button at the top of the Add Background win-
dow.  The following controls will be available:

Distance from Image Edge

This is the distance the background will extend from 
the edge of the image(s) being affected.  It can be sym-
metrical; meaning equal distance from each edge of the 
framed area, or you can choose different distances for 
the top, bottom, right and left edges. 

Color

Here you can choose the color of the background by clicking the color button and choosing via 
the Color Chooser that will appear.  An eyedropper has also been provided--select this icon, 
then click anywhere on the screen to choose a color.  The eyedropper is a great way to pick a 
background color using a color from within the image itself.

Transparency 

The transparency slider allows you to change the transparency of the background, allowing you 
to see underlying items through the background.

This image has a solid black 
background with non-symmet-
rical distances of Top, Left and 

Bottom .3, and Right 4.0.

(The text was later added via 
the Add Text menu).
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Adding an Image Background

You can choose to have an image appear as 
a background to an image or group of imag-
es.  This background image can be automati-
cally cropped to fit the area, or left in its original 
aspect ratio.  Click Image at the top of the Add 
Background window to access the following con-
trols:

Distance from Image Edge

This is the distance the background will extend from 
the edge of the image(s) being affected.  It can be 
symmetrical; meaning equal distance from each edge of the framed area, or you can choose 
different distances for the top, bottom, right and left edges. 

Choosing an Image

You can choose any tiff, JPEG, or psd file as the background by clicking the Image button in 
the lower section of the Add Background window, then locating it via the standard file dialog 
that appears.

Crop

The crop controls how the image will “fit” in the area you defined via the Distance from Image 
Edge fields.

- Selecting “Crop and Zoom” from the Crop menu will cause the chosen image to auto-
matically crop to the exact size specified in the Distance fields.  You may not see the 
entire image if the aspect ratio differs from the Distance values you specified. 

- Choosing “Accommodate without Crop” will cause the image to grow as large as pos-
sible within the Extent boundaries without cropping or distorting the image.  This option 
may result in the background image not fully covering the specified area, but all of the 
background image will be placed.    

Transparency 

The transparency slider allows you to change the transparency of the background image, 
allowing you to see underlying items through it. This can make for some nice watermark 
effects.

An example of an image with a 
background image applied with 

slight transparency.

The text was later added via the 
Add Text menu.
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Creating a Gallery Wrap
A gallery wrap is a method of extending the edges of a print for frameless mounting in such a way 
as to present no harsh transitions while preserving the entire image without cropping.

With ImagePrint’s gallery wrap feature, a portion of the 
edges of the image will be duplicated and mirrored, allow-
ing each edge to seamlessly wrap around the sides of the 
mounting bar.  Note that gallery wrap can only be applied to 
a single image--not to a group of images.

To create a Gallery Wrap, choose Gallery Wrap at the top of the Add Background window.  You 
will have access to the following control:

Distance from Image Edge

This is the only control available for Gallery Wrap. Choose the distance from the edge of the 
image that should be duplicated and mirrored.  This distance should reflect the thickness of the 
mounting bar you plan to use for mounting the print.

If the original image was close to the edge of the page, you may need to move it to ensure the 
newly added edges are within the printable area of the page

A rather exaggerated example of a 
Gallery Wrap. The original image is 
extended and mirrored at the edges, 

allowing for a smooth edge when wrap 
mounting without a frame.
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Backgrounds, Frames and Gallery Wrap (Cont.)

Removing image background settings

To remove any Frame, Background, or Gallery Wrap, Control-Click or Right-Click the 
image(s) and choose Remove Background from the menu that appears.

Editing background settings 

To change the Frame, Background, or Gallery Wrap settings, Control-Click (Mac) or 
Right-click (PC) the image(s) and choose “Edit Background”.  

The Add Background window will appear, allowing you to make changes to its cur-
rent parameters using the controls discussed throughout this chapter. 
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What are Boundary Areas?

A Boundary is an area of the page treated as a sub-page.  Images within a boundary will act 
as if grouped--moving the boundary will cause all the images and text elements in it to move 
as well, while each element, if clicked on, can be moved separately.

But boundaries are more than just a grouping mechanism.  Crop marks will be applied to the 
boundary, not the images within it, allowing you to easily segment your pages into sub-pages 
for cutting.  Annotations for each image will also automatically appear beneath boundary, mak-
ing it easy to keep track of what images are included within each sub-page without having 
them actually print.

In addition to their use in defining sub-pages, boundaries have another usage: an artistic one.  
Boundaries are essentially an extra background because, while you can choose to have the 
boundary transparent, you can also fill it with color.  When used with Image Backgrounds and 
Frames, boundaries can provide yet another layer of graphical possibilities in your layouts.

Boundaries can be defined based on images that have been already laid out--you will then be 
able to specify a boundary that “fits” the selected image--it’s much easier to create a bound-
ary with a centered image within it this way.  You can also create a boundary without selecting 
images for it to encompass and later drag images on to it.  Boundary Areas are created via the 
Add Boundary Area window. 

The Add Boundary Area window

The Add Boundary Area window is accessed via the Mouse Menu, or the Edit Menu at the top 
of the ImagePrint main menu.  

- On PCs, you can right click an on an empty area of the layout window, or on an image 
or group of images to see the Mouse Menu. (Left click with control pressed to select 
multiple images).

- On Macs, if you don’t have a right mouse button, access the Mouse Menu by holding 
the Control key and clicking on an image or group of images or an empty area of the lay-
out area. (To select multiple images, hold the Command key down and click each image 
to be added to the group). 

In the Mouse Menu or the Edit Menu, choose “Add Boundary Area” to access the Add 
Boundary Area window.
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Boundary Areas (Cont.)

The Add Boundary Area window

This window provides controls for specify-
ing the size and fill of the boundary area.  
The available selections are:

Transparent / Solid

If you want to use the boundary as a 
means of grouping, or as a means of 
defining a croppable “sub-page”, without 
it being part of the graphical elements on 
the page, click Transparent at the top of 
the screen.  A transparent boundary will 
be shown on screen with cross hatched 
lines, but will not print.

Choose Solid if you want to specify a 
color for the boundary.

Boundary Dimensions

This is where you specify how big the boundary will be.  You can do it two ways--either as an 
absolute width/height value, or base the size on the images it is bounding.

- Click “Define by Size” to specify an absolute boundary size, then put the values in the 
Width Height fields. This option is usually desired if you are creating a “sub-page”, like 
an album page, that needs to be cut at a specific size regardless of the image(s) within 
it. 

- Click “Define from Image Edge” if you want the boundary to be defined by the 
image(s) it encompasses.  (This option is only available if you accessed the Add 
Boundary Area window by clicking on an image or group of images, not an empty area).  
This can be useful if you are using the boundary as a colored background or frame and 
are more concerned about the size of the margin than the size of the boundary itself.

Solid Fill Parameters

If you chose “Solid’ instead of transparent for your boundary, this is where you can choose 
its color.  Click the Color Button and choose via the Color Chooser window that will appear.  
An eyedropper has also been provided--select that icon, then click anywhere on the screen 
to choose a color.  (The eyedropper is a great way to pick a boundary color using color from 
within one of the images on the page).
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Boundary Areas (Cont.)

Using Boundaries

Here’s some important points to keep in mind when using boundary areas:

	 •	 Adding images to boundaries is like grouping them--clicking the boundary and mov-
ing it will cause all images in it to move together with it, preserving their relative 
locations.

	 •	 Clicking an individual image within a boundary will cause just that image to move.

	 •	 Moving an image partially out of the boundary will remove it from the boundary 
group.

	 •	 Images within boundary areas will not have individual crop marks and their annota-
tions will appear at the bottom of the boundary.

This image has crop marks 
and an annotation (caption).

When dragged onto 
a boundary area, 

the crop marks are 
removed, and the 

annotation is added 
to the bottom of the 

boundary. 
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Common System Driver Settings

ImagePrint R.E.D. uses some settings from your printer manufacturer’s driver (the free driver 
provided by your printer manufacturer). These settings include the paper size, the size of the 
non-printable margins, borderless printing settings and whether roll or sheet paper is being 
used.  The Media Type also needs to be set in the printer driver’s settings and will be used to 
automatically set the correct paper profile if you are using papers from your printer manufactur-
er (OEM). This chapter gives a brief overview of common settings for Epson and Canon print-
ers for both Macintosh and Windows computers.

Any settings that need to be set in the printer driver will be labeled with “Set in Driver” in the 
ImagePrint Dashboard.

Accessing the system driver:

Click the triangle button  beside the word PRINTER in the ImagePrint R.E.D. dashboard to 
expand the printer settings area.  

Make sure your R.E.D. driver (Desktop or Large) is selected as the printer, then click the 
Setup... button to launch your printer’s Printer Driver dialog.  

Choose your printer in the driver window drop-down menu to access the settings for that print-
er. 

On OSX computers you may need to click the 
“Show/Hide Details” button at the bottom of 
the window to view all of the 
available options. 

On Windows computers, 
you will need to click the 
PROPERTIES button to 
access the printer driver’s 
settings.

The following pages give recommended settings for Epson and Canon printers for use with 
ImagePrint R.E.D.

Windows

OSX
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Common Canon Driver Settings - Macintosh

Here are the recommended settings to 
use for most Canon Printer drivers. Not 
all settings will be available for every 
printer, and settings not mentioned 
should be left at their default state.

Page Attributes
•	 Copies: Specify the number of cop-

ies
•	 Pages: Choose All pages or a 

range of pages
•	 Paper Size: Pick a size that match-

es the paper loaded in your printer 
or choose “Manage Custom Sizes” 
to create a custom page size. 
When creating custom page sizes:

If printing on ROLL, make sure the width of the paper you specify is the same as that 
of the roll loaded on the printer and specify a length long enough to accommodate your 
planned layout.  

If you want to print edge to edge borderless, make all the margins 0 (ignore any warn-
ing that may appear).

•	 Orientation: Leave at Portrait (vertical)

Layout
•	 Pages per sheet: 1 
•	 Border: None

Color Matching:  No changes

Paper Handling:  

•	 Do NOT select “Scale to paper size”
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Cover Page: No changes

Quality Media: 

•	 Media Type: Choose your media or the one recommended by your paper 
manufacturer.

•	 Paper Source: Roll (Auto) or Sheet
•	 Print Quality: Highest available

Color Option: No changes

Paper Detailed Settings: No changes

Page Processing (Only valid for ROLL printing)

•	 Roll Width: Pick the width that matches the width of your roll.
•	 Automatic Cutting: Specify this if you want the paper automatically cut at 

the end of the print.
•	 Fit Roll Width: 

ON (BORDERLESS) for Borderless (full bleed) printing. You must have 
specified a page size with no borders.  

ON (BORDERED) to print with a border.

•	 No spaces top and bottom (inked area): To save paper, choosing this 
option will cause empty space above and below the images in your layout 
to not be output.

Additional Settings:  No changes

Settings not mentioned above should be left at their default setting.

Canon Drivers - Macintosh (continued)
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Common Epson Driver Settings - Macintosh

Here are the recommended settings to use 
for Epson Printer drivers. Not all settings 
are available for all printers, and settings 
not mentioned should be left at their default 
state.

Page Attributes

•	 Copies: Specify the number of copies
•	 Pages: Choose All pages or a range.
•	 Paper Size: Pick a size that matches 

the paper loaded in your printer or 
choose “Manage Custom Sizes” to 
create a custom page size.  
 
When creating custom page sizes:

If printing on ROLL, make sure the width of the paper you specify is the same as that 
of the roll loaded on the printer and specify a length long enough to accommodate 
your planned layout.  

If you want to print edge to edge borderless, make all the margins 0 (ignore any warn-
ing that may appear).

•	 Orientation: Leave at Portrait (vertical)

Layout:

•	 Pages per sheet: 1 
•	 Border: None

Color Matching: No changes

Paper Handling:  

•	 Do NOT select “Scale to paper size”

Cover Page:  No changes
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Printer Settings: 

•	 Page Setup: Choose the appropriate borderless/non-borderless or sheet setting.  If you 
wish to use the Save Roll Paper option, where the final blank area of a print is not out-
put, choose Roll (Banner) and select the Save Roll Paper Option in Roll Paper Settings 
(below).

•	 Media Type: Choose your media or the one recommended by your paper manufacturer.
•	 Paper Source: Roll (Auto) or Sheet feeder
•	 Output Resolution: Highest available.

Roll Paper Settings (Only valid for ROLL printing):

•	 Auto-cut settings: Specify how you want auto-cutting to be handled by the printer.
•	 Fit Roll Width: 

ON (BORDERLESS) for Borderless (full bleed) printing. You must have specified a 
page size with no borders.  
ON (BORDERED) to print with a border.

•	 Save Roll Paper (inked area): To save paper, choosing this option will cause empty  space 
below the images in your layout to not be output.  To use this option, Roll (Banner) must be 
selected in Printer Settings (above).

•	 Advanced Media Control - No changes

Settings not mentioned above should be left at their default setting.

Epson Driver Settings - Macintosh (continued)
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Common Canon Driver Settings - Windows

Here are the recommended set-
tings to use for most Canon Printer 
drivers on Windows computers. 
Not all settings will be available for 
every printer, and settings not men-
tioned should be left at their default 
state.

Main Tab

Advanced Settings should be selected

•	 Media Type: Choose your 
media or the one recom-
mended by your paper manu-
facturer.

•	 Print Quality: Highest avail-
able.

•	 Color Mode: 

Color if printing color
Monochrome to convert output to grayscale. (ImagePrint R.E.D.’s color management 
mode should be set to Printer Handles Color Management

•	 Color Settings... 
 Click the Color Settings button and the Color Settings window will appear.

    - Under the Matching Tab ensure that ICM is the selected mode.

    - Under the Clear Coat Tab (if available) choose the clear coat mode.

► Auto causes the driver to selectively apply the clear coat to inked areas

► Overall will cause it to apply the clear coat to the entire page area.	
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Page Setup Tab

•	 Page Size: Pick a size that matches the paper loaded in your printer or choose “Custom 
Paper Size” to create a custom page size. If printing on Roll, make sure the width of the 
paper you specify is the same as that of the roll loaded on the printer and specify a length 
(height) long enough to accommodate your planned layouts.

•	 Borderless Printing: Enable this selection if you want to print full bleed (not all printers 
and page sizes support borderless printing).

•	 Enlarged/Reduced Printing: Disabled

•	 Orientation: Portrait (Vertical)

•	 Paper Source: Roll or Sheet according to what you have loaded on your printer

•	 Roll Paper Options: (Roll only) 
 Automatic Cutting: Specify if paper should be automatically cut after each print.
 Banner Printing: Disabled

•	 Roll Paper Width: (Roll only) Choose the same width as the Roll Paper size you are 
using.

Layout Tab
•	 No Spaces Top or Bottom: Enable this setting to have the printer output only the areas of 

your layout that contain image data. This mode will save paper by not printing the empty 
space above or below the images in your composition.

•	 Copies: Specify the number of copies that should be output. (default: 1).

Settings not mentioned above should be left at their default setting.

Canon Driver Settings - Windows (continued)
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Common Epson Driver Settings - Windows

Here are the recommended settings to 
use for Epson Printer drivers. Not all 
settings are available for all printers, and 
settings not mentioned should be left at 
their default state.

Main Tab
•	 Media Type: Choose your media or 

the one recommended by your paper 
manufacturer.

•	 Color: 

Color if printing color

Advanced B&W to convert output 
to grayscale. (ImagePrint R.E.D.’s 
color management mode should 
be set to Printer Handles Color 
Management)

•	 Print Quality: Highest available

•	 Mode : Custom
► Choose ICM in the Mode 
drop-down menu

► Click Advanced... and make sure HOST ICM is the selected ICM Mode.

•	 Source: Roll or Sheet according to what you have loaded on your printer.

•	 Roll Paper Option: (Roll only) 
 Automatic Cutting: Specify if paper should be automatically cut after each print.

•	 Size: Pick a size that matches the paper loaded in your printer or choose “User Defined” to 
create a custom page size. If printing on Roll, make sure the width of the paper you specify 
is the same as that of the roll loaded on the printer and specify a length (height) long 
enough to accommodate your planned layouts.

•	 Borderless Printing: Enable this selection if you want to print full bleed (not all printers 
and page sizes support borderless printing).
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•	 Save Roll Paper: (Roll only)  Enable this setting to have the printer output only the areas 
of your layout that contain image data. This mode will save paper by not printing the empty 
space below the images in your composition.

•	 Roll Paper Width: (Roll only) Choose the same width as the Roll Paper size you are 
using. 

Layout Tab
•	 Orientation: Portrait (vertical)

•	 Copies: Specify the number of copies that should be output. (default: 1).

Settings not mentioned above should be left at their default setting.

Epson Driver Settings - Windows (continued)
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SpoolFace - The ImagePrint Spooler
The ImagePrint Spooler is one of the most powerful features of ImagePrint software.  
With its graphical interface, print jobs can be rearranged and prioritized, sent to dif-
ferent printers or moved from one computer to another.  It is also possible to directly 
edit the parameters of a print job, allowing you to change elements such as the num-
ber of copies, DPI, ink set or drum speed--without having to rebuild the layout. With 
SpoolFace, you can view thumbnails of your jobs, and save previously printed jobs 
(including all images and profiles used) into archive files for future printing.

To launch the spooler, click the Spooler button at the top of the Dashboard.  (Note: you 
may also launch the spooler directly from the Spool folder within the ImagePrint folder 
on your hard drive). 

The ImagePrint Spooler interface utility, SpoolFace, will appear.  

The SpoolFace window 
allows you to view and 
control your print jobs.

Run into a Problem?

The ImagePrint trouble shooting guide is located in 
your ImagePrint folder and can be accessed from 

the Help menu in ImagePrint or Spoolface.
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The ImagePrint Spooler  (Continued)

Using SpoolFace

SpoolFace consists of 4 areas:

The Menu Bar - Located along the top of the Spoolface window if on a PC, or along 
the top of the screen if on a Mac, this area gives access to controls for viewing different 
printer queues and queues on remote machines, as well as Pausing and Resuming the 
queue.

The Active Queue - This area is located on the top left side of the spooler interface.  It 
shows the currently printing, and lined up to print, jobs.

The Inactive (Saved) Queue - This area, on the lower left side of the SpoolFace win-
dow, lists jobs that are currently not set to print.  Once a job is done printing, it is auto-
matically moved from the Active Queue to this Inactive Queue.

The Status Area - Located at the right side of SpoolFace, this area shows the current-
ly printing job, as well as a running list of messages from the spooler during printing.  

The Preview Area - Located at the bottom right side of SpoolFace, this area shows 
thumbnails of the currently selected print job.  Note: You must have enabled “Generate 
previews for SpoolFace” in the ImagePrint Preferences window prior to printing.  

Active Queue

Inactive Queue

Status Area

(Check here for errors!)

Preview Area



16-4 ImagePrint User’s Guide

The ImagePrint Spooler  (Continued)

As jobs are submitted to the queue, they are displayed in the left side of the 
SpoolFace window.  From there, they can be cancelled or deleted by highlight-
ing them and dragging them to the desired location. 

Drag and Drop job control

To cancel a job, highlight it in 
the Active (top) pane and drag 
it to the Inactive (lower) pane.

To re-submit a job, highlight it in 
the Finished (lower) pane and 
drag it to the Active (top) pane.

To permanently delete a job, 
drag it from the Inactive (bot-

tom) pane to the Recycling bin 
icon. 

 Currently printing jobs appear on 
the upper left pane of the spooler

Finished or cancelled jobs appear 
on the lower left pane of the 

spooler

Delete jobs from the inactive pane 
by dragging them to the Recycling 

bin

Note on DEMO printing

If you don’t have an encryption for ImagePrint but want to print in DEMO mode (with the 
word DEMO watermarked on your prints), make sure “Print if Demo” is selected within the 

QUEUE menu’s DEMO options. 
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Using the ImagePrint Spooler (Cont.)

Previewing jobs - Highlight a job in the Active or Inactive queue to see a thumbnail of it’s 
contents in the Preview area in the bottom right corner of the SpoolFace window.

Status

The current status will appear here, in the very bottom left corner of the SpoolFace window. 

This is the quickest place to see if SpoolFace is paused, ready to print (idle) or finished the 
last print with an error.

Tip: If you have a lot of jobs to search through, the Use Filter checkbox will pop-up a search 
menu for quickly finding the one you’re looking for.  That feature is described later in this 

chapter.
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Using the ImagePrint Spooler (Continued) 

Archiving jobs    (THIS FEATURE IS NOT SUPPORTED FOR IMAGEPRINT R.E.D.)

Job(s) in the Inactive (lower) Queue can be preserved for safe keeping--all images, pro-
files, and settings are included in the archive.  The archive can then be backed up or 
moved to a new computer running ImagePrint.  

To create a job archive:

Right click or Control-click one or more selected 
jobs in the “Inactive” lower pane of the SpoolFace 
window, and choose Archive Jobs in the menu that 
appears.  (To select multiple jobs, hold the Control 
key (PC) or Command key (Mac) while clicking 
them).

The Archive Jobs dialog will appear.

Click Choose Folder to specify the location in which 
you want to save the archive.

Select the “Include Images” checkbox to have all images included in the job file 
archive that were part of the original print.  (Including images will make the archive sig-
nificantly bigger, but is usually necessary for future printing to occur if the images are 
to be deleted or moved from their current location).  If “Include Images” is not selected, 
and the images from the print job(s) are moved or deleted, the archived job(s) will not 
print successfully.

Select “Include Profiles” to include the ICM/ICC color profiles used in the original job 
within the archive.  In most cases this is recommended to ensure the archive contains 
all of the original color information for future printing. If a necessary profile is not avail-
able in the ImagePrint Color folder when the archived job is reprinted, the print will fail if 
the profile was not included within the archive. 

Click OK to create the Job Archive.

Restoring archived jobs - To retrieve jobs from a previously created job archive, Right 
click (PC) or Control-click (Mac) within the Inactive (lower) pane of SpoolFace and 
choose “Restore Job(s) from Archive” in the menu that appears.

You will be presented with a File dialog allowing you to locate the saved archive.  Once 
you select the archive it will be restored into the Inactive queue.  Jobs can then be 
dragged to the Active Queue for printing. 
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The ImagePrint Spooler  (Continued)

Following is a complete list of the operations which can be performed via the Spooler inter-
face window:

Choosing a Different Queue
To display a Print Queue from another workstation in the current spooler interface win-
dow, choose the desired workstation’s name from the Computer drop down menu.

Choosing a Different Printer
To display another printer’s queue in the current spooler interface window, choose the 
desired printer from the Printer drop down menu.

Changing DEMO mode behavior
Choose “Demo Mode Behavior” under the QUEUE menu to specify what should hap-
pen when ImagePrint does not have a valid license (or in the case of Macs, if no don-
gle is attached).  Normally, nothing will print in that case, but you can instead choose to 
have the word “DEMO” watermarked on your prints.  You can also use this menu to run 
ImagePrint in “emulation mode”, allowing nothing at all to go to the printer (Emulation 
mode can be useful for testing spooler/printing problems without wasting paper).

Changing Job Priority
If you need to re-order jobs in the active queue, move them to the inactive (lower pane) 
then drag them back to the active (upper) pane in the order you wish to print them.

Canceling Jobs from the Active Queue
To cancel a job from the active queue, highlight the desired job (hold down the Control 
key to select multiple jobs) and drag it to the Saved (lower pane) Queue. 

Force Quitting a job
If canceling a job using the normal method of dragging it to the Saved Queue fails, 
you can choose “Force Quit” from the Queue menu at the top of the Spoolface screen.  
Make sure to reset your printer and unpause SpoolFace (Queue->Pause) after force 
quitting a job. 

Resending jobs from the Inactive (Saved) Queue
To resubmit an inactive job to the Active Print Queue, highlight the job (hold down the 
control key to select multiple jobs) and drag it up to the Active Queue pane.
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The ImagePrint Spooler  (Continued)

Deleting Jobs from the Inactive (SAVED) Queue
To permanently delete a job from the Inactive Queue, highlight the job and drag it to 
the Recycling Bin icon at the bottom of the SpoolFace window. 

Pausing the Print Queue
Choose Pause Queue from the Queue drop down menu located at the top of the 
screen to cause the currently displayed queue to be paused. (You’ll see a check mark 
beside the Pause Queue menu entry after selecting it). Paused will appear in the status 
area at the bottom left corner of the spooler interface window.  

Resuming the Current Queue
Choose Pause Queue from the Queue drop down menu to cause the currently dis-
played queue to be resumed.  (The check mark beside the Pause Queue menu entry 
will disappear when the Queue is resumed). Active will appear in the status area at the 
bottom of the spooler interface window.

Viewing Job Parameters
To view the parameters of a print job, including DPI, ink set, file names and color pro-
files being used, move the job to the Inactive (Saved) Queue (lower pane) and double-
click it.

Editing Job Parameters
To edit a jobs parameters (such as DPI or ink set), first View the job in the Inactive 
(Saved) Queue as described above, then edit the values in the view window.  When 
you close the viewing window, you will be asked if you wish to save the job changes.  
Choose yes, and the new parameters will be saved.  Note: Incorrect job parameters 
can result in jobs that do not print or print incorrectly.

Archive/Restore jobs  (ImagePrint Black only)

Right click (PC) or Control click (Mac) job(s) in the Inactive (Saved) Queue and choose 
the appropriate function in the menu that appears. (Archiving jobs is described earlier 
in this chapter).
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The ImagePrint Spooler  (Continued)

Use Filter
The Use Filter checkbox -- located in the bottom left of 
the Spoolface window -- will cause a search window to 
be displayed that provides tools for searching through 
jobs in the Saved (bottom) area of Spoolface.  This can 
be useful if you have a large number of saved jobs that 
you regularly reprint.

To use the Search window, first pick from among the 
available job columns in the Filter Column menu.  You can choose to search based on 
the Job number, the computer (Host) it came from, the User that sent the job, the Date 
it was sent, or the job’s Name.  

Next, pick the search method you wish to use in the Filter Syntax menu (or just leave it 
at its default setting (Regular Expression) which works fine for most simple searches)).    
In addition to Regular Expression searching - which uses standard regular expression 
syntax beyond the scope of this manual -- you can choose Wildcard searches (using 
standard wildcard characters like “*”) or Fixed (Exact) String matching which uses no 
wildcards or regular expression syntax and will return results based on the exact text you 
specify.  

Next, type the text you wish to search for in the Filter Pattern field at the top of the win-
dow and hit the return key. The jobs listed within the Saved (bottom) section of spoolface 
will change to show only the jobs that match your search criterea. 

Note that you can choose to make your searches case senstive via the Case sensitive 
filter checkbox, and have your results sorted case sensitively via the Case sensitive 
sorting checkbox.

To close the Filter search window and return to the normal (complete) job list, just un-
check the Use Filter checkbox.
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Cut-it-out!
The automatic cutter control option

Cut-it-out! is a new option for ImagePrint R.E.D. and 
Black that supports Graphtec Roll and Flatbed cutters.  

In the past, automatic cutting has mostly been limited to 
vinyl or heavier media, but with Cut-it-out! ImagePrint 
brings inexpensive automated cutting to standard ink-
jet printing.  From school packages to portraiture, from 
business cards to fine art -- if you can print it, you can 
cut it with Cut-it-out! and a supported cutter.

To use Cut-it-out you must have a supported cutter attached to your computer (and pur-
chased a Cut-it-out! license to enable the feature).  ImagePrint will use the cutter automati-
cally--no additional installation needed.

Two types of Cutting 

Cut-it-out! supports two methods of cutting, Basic and Contour.

With Basic cutting, rectangular or oval-shaped cuts (with or with-
out borders) will be applied to every image on the page according 
to the image’s boundaries. For many users this is the only type of 
cutting needed. If you need to easily print and then cut out photo-
graphs with virtually no extra steps, this is the option for you.

Contour cutting conforms to image shapes, not just the rectangu-
lar image boundaries.  Images with decorative borders... artistic 
lettering... cartoon characters... pretty much any shape you can imag-

ine, ImagePrint’s contouring tools will make it easy to create 
the paths needed to precisely cut them.  And...contour cutting 
also works with paths in images saved from Adobe Illustrator or 
Photoshop.

What’s next?

The next few pages will show you how to enable Cut-it-out! and set up cutting 
parameters for doing Basic (rectangular and oval) cuts.  Contour cutting is covered next 
(you can skip that part if you don’t plan to do that kind of cutting) followed by instructions 
on how to send the job to the cutter after it’s printed.  

Finally, to help get you started we’ll devote a few pages to the essentials of setting up and 
using your Graphtec cutter with Cut-it-out!.
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Enabling Cut-it-out!

You can find Cut-it-out! within the CUTTER SETTINGS section of the ImagePrint 
Dashboard, under ADVANCED. To enable it, select the check box at the top of the Cutter 
Settings section.  

What happened to the page size?

Notice that as soon as you enable Cut-it-out! the printable 
area in the ImagePrint layout window becomes smaller by 
about an inch on all sides.

This larger margin space is needed for the registration marks 
that the cutter uses to set the coordinate system for each page 
in order to ensure pinpoint accuracy in the cutting process.  
ImagePrint will automatically add the six registration marks at 
print time in this margin area.

Setting up the Basic Cut parameters

The Cutter Settings section of the Dashboard is where 
you specify how the images on the printed page will be 
cut. 

On the next page you’ll find the available options 
and descriptions of their functions.  

Cut-it-out! (Continued)
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Setting up the Basic Cut parameters (continued)

Type  

The Type menu lets you choose the 
shape of the cut.  There are three 
choices:

Rectangle
 Cuts will be rectangular with 90 degree corners.

Rounded Rectangle

Cuts will be rectangles with rounded corners.  The round-
ness of the corners is determined by the Radius setting 
(described below).

           	 Ellipse

  Cuts will be elliptical (oval).  The shape 
and size will be determined by the image’s shape and 

size.

 

Cut-it-out! (Continued) - Basic Cutting
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Setting Cutting Parameters (continued)

After specifying the Type of cut to be made, the next two settings let you control the shape and 
size of the cuts.

Radius

The Radius setting is only used when the Type 
(see above) is set to Rounded Rectangle.  The 
radius determines how rounded the corners will 
be. The default of .175 results in a slightly round-
ed corner.  To increase the roundedness, make 
this value larger.  To make the corners sharper, 
decrease this value.

Spread  
This setting controls the distance from the edge of the 
image that the cut will be made.  The default is 
0.00, meaning the cut will be made right at the 
edge of the image.  

Increase the spread if you want a border 
around your image. 

Leave the spread at 0 if you want no border.

Decrease the spread value below 0 if you want to cut into the edges of your image. This 
can be useful if you are working with images or documents that are oversized and you 
want them cut to the proper dimensions.  

Note that as you place images on the page, you’ll see any non-
zero spread represented as a rectangle around each image.  

As it lays images out, 
ImagePrint will auto-
matically space them  
so that the spread 
areas don’t overlap.

Cut-it-out! (Continued) - Basic Cutting
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Setting Cutting Parameters (continued)

The next two cutting parameters allow you to specify the hanger size and spacing.

What’s a hanger?

 
 

Hangers are tiny pieces of uncut paper spaced along the cut line that keep the cut image 
from completely separating from the page.  Without leaving some hangers the integrity of the 

paper would decrease during the cutting process and eventually a paper jam would occur.    

 
In the example above, a sheet of cut images is being held together by several hangers on 

each side. It’s easy to separate them with just a small amount of force.   

Hanger Space
This is the distance that the hangers will be placed from one another.  The default of 
.750 inches should be sufficient for most cutting jobs.  If a specific type of layout is 
causing paper jams, or cuts that separate from the page prematurely, then decrease the 
spacing. That will add more hangers, increasing the integrity of the page.   If you are 
just cutting a few images on the page you may be able to decrease this value to use 
fewer hangers.

Hanger Size
This setting lets you specify the size of the hangers. The default value is .3 mm which 
should be fine for most cutting.  If the hangers are too small they will fail to hold the cut 
images in place during the cutting procedure.  Too big, and you may have trouble sepa-
rating the cut image from the page afterwards.  It is not recommended that you change 
this value without guidance from our support team.

Cut-it-out! (Continued) - Basic Cutting
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Setting Cutting Parameters (continued)

The final three settings are global options that apply to both Basic and Contour cutting.

Image Protection
As the cutting assembly moves back and forth over the paper, 
it’s possible that it may mar the surface of the print as it quickly 
moves to the next location. Image Protection mode will cause 
the cutter to determine a path that doesn’t pass over printed 
areas of the paper, greatly reducing the chances of a marred 
print due to a cutter head strike.  

Blind Cutting (skip printing)
Enable this mode when you don’t want to actually print the images you’ve laid out on the 
page. Instead, a job will be created (when the print button is clicked) that only contains 
the cutting data -- not the images they apply to.  You can then pass the job to the cutter 
to cut out blank shapes.

Cut Both Boundaries and Contours
With this setting enabled, both Basic cuts (for all images on the page) and Contour cuts 
(for images that have contour cutting paths) will be performed when the page is sent to 
the cutter.  This is the default mode. 

Turn this option off it you only want the contours cut -- no basic (rectangular/oval) cutting 
of the image.  

Cutter Selection

Click the Gear icon to access the Cutter selection window.  This window allows you 
to select the cutter model you are using, as well as the connection (USB or net-
work).  If  network, the window will also let you specify the IP Address of the cutter. 

That takes us to the end of the Basic Cutting parameters. 

Contour cutting will be covered next, but first let’s go over a couple of best practices to use 
when laying out images to ensure you get the best cuts. 

Cut-it-out! (Continued) - Basic Cutting
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Recommendations for spacing images

For the most part, images can be placed on the 
page just as you normally would. 

Images can be placed next to each other with no 
space (gutters) between them (recommended) or 
separated from one another by .25 inch or more.  

In order to maintain the integrity of the page as 
it is cut, it is strongly recommended that images 
either be placed beside one another with no 
space between them, or separated by .25 inch (or 
more).  

When images are separated by less than .25 inch, cutting them will result in a sliver of 
paper between them which can negatively affect the overall structure of the paper.

So--

 -- Images next to each other with no space between them:   
    Recommended (and the most efficient)

 -- Images .25 of an inch apart:  
    Recommended

 -- Images not next to each other but closer than .25 of an inch:  
    Not Recommended

Special Case: Templates

The same recommendations hold true when designing and using templates, but with 
templates -- unlike with standalone images -- the template boundary itself will also be 
cut.  So, when designing a template try to keep image frames up against the template 
boundary, or, if that is not possible leave at least .25 inches between the frames and the 
template boundary.

And, just as with stand-alone images, when placing multiple templates side-by-side be 
sure to put the templates are beside each other with no space between them OR leave 
at least .25 inches of space between them.  Do not leave less than .25 inches between 
them or you may have issues with the resulting cuts.

Cut-it-out! (Continued) - Basic Cutting
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Contour Cutting
Contour cutting refers to cuts that follow a path other than that of the image’s boundar-
ies. This path can take on virtually any shape--logos, people, cartoon characters. Note: If 
you just want to make rectangular or oval cuts that include the entire image, you may not 
need to delve into the more advanced subject of contour cutting at all--in that case, skip 
to the Making the Cut section later in this chapter. 

In order to make a contour cut, Cut-it-out! needs to be able to determine which shape(s) 
within the image to cut.  To do this, you can use ImagePrint’s Contour Cut window to 
define the areas to cut, or you can create the contour as a path in Adobe Photoshop or 
Illustrator.  If Cut-it-out! is enabled, ImagePrint will treat any path it sees in the file as a 
contour cut outline.

Sample Files
ImagePrint provides several sample files that you can use as 
is or as a source of inspiration for your own cut-ready cre-
ations. With their clean lines they also make great practice 
subjects for learning to use the contour tools.  These files are 
located in the Cutting Images folder within the Test Images 
folder in your ImagePrint folder.

Defining the contour in ImagePrint
To access the Contouring controls in ImagePrint, open your 
image into the ImagePrint layout area as normal.  Make 
sure that Cut-it-out! is enabled in the dashboard using the 
instructions on the previous pages.   Then right-click the 
image (or control-click it if you don’t have a right mouse but-
ton) and choose Contouring from the menu that appears. 

The Contouring Window will appear.  

On the right side of the Contouring Window you’ll see the 
controls that will be used to define the area to be con-
toured.  

On the left, the image and the current contour outline will be shown.  As you make 
changes in the controls area, you’ll see the current path--represented as a purple outline-
-change to reflect the new contour parameters.

In the next few pages you’ll find descriptions of the tools to be found in the Contouring 
Windows along with some examples of defining a contour in typical images.

Cut-it-out! (Continued) - Contouring
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The Contouring Window

Zooming Controls

At the top of the Contouring Window are magnifying glasses 
that you can click on to zoom in/out of the displayed image in 
order to see the effect of the contour more accurately.  You 
can also set a specific zoom via the Set Zoom menu.  When 
zoomed in, click within the image area to access a Hand tool 
that allows you to adjust what part of the image you see.

Type 

The Type menu lets you choose between standard and Wrap 
Contour modes. 

Standard Contours
This type of contour closely follows the outline 
of a defined area of the image. 

Wrap Contours 
Wrap contours are more generalized outlines that 

are exactly big enough to “wrap” around the image 
but don’t conform to its exact shape.  

Cut-it-out! (Continued) - Contouring
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Offset 

The Offset setting lets you specify a distance that the con-
tour will be drawn from the image edge.  This allows you 
to include a border outline within the cut.

This image has an offset of 1.0.  Notice how the 
purple contour outline is offset from the edge of 

the image.

Notch 

There may be cases 
where you don’t want 
every narrow indenta-
tion along the edge of the image cut.  

The Notch setting can be used to adjust how closely the 
contour will follow such areas.

  

A high notch value will cause the cutting outline to follow 
the shape more loosely around 
narrow convex areas. 

A lower value (zero is the default) 
will cause the contour outline to 

exactly match the shape.  

Cut-it-out! (Continued) - Contouring
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Min Diameter 

To avoid small sub-sections of the image being assigned cut 
outlines, you can set a Minimum Diameter.  Any area of the 
image that has a diameter smaller than this value will not get a 
contour outline. 

Cut-it-out! (Continued) - Contouring

Min. Diameter .2

With a diameter of .2, 
some smaller sections 
get contoured as well.

Min. Diameter 1.0

Only the large blue out-
side section gets con-

toured.

Min. Diameter .05

Even the smallest 
areas are now con-

toured.
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Threshold 

The Threshold slider is the main control used to define which 
parts of the image get outlined.  

The threshold control works by letting you choose an aver-
age RGB percent value from 0 to 100.  As you drag the slider, 
the contour outline will be drawn between those areas of the 
image that have a higher average value, and those that have 
a lower value.  

Images with a solid background separating the areas you wish 
to have cut are much easier to create contour outlines for than 
images with gradient backgrounds, and if the background is 
much lighter (or darker) than the part of the image you want 
cut, defining the contour is typically a simple process.

For images that have less distinct edges, you’ll typically need to fine tune the value to 
ensure the parts of the image you want to be contoured.  Remember, if some smaller 
sections -- like the inside of a letter “O” -- are not included in the contoured area that 
you want cut-out, you may need to adjust the Min Diameter setting to a lower value to 
let those parts get a contour too.

TIP: If you can’t get the contour to include the area you want cut without also getting 
some unwanted contours, don’t worry --  the Contour Remove tool (described later) can 
be used to delete unwanted contours. 

As an example, let’s use the Threshold 
slider to contour this robot image.

The default contour value of 100 represents 
white.  This means that the contour line will 
be drawn between all the white pixels and 
any pixels brighter than white.  But... since 
white is the brightest value possible, there’s 
no contour to be drawn.  We need to adjust 
the threshold a bit.

Cut-it-out! (Continued) - Contouring
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We don’t have to go far.  A threshold value of 99% 
manages to contour the main robot shape nicely.  
The purple contour outline is drawn between any 
RGB average values 100 (white) and 99 (every 
other color) so we get an outline between the 
white areas of the image and the black edge of the 
robot.

But wait--the small white areas between the arms 
and the robot’s body do not have outlines -- even 
though they are white.  If we want those areas to 
be cut-outs, we need contours there too.  So what 
went wrong?

The “Min. Diameter” setting from earlier in this 
manual controls how small the contoured areas will 
be.  This is useful for avoiding drawing contours 
around every little shape in the image, but in this 
case we want to contour those thin areas beside 
the arms.  So, let’s bring down the Min Diameter 
value a bit until we see the contour get those areas 
as well.

A minimum diameter setting of .200 seems to have 
done the trick.  We now have included those areas 
by the arms -- if this robot was printed and sent to 
the cutter, you’d get the robot cut out and a cutout 
beside each arm.

But--there’s another problem.  When we adjusted 
the minimum diameter, the small round lights on 
the robot’s chest panel got contoured too!  We 
definitely don’t want those to be cut out.

No problem.  ImagePrint provides tools to eas-
ily delete unwanted contours.  We’ll get to those 
tools after the next page and finish the job with our 
robot. Stay tuned!

Cut-it-out! (Continued) - Contouring
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Exclude Interiors 

With this option set to OFF only the outer contour will be 
outlines--no interiors area (within the contour’s boundaries) will 
be created.  Turn this option ON to include contours within the 
main contoured outline.

Details 

The contour can be drawn at three different details. Normal, 
High and Extreme.

Higher levels will cause the contour to follow the shape more 
accurately but if your image has lots of fine detail may result 
in longer cutting times.  That should not be an issue with just 
a few images to cut, but if cutting lots of images, you may 
want to use the lowest detail setting that produces acceptable 
results.

Cut-it-out! (Continued) - Contouring
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Contour Correction Tools 

These tools allow you to fine tune what parts of the image via 
a colored fill or line.  It’s important to understand that any fills 
or lines you draw with these tools will NOT be included in the 
print - they are just used to block off or connect areas of the 
image to control the contouring. 

Click the color drop-down menu to choose a color for the 
line/fill tool to use (Black or White are often the most useful 
as they represent the extreme ends of the threshold range) 
then click the pencil or fill tool and draw within the contour 
windows display area.  The  contour outline will follow the 
new area based on its brightness compared to adjacent 
areas. 

To delete any elements you have added, click the Reset button.

Here’s an example of using the Correction Tools to adjust the contouring outline. 

The exclamation mark in this image 
has a contour around both parts, 
meaning it will be cut into two separate 
shapes.  

Joining:  To join the two pieces, a black line could be drawn between 
them.  Notice how -- when the contour is redrawn -- that the shapes 
are now “bridged”.  Remember--the black line won’t print.  It’s just 
there to adjust the contour.

Breaking: In another part of this 
image, the “H” and the “i” are joined, 
meaning they’ll be cut together as 
one shape.  A white line or box 
drawn between them at the base 
will effectively break the continuity, 
causing the contour to treat them as 
separate shapes.

Cut-it-out! (Continued) - Contouring
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Contour Selection Tools 

The contour selection tools provide the ability to select con-
tours and delete them.  This makes it easy to clean up any 
unwanted contours that appear after adjusting the threshold 
and other values to outline the parts of the image you want to 
have cut.

Click the pointer to tool to enable contour selection. Then, 
simply click contours to highlight them (they will turn red when 
selected).  Hold shift down to add to the group of select con-
tours--or, drag the pointer tool to multiply select contours within 
a marquee.

Once you have the contours you want selected, click the X 
icon to delete them.  You can also use the “d” key on your key-
board.

If you make a mistake and want to un-delete a contour, click the check button (or press 
the “r” key on your keyboard.  Clicking check or the “r” key multiple times will result in 
restoring multiple contours that have been deleted.  

As an example, let’s return to our robot example 
from a few pages ago.

When last we saw him, a proper contour line 
had been created using the Threshold and Min. 
Diameter tools, but we had a couple of areas 
within the robot body that we didn’t want to have 
cut.  The two white circles within the robot’s con-
trol console.

To remove them, click the Pointer tool within the 
Contour Selection Tools, and click one of the 
circles.  Hold shift down and click the other. (You 
could also have dragged the point to select both 
circles within a selection marquee).

Now click the X icon (or press the “d” key on your keyboard) and the contours will be 
deleted. (You’ll see them outlined in blue when deleted.)

Now the robot is done and ready for cutting!

Cut-it-out! (Continued) - Contouring
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Contour Cut Controls
Normally the Basic hanger size and hanger spac-
ing settings in the Cut-it-out! section of the dash-
board are used for contour cuts as well, but the 
Contour Cut Controls section at the bottom of the Contour Window allow you to specify dif-
ferent hanger size and space settings to be used for contour cuts.  Here,  you can also over-
ride the force setting that is currently in effect on the cutter.   

This can be very useful for special “combination” cut styles, such as rectangular cards (cut 
with the Basic cut-it-out hanger settings and the on board cutter force setting) that contain 
peel away stickers (cut using zero-hanger kiss cuts from the Contour Window Cut Controls). 

Applying the Contour 
After using the tools within the Contour Window to contour your image, simply close the 
Contour Window to apply them.  You’ll see your contour outline in the image displayed in the 
layout window, and if you print and send the job to your cutter, the contour outline will be cut.

If you want to edit your contour line, simply right click the image and choose Contouring 
again in the menu that appears. 

Other methods of contouring

In addition to creating your contour outline using ImagePrint’s Contour tools, contours can 
also be created in Adobe Illustrator and Photoshop as paths.  When an image is opened in 
ImagePrint that contains a path--and Cut-it-out! is enabled--the path will be treated as a con-
tour.  

If you name the path using specific terms as defined in the next section, ImagePrint can use 
custom cut settings, including “kiss cuts” (cuts that do not go completely through media, usu-
ally used for cutting through adhesive media without penetrating the backing).

Another way to apply contours is via an SVG contour file. SVG (Scalable Vector Graphics) 
is a common file format (available in programs like Adobe Illustrator or Corel Draw) that can 
be used by ImagePrint as sources of contour outlines.  When dropped on an image, the vec-
tor data in the SVG file will be applied as contour paths.  ImagePrint provides some sample 
SVG contour borders that you can access.  You can also make your own in Adobe Illustrator 
or Corel Draw.

SVG files with paths (but no image data) can also be opened directly in ImagePrint as “Blank 
Contours”.  

The next few pages describe these two alternate methods of contouring.

Cut-it-out! (Continued) - Contouring
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Defining the contour as a path in Adobe Photoshop or Illustrator

Adobe Photoshop can also be used to make paths that ImagePrint will use as con-
touring outlines.  

Just create a path in either program and save it with the image as a Photoshop PSD 
file.  When opened in ImagePrint, the contouring data will automatically be found and 
used as the contour cutting path when the resultant print job is sent to the cutter.

Making a path in Photoshop - a very quick example

While complete Photoshop or Illustrator path-making instructions aren’t within the 
scope of this manual, here’s one way to create a path in Photoshop using the Magic 
Wand tool. There are many other ways to accomplish the same task.

Open an image in Photoshop.  For best results, the image should have a flat back-
ground composed of one color (white is recommended) and the part of the image to 
be cut should have clean, distinct edges.

Select the Magic Wand tool in Photoshop’s tool palette and click the background 
of your image.  The entire background should show a “marching ants” selection.  If 
some portions were missed, adjust the “tolerance” value for the wand at the top of 
the Photoshop screen to a higher value and click the background again.  

Once you have the whole background selected without any of the image you want to 
cut from it--choose “Invert” from the Selection menu.  The selection will be reversed. 
You’ll now have just the image data that you want to have cut selected and none of 
the background.

To convert this selection into a path, make sure the Paths palette is visible (you can 
choose it from Photoshop’s Windows menu).  In the Paths palette, click the menu 
in the upper right corner and select: Make working path.  Your selection area will 
change to a path.

Save the image as a Photoshop PSD file and open it in ImagePrint.  If Cut-it-out! is 
enabled, you should see the path data represented as a contour path.

Cut-it-out! (Continued) - Contouring
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Advanced - Using the path name to designate cutting options

By naming an Adobe Photoshop using specific conventions (as outlined below), you can 
have the path cut using custom cut parameters.  

Named paths are currently the only supported method of specifying a “kiss” cut.  Kiss cuts 
are cuts that go through the top portion of adhesive media without penetrating the backing in order to 
ensure easy peel off.

Naming Syntax

There are 4 sections that need to be included in the name of a path in order for ImagePrint 
to recognize it as a source of cut parameters.  Each section must be separated by a colon 
(:).  The naming format is:

CUT NAME : FORCE : HANGER SPACING : HANGER SIZE

Cut name 
The first part of the path name must be of the form:  ipcut-#  where ”#” is a unique 
number. It’s recommended that the number simply be the sequential order of the path in 
the image –  ipcut-1 for the first path, ipcut-2 for the 2nd path, etc.  

Force       Valid values: 1 - 38
For normal (perforation) cuts, use the Force value necessary to completely cut through 
the media.  For “kiss” (partial) cuts, use a smaller value--typically about half of the cut-
through value though you may need to experiment.  

 A Force value of “-1” will use the current Force setting on the Cutter.

Hanger Spacing  
This value determines the distance between hangers in 10ths of a millimeter. (192 is 
equivalent to 1/4 inch).  Note: If doing a “kiss” (partial) cut, even though there are no 
hangers, a value must always be present (even though it won’t be used).  

 A Hanger Spacing value of “-1” will use the Hanger Spacing setting from 
ImagePrint’s Cut-It-Out! Settings

Hanger Size    Valid Values: 0 - 10 
This value determines the size of the hanger. Values are in10ths of a millimeter. . For a 
kiss cut, this setting should be 0 (no hangers). Non-kiss cutting values can be anywhere 
from 1 to 10.   

 A Hanger Size value of “-1” will use the Hanger Size setting from ImagePrint’s Cut-It-
Out! Settings.
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Keywords

In addition to the above parameters, there are two special keywords that can be used: 

Punchout    (example:  ipcut-1:Punchout)

Using this keyword will result in a cut that uses small hangers and wider spacing 
to allow for easier separation than normal. 

Tearoff  	       (example:  ipcut-1:Tearoff)

Using this keyword will result in a cut that uses larger hangers and smaller spac-
ing for a more rigid, harder to separate cut. Good for tickets that need to be torn 
in half when validated. 

Tenths of a millimeter? 
 

The Hanger spacing and size values are in 10ths of a millimeter.  To quickly convert from inch-
es to tenths of a millimeter, use a tool (Google will do it) to convert from inches to millimeters, 

then multiple the result by 10 (rounding to the nearest whole number).

Path naming examples:

A “kiss” cut, using a force of 15, and using a “dummy” value of 10 for the hanger distance 
(since that setting isn’t used for kiss cuts):

 Ipcut-1:15:10:0   

The below examples show two path names for a ticket that will have two types of prefora-
tion cuts--the first to allow easy separation of the entire ticket from the printed page and 
a second “open path” line down the middle to allow for the ticket to be torn by the ticket-
taker:

ipcut-1:-1:192:2       (For the easy to separate ticket boundary: the current force value 
from  the cutter will be used, with hangers spaced at 192 tenths of a millimeter (1/4th 
inch) and 2/10th of a millmeter hanger size)        
ipcut-2:Tearoff 	     (For the more rigid tear-line down the middle of the ticket)  
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Applying a pre-defined contour border

ImagePrint comes with several contour borders that can be applied to images via sim-
ple drag and drop.  It’s possible to add your own contour borders as well.

To access the pre-defined contours, choose “Visible” beside the “Contours Browser” 
entry in the VIEW at the top of the ImagePrint screen.

You’ll see a window appear with thumbnails of the available contour borders. 

Drag one to an image in your layout and you’ll see the contour applied.

Making your own pre-defined contours

To use your own pre-defined contours, create a file in Adobe Illustrator or Corel Draw 
that contains the path you wish to use using the normal methods for that program 
(ColorByte Software is not able to offer support or instructions on those methods-
-check your program documentation for information on the proper procedures).  

Then save the file as an “SVG” file and put it in the Shapes folder within your 
ImagePrint folder (On Macs, that folder is: /Applications/ImagePrint/Shapes.  On 
Windows, it’s: c: \programdata\ColorByte Software\ImagePrint\shapes).

Restart ImagePrint and your new contour should be available in the Contours Browser 
window.

“Blank” contours

You can also use an SVG file with a path as a “blank” cutting contour. A blank contour 
is a cut line with no image data.  These can be used when you simply want to cut 
shapes without any associated pictures. 

To use a blank contour, simply open an SVG file that contains a path (but no image 
data) in ImagePrint via the File->Open command.  

You’ll see the contour in the layout window as an outline.  

When you click “Print” with only SVG contours on the page, no job will be sent to the 
printer but the job file that appears in spoolface can be dragged to the Scissors icon 
to have the cutter cut the designated shape(s) according to the instructions in the next 
section (Making the Cut).

Since no registration needs to be made with image data when blank contours are cut, 
you don’t need registration marks present on the media. 
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Making the Cut
Now for the fun part - cutting the page!

Of course, before you can cut the page, you must first print it.  But don’t worry--printing a 
job with cut data is exactly the same as printing a job without cut data.  Just make sure to 
include the cut data in the job by clicking the checkbox within the Cutter Settings section of 
the ImagePrint dashboard.  

Now print the job just like normal by choosing Print from the ImagePrint File menu, or by 
clicking the PRINT button at the top of the ImagePrint Dashboard.  

After sending the job to print, open Spoolface (the ImagePrint Spooler) by clicking the 
Printer icon at the top of the Dashboard or by choosing Spoolface from the File menu.

As usual, the print job will stay in the top (Active) side of Spoolface as it prints.  When print-
ing is done, it will move to the SAVED (bottom) side.  (Because it’s a cut enabled job, it will 
appear red in the job listing.)  

TIP: The job name and job number will appear on the print, just below the bar code. This 
makes it easy to match the right print to the right job.

Now, load the completed print into the automatic cutter using the normal procedures for 
your cutter model.  For instructions on loading the cutter, see the section that immedi-
ately follows this one.

Once the paper is loaded, return to your computer and simply drag the completed job to 
the Scissors icon at the bottom of the Spoolface window.  (You can also highlight the job 
and click the scissors instead to send the job). The cut data contained within the job will be 
sent to the cutter, and your print will be cut!

Cut-it-out! (Continued) - Making the Cut

After loading the automatic 
cutter with the completed 
print, drag the job to the 
scissors icon to cut it!
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Cut-it-out! (Continued) - Cutter Setup

Using your Graphtec cutter with Cut-it-out!

While the following guidelines are not intended to substitute for the manual that came with your 
Graphtec cutter, the below tips should help to get you quickly cutting your Cut-it-out! prints. 

First, we’ll give a brief description of best practices when loading paper.  Following those 
instructions, we’ll provide basic instructions on the steps you need to take when switching to a 
new media. Namely, setting the blade length, cutting force and cutting speed.

Loading the cutter with your printed media

Follow the below steps when inserting your ImagePrint Cut-it-out! prints into your 
Graphtec cutter to get a perfect cut every time.

- Lever down

Push down the lever at the back of the cutter before loading 
your paper.

- Bar Code orientation

On every Cut-it-out! enabled 
print, a barcode is generated 
(along with the job name and the job number that appears 
for the job in Spoolface).  For the Graphtec CE-6000 and 
FC-8600 the bar code should be loaded first into the cut-
ter.  For the Lite CE-50, load the end of the paper opposite 
of the barcode first--the barcode goes last for that cutter.

- Paper over the rollers

The gray-colored “grit” rollers on the cutter are responsible for moving the paper as it cuts.  It’s 
vital that the left and right edges of the print are positioned on top of these rollers.   To accom-
plish this, place the right edge of the paper somewhere on the extra wide right-most roller, then 
move the paper left or right until its left edge exactly covers another grit roller. 
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Loading the cutter with your printed media (continued)

- Insert it all the way

When inserting the paper, push the paper into the 
cutter until the trailing edge reaches the horizontal 
guideline in front.

- Keep it straight

While the cutter can compensate for 
some amount of paper skew, it’s still a 
good idea to keep the paper as straight 
as possible when loading. The guide-
lines at the front of the cutter can help 
to do this visually, but we’ve found it’s 
often easier and faster to put a ruler in 
the groove just above those guidelines 
and butt the edge of the paper against 
it.

- Lever up

Once the paper is in place, lift the lever in the 
back of the cutter up to lock the media into 
place.  You won’t be able to move the rollers in 
the next step until you perform this step.

Cut-it-out! (Continued) - Cutter Setup
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Loading the cutter with your printed media (continued)

- Place the pinch (top) rollers

The two top “pinch” rollers are responsible for holding the paper down as it moves through 
the cutter. They also help the cutter’s sensors to find the registration marks. So it’s very 
important to place them correctly.

In placing the rollers, use the wheel brackets as a guide. (Each pinch roller wheel is held 
by a U-shaped black plastic bracket.)  

Align the left edge of the left roller bracket to the 
left edge of the paper.  This placement should cor-
respond to the blue grit-roller marks above the 
page load area since the edge of the page will fall 
on top of a grit marker.

Align the right edge of the right roller bracket to the 
right edge of the paper.

That’s it -- your media is loaded and ready to cut!

Cut-it-out! (Continued) - Cutter Setup
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Setting up the cutter for new media

Navigating the cutter’s front panel menu can be confusing, but most options can remain 
at their default setting.  However you will need to adjust the blade length and cut force 
are when switching to a new media. It’s also a good idea to set the cut speed to ensure 
the cuts are made as accurately as possible.

Note on Conditions: Graphtec cutters allow you to save a number of “Conditions”. 
These are groups of settings that can be saved and easily recalled.  The following 
setup procedures assume you are using the Condition one, but at any step you can 
choose a different Condition number to create settings for it instead. 

First, load your media 

You’ll need to have your media loaded on the printer before making the following 
adjustments.  You can use the instructions in the previous section as a guide.  Note 
that, since you won’t be cutting an actual job, there’s no need for the loaded paper to 
have registration marks, and the placement of the grip rollers doesn’t have to be accu-
rate. The cutter just needs the media to be in place for setting the proper blade height 
and making small test cuts.

Step 1 - Adjusting the cutter length (Coarse adjustment)

Adjusting the blade length is an interactive process of making manual adjustments 
while being guided by the cutter as it checks the media.  You’ll need to do this when-
ever you change to a media of a differing thickness.

A. Retract the blade

Remove the blade assembly from the cutter. Then, using the 
rotating knob at the top of the cutter assembly, adjust the cutter 
extension just enough so that the tip of the blade is not protrud-
ing at all and is hidden within the opening.

Cut-it-out! (Continued) - Cutter Setup
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Setting up the cutter for new media (continued)

   B. Set the baseline (zero) point

Put the blade assembly back in the cutter

On the cutter’s control 
panel, press the COND/
TEST button.  

Then press the DOWN 
arrow once to move to 

change to the 2nd menu 
screen. 

Choose option 3 - Blade Adjust. You’ll be prompted to retract the blade--
but since we’ve already done that in step one, just press the 
ENTER button.

The cutter will now set its “0” point -- the point at which the 
blade assembly just touches the media. 

   C. Set the blade extension

When it’s done, you’ll need a small piece (3 inches by 3 inches should be fine) of the 
media you plan to cut.  Place that piece between the blade and the loaded media.  Then 
choose option 2 - Check.

Now the cutter will measure how thick your piece of media is. Once it’s done, you’ll see 
the thickness listed at the top of the panel.  This will be the length you’ll be setting the 
blade to match.

There’s several ways to set the blade length. We’ll be using the Target Length method.

Remove the scrap of paper. Then, click option 1 - Blade Length Target, and use the 
arrow keys to adjust the target value to match the paper thickness you measured in the 
previous step. Click the ENTER button to return to the previous screen.

Cut-it-out! (Continued) - Cutter Setup
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Setting up the cutter for new media (continued)

Now click Option 2 - Check to have the cutter check the current length of the 
blade. 

Each time you chose this option, the cutter will measure that 
length and provide instructions on how far and which way to 
turn the blade’s adjustment knob to reach the Blade Length 
Target you set.  (Note that you don’t have to remove the blade 
assembly to turn the knob).  

Turn the top adjustment knob in the direction and degree that the panel instructions 
specify, then choose Option 2 - Check again to assess the current blade length.

Keep choosing Option 2 - Check and adjusting the blade length as directed until the 
Blade Length Target is reached (as shown at the top of the panel).   Once that value is 
reached, click Option 3 - END.  

You now have adjusted the blade to equal the thickness of your media!  

Now you need to adjust the force that the cutter will use as it presses into the media.

Step 2. Setting the force value (Fine adjustment)

To set the force value, you’ll do a series of one or more test cuts to determine the proper 
amount of force for your particular media.  

Determining a starting point 
 

To get a good “ballpark” force value for your media, the following formula can be used:  
 

Force = (28  x  [Paper thickness (mils)] )   /  11 
 

That is, multiply the thickness in mils of the paper times 28, then divide the result by 11 
(Round down the answer to the nearest whole number).   So, for 12 mil paper, the starting 

force should be: 
 

(28 x 12)  / 11  = 30.5 
 

Rounding down, we now have a force value of 30 to start with.

Cut-it-out! (Continued) - Cutter Setup
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Setting up the cutter for new media (continued)

On the cutter’s front panel, click the Cond/Test button (you may need to 
click it twice) then choose Option 4 - Force.

Now use the UP/DOWN Arrow buttons on the panel to enter in your starting force and 
press the ENTER button.

You’ll now need to do a test cut.  Press the RIGHT 
Arrow button on the front panel to be taken to a screen 
that lets you use the Arrow buttons to move the cutter 
blade to a position on the paper you’d like to cut.  

When you have it over a clear area of media, press the 
ENTER key to perform the cut.

The cutter will execute a small triangular cut.  Check that the triangle separates easily 
and cleanly from the paper. 

- If it doesn’t separate cleanly, press the ENTER button, then Option 4 - Force, and 
repeat the above steps with a higher force value.  

- If you notice tearing of the paper after the cut was made, your force is probably too 
high.  Again, press the ENTER button, then Option 4 - Force, and try again with a 
lower force value. 

Once you get a perfect cut, press ENTER one more time and move on to the last set up 
step: Setting the Cut Speed.

Cut-it-out! (Continued) - Cutter Setup
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  Step 3. Set the Cut Speed value	

The speed setting can affect the accuracy of your cuts. Generally, for most cut jobs a 
speed setting of around 40 works best, but we recommend that you set the cutter speed 
to AUTO to let the cutter change its speed based on the cut being made.

To set the speed to AUTO, first press the Cont/Test button, then press the 
DOWN arrow twice to get to the menu that has Option 1 - Acceleration.  

Choose that option and a screen will appear that lets you specify the acceleration 
mode.  Press the UP arrow key to change that value to * (It will be one click above “2”).  
That’s the Auto Speed mode.  

Hit the ENTER button and it will be saved. Now the cut speed will automatically adjust 
based on the cutting conditions.  

Cut-it-out! (Continued) - Cutter Setup
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Appendix A - Keyboard Shortcuts
The following keyboard shortcuts can be used within ImagePrint

 

Function			    Macintosh			   Windows 

Open File Command - o Control - o
Quit Command - q Control - q
Zoom in Command -Shift - + (plus) Control - Shift - + (plus)
Zoom out Command - - (minus) Control - - (minus)
Print Command - p Control - p
Preferences Command - . (period) Not available
Hide ImagePrint Command - h Not available
Step and Repeat images Drag corner/edge of image 

while holding shift
Drag corner/edge of image 
while holding shift

Step and Repeat - Increase 
spacing between stepped/
repeated images

Drag interior of image while 
holding shift

Drag interior of image while 
holding shift

Context sensitive “mouse” 
menu

Click image while holding 
Control key

Click image while holding 
Control key

Run into a Problem?

The ImagePrint trouble shooting guide is located in 
your ImagePrint folder (or on the Technical Support 

page at www.colorbytesoftware.com) 
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Appendix B - ImagePrint as a Lightroom “External 
Editor”
Many ImagePrint customers use Adobe’s Lightroom to process and organize their imag-
es.  But… getting them from one Lightroom to ImagePrint can be a bit of a chore: Export 
the image from Lightroom, find the file on your computer, then re-open it in ImagePrint. 

Wouldn’t it be nice to avoid those extra steps and go straight from Lightroom to 
ImagePrint? Good news, you can!

Lightroom’s External Editor feature is the key. Once ImagePrint is set up as an external 
editor, you can place an image directly into ImagePrint’s layout window right from the 
Lightroom menu. 

Setting up ImagePrint as an external editor is easy. The following steps are based on 
Lightroom 4.0, but should be similar in later versions.

  �In Lightroom, choose Preferences from the top menu. Then, choose the External 
Editing tab at the top of the Preferences window. Look for the section labeled: 
Additional External Editor and click Choose. This will open a new window where 
you’ll select the ImagePrint executable file:

► �On Macintosh computers, the file you’re looking for is “ImagePrint.app” You’ll 
find it in the ImagePrint folder inside your Mac’s Application folder.

► �On Windows computers, look for the file “ImagePrint.exe”. You’ll find it in the 
ImagePrint folder which is located in your Program Files (x86) folder.

Once you find the ImagePrint executable, click Choose to lock in your choice.

 �The next thing to do is set some rules for Lightroom to follow when it sends images 
to ImagePrint.

- In the File Format drop-down, choose TIFF.

- �In the Color Space drop-down, choose your preferred source space (usually Adobe 
1998 or Pro Photo RGB).

- In the Bit-Depth drop-down, choose 16-bit.

- �For Resolution, if you don’t plan to scale the image in ImagePrint, 240 or above is 
fine. If you plan to use ImagePrint’s scaling, you may want to go higher to avoid 
losing detail.

- Finally, for Compression leave it at None
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 �Now that you’ve set up ImagePrint as an editor and set the rules that Lightroom 
will follow, you need to save your new settings as a Preset. Click the Preset drop-
down menu at the top of the Additional External Editor area and choose Save 
Current Preset. Type ImagePrint for the preset’s name. Click Create.

That’s it--ImagePrint is now an external editor for Lightroom!

To use your new preset, right-click (or control-click) an image in Lightroom and choose 
“Edit in ImagePrint”.  You can also select that option from the Photo menu at the top 
of the Develop screen. 

After choosing that option, ImagePrint will launch (if it’s not already running), and 
the Lightroom image will appear in the layout window. From there you can use 
ImagePrint’s workflow tools to position, resize and print the image. 

Remember: ImagePrint’s editing tools are always non-destructive, meaning the tweaks 
you make with ImagePrint are not saved to the file and will not appear in the original 
image back in Lightroom. 

ImagePrint as a Lightroom External Editor (continued)
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